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Revision History

Publication Publish Date Comments

Part Number

202-12036-01  January 2020 We made the following major changes:

We added support for model GS724TPP.

We changed the login procedures for all tasks. After you register and access
the switch with your NETGEAR account, you can access the switch with the
local device password.

The switch now supports management through the NETGEAR Insight app
and Insight Cloud portal.

We reorganized the information in Chapter 1, Get Started and added or
revised the following sections:

- Available publications

- Switch management options and default management mode

- About on-network and off-network access

- Access the switch on-network and connected to the Internet

- Access the switch off-network

- Credentials for the local browser Ul

- Register the switch

- Change the language of the local browser Ul

- Change the management mode of the switch

In other chapters, we added the following sections:

- PoE concepts
- Device class power requirements

- Power allocation and power budget concepts

- Hardware technical specifications

Throughout the manual, we did the following:

- We added or revised many standard sections.

- We made many other minor changes and improvements.
We published the manual in a new format.

202-11765-03  September 2019 We removed references to the CD.
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202-11765-02 May 2018 We made the following major changes:
+ Added the DHCPv6 option to Configure the IPvé network interface on
page 58
» Added Configure Layer 2 loop protection on page 200
* Added Configure DiffServ IPvé class settings on page 224
* Revised Manage port authentication on individual ports on page 280
« Added View the client summary on page 287
* Revised Use the ACL Wizard to create a simple ACL on page 304
e Added Configure an IPvé ACL on page 337
» Added Configure rules for an IPvé ACL on page 340
In addition we made multiple minor changes.
202-11765-01  June 2017 First publication
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Get Started

This user manual describes how you can use the local browser user interface (Ul) to configure
and operate the following NETGEAR Smart Managed Pro switches:

GS724TPv2. NETGEAR 24-Port Gigabit PoOE+ Ethernet Smart Managed Pro Switch with
2 SFP Ports and Cloud Management.
This model provides a PoE power budget of 190W.

GS724TPP. NETGEAR 24-Port Gigabit Hi-Power PoE+ Ethernet Smart Managed Pro
Switch with 2 SFP Ports and Cloud Management.
This model provides a PoE power budget of 380W.

The manual describes the software configuration procedures and explains the options that are
available within those procedures.

This chapter contains the following sections:

Available publications

Switch management options and default management mode

Manage the switch by using the local browser Ul

About on-network and off-network access

Access the switch on-network and connected to the Internet

Access the switch off-network

Credentials for the local browser Ul

Register the switch

Change the language of the local browser Ul

Change the management mode of the switch

Use the Device View of the local browser Ul

Configure interface settings
Access the NETGEAR support website
Access the user manual online

I
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Note: In this manual, we refer to both switch models as the switch. Unless
noted otherwise, all information applies to both switch models.

Note: For more information about the topics covered in this manual, visit the
support website at netgear.com/support.

Note: Firmware updates with new features and bug fixes are made available
from time to time at netgear.com/support/download/. Some
products can regularly check the site and download new firmware, or
you can check for and download new firmware manually. If the
features or behavior of your product does not match what is described
in this guide, you might need to update your firmware.

Available publications

The following guides are available at netgear.com/support/download/:

+ Installation Guide
 Hardware Installation Guide

For information about the NETGEAR Insight app and Insight Cloud portal, visit

netgear.com/insight and netgear.com/support/product/Insight.aspx. For knowledge base
articles about NETGEAR Insight, visit netgear.com/support.
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Switch management options and default
management mode

If you prefer, you can use the switch as a plug-and-play device, so you do not need to set up
a custom configuration. Just connect power, connect to your network and to your other
devices, and you're done.

The switch provides administrative management options that let you configure, monitor, and
control the network. The local browser Ul is enabled by default, allowing you to configure the
switch and the network from a web browser. You can also choose to manage the switch by
using the NETGEAR Insight app on a smartphone or tablet. Or, if you are an Insight Premium
or Pro subscriber, you can choose to manage the switch from the Insight Cloud portal that is
available from a web browser on your Windows-based computer, Mac, or tablet.

The switch provides the following management options that let you discover the switch on the
network and configure, monitor, and control the switch:

» Local browser Ul. By default, the management mode of the switch is set to Directly
Connect to Web Browser Interface, which lets you access the local browser Ul. In this
mode, you can change all settings of the switch.

* NETGEAR Insight app and Insight Cloud portal. If you set the management mode of
the switch to NETGEAR Insight Mobile App and Insight Cloud Portal, you can use the
following applications to manage the switch remotely:

- NETGEAR Insight app. With the NETGEAR Insight app, you can discover the switch
on the network and add the switch to the NETGEAR Insight app so that you can set
up the switch in the network and manage and monitor the switch remotely from your
smartphone or tablet. You can choose from four methods to add the switch to the
NETGEAR Insight app: You can scan your network for the switch, scan the QR code
or the barcode of the switch, or add the serial number of the switch.

- Insight Cloud portal. As an Insight Premium or Insight Pro subscriber, you can use
the NETGEAR Insight Cloud portal to set up the switch in the network, perform
advanced remote setup, configuration, and management, monitor the switch, analyze
the switch and network usage, and, if necessary, troubleshoot the switch and the
network. A free trial is available for new customers.

For more information about NETGEAR Insight, visit netgear.com/insight and
netgear.com/support/product/Insight.aspx. For knowledge base articles about
NETGEAR Insight, visit netgear.com/support.

To use the NETGEAR Insight app or Insight Cloud portal methods, you must change the
management method to NETGEAR Insight Mobile App and Insight Cloud Portal. After you do
S0, you can also change the management method back to Directly Connect to Web Browser
Interface and use the local browser Ul. For more information, see Change the management
mode of the switch on page 37.
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Manage the switch by using the local
browser Ul

This manual describes how to use the local browser Ul to manage and monitor the switch.

For information about using the NETGEAR Insight app and Insight Cloud portal to manage
the switch, visit netgear.com/insight and netgear.com/support/product/Insight.aspx. For
knowledge base articles about NETGEAR Insight, visit netgear.com/support.

Software requirements to use the local browser Ul

To access the switch by using a web browser, the browser must meet the following software
requirements:

e HTML version 4.0, or later
e HTTP version 1.1, or later

Supported web browsers

The following browsers were tested and support the local browser Ul. If later browser
versions are not stated, it means that they were not tested but might function fine. The
supported web browsers include the following:

« Microsoft Internet Explorer (IE) version 10 and later versions

» Mozilla Firefox version 35 and later versions

e Chrome version 33 and later versions

e Safari (on MAC OS) version 10 and later versions
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Navigation tabs, configuration menus, and page menu

The following figure shows the System Information page for model GS724TPP.

Navigation tabs  Configuration menus
Logout button

Language menu

NETGEAR S "N
GS724TPPR4-Port Gi- 4bit Hi-Power PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports and Cloud Management Auto ~| Welcome admin |
[ Spen | Poewg | 005 | S | ooy | banenaco | hop | b | ]
N DevicaMiew PoE SNMP LLDP  Senices  Timer Schedule
(oo
Management Managemenl Mode @
* System Information ® Directly Connect to Web Browser Interface METGEAR Insight Mobile App and Insight Cloud Portal
*IP Configuration (Local LAN Only) (Cloud/Remote)
; E’?‘;EHT;E:;?; * Ingight Subscnption Required Hel p pag e
= IPvE Network Neighbor
. s Buttons
*Denial of Service «| Application. Information @
“DNS v |AppName App Status Version
+Green Ethemet v CloudAgent Device not added in Account  5.8.0.50800050
Confighgent Operational 5.8.0.50800050
DiscoveryAgent  Operational 5.8.0.50800050
System Information ®
Product Name GS724TPP: 24-Port Gigabit Hi-Power PoE+ Ethemet Smart Managed Pro Switch with 2 SFP Ports and Cloud Management
Page menus  systemname
Systam L alon Configuration status and options
System Contact
Serial Numbaer 65F1995TF0052
System Object QID 1.3.6.1.4.1.4526.100.4 62
Date & Time Dec 02 23:38:16 2019 (UTC+0)
System Up Time 0 days 2 hours 31 mins 16 secs
Base MAC Address BC:AS:11:21:80:94

Figure 1. Switch navigation tabs, configuration menus, and page menu

The navigation tabs along the top of the web interface give you quick access to the various
switch functions. The tabs are always available and remain constant, regardless of which
feature you configure.

When you select a tab, the features for that tab appear as menus directly under the tabs. The
configuration menus in the blue bar change according to the navigation tab that is selected.

The configuration pages for each feature are available as submenu links in the page menu
on the left side of the page. Some items in the menu expand to reveal multiple submenu
links, as the following figure shows.
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Submenu
links

Link—

I
N

= Denial of Service »

«DNS w

= Green Ethemet v

Figure 2. Switch page menu link and submenu links

Configuration and status options

The area directly under the configuration menus and to the right of the links displays the
configuration information or status for the page you select. On pages that contain
configuration options, you might be able to enter information into fields, select options from
menus, select check boxes, and select radio buttons.

Each page contains access to the HTML-based help that explains the fields and configuration
options for the page.

Buttons in the local browser Ul

Each page also contains command buttons. The following table shows the command buttons
that are used throughout the pages in the local browser UI.

Table 1. Command buttons in the local browser Ul

Button Function

Add Clicking the Add button adds the new item configured in the heading row of a table.

Apply Clicking the Apply button sends the updated configuration to the switch. Your settings are
saved and configuration changes take effect immediately.

Cancel Clicking the Cancel button cancels the configuration on the page and resets the data on the
page to the previous values of the switch.

Clear Clicking the Clear button clears all the counters and resets the switch summary and detailed
statistics to default values.

Delete Clicking the Delete button removes the selected item.

Refresh Clicking the Refresh button refreshes the page with the latest information from the device.

Logout Clicking the Logout button ends the session.
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User-defined fields

User-defined fields can contain 1 to 159 characters, unless otherwise noted on the
configuration web page. All characters can be used except for the ones stated in the
following table (unless specifically noted in a procedure for a feature).

Table 2. Invalid characters for user-defined fields

\

Invalid characters for user-defined fields

| < > 2

Context-sensitive help

When you log in to the switch, every page contains a link to the online help () that contains
information to assist in configuring and managing the switch. The online help pages are
context sensitive. For example, if the IP Configuration page is open, the help topic for that
page displays if you click the link to the online help.

About on-network and off-network access

You can access the switch either on-network or off-network:

On-network and connected to the Internet. When you use the local browser Ul, for
easiest access, we recommend that you cable the switch to a network that is connected
to the Internet and that includes a router or DHCP server that assigns IP addresses,
power on the switch, and then use a computer that is connected to the same network as
the switch to connect to the local browser Ul. We refer to this setup as on-network or
online.

For more information, see Access the switch on-network and connected to the Internet
on page 18).

Off-network and not connected to the Internet. You can also configure the switch
connected directly only to the computer that you are using to configure it. That is, the
switch is not connected to the network and the Internet. We refer to this setup as
off-network or offline.

Before you can access the full menu of the local browser Ul, you must connect the switch to
a network with Internet access at least once so that you can register the switch with
NETGEAR and unlock the full menu. Alternately, you can get a registration key, which you
can enter to unlock the full menu while the switch is off-network.

For more information, see the following sections:

Register the switch on page 31.

Access the switch off-network on page 27.
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Access the switch on-network and
connected to the Internet

The DHCP client on the switch is enabled by default, allowing a DHCP server or router on the
network to assign an IP address to the switch.

If the switch is on-network, connected to a DHCP server, and connected to the Internet, you
can use a Windows-based computer to access the local browser Ul of the switch and register
the switch with NETGEAR. For more information, see Use a Windows-based computer to
access the switch on-network on page 19.

If you use a Mac, or if you do not know the IP address of the switch, use one of the following
tools to discover the IP address of the switch on the network:

NETGEAR Insight app. You can install the NETGEAR Insight app on an iOS or Android
mobile device and discover the IP address of the switch. See Use the NETGEAR Insight
mobile app to discover the IP address of the switch on page 21.

NETGEAR Switch Discovery Tool (SDT). If you use a Mac or a 64-bit Windows-based
computer, you can use the SDT to discover the switch on your network. See Use the
NETGEAR Switch Discovery Tool to discover the switch on page 22.

NETGEAR Smart Control Center (SCC). You can install the SCC on a Windows-based
computer. See one of the following sections:

» Discover the switch in a network with a DHCP server using the Smart Control
Center on page 23

» Discover the switch in a network without a DHCP server using the Smart Control
Center on page 24

Other tools. You can also get the IP address of the switch from the DHCP server in the
network or use an IP scanner utility. See Use other options to discover the switch IP
address on page 25.

When you know the IP address, you can configure the switch in the following ways:

Local browser Ul. For configuration of all switch features, access the switch over the
local browser Ul. See Access the switch on-network when you know the switch IP
address on page 26.

NETGEAR Smart Control Center (SCC). For configuration of a limited number of switch
features, use the SCC on a Windows-based computer. For more information, see the
SCC user manual, which you can download from netgear.com/support/product/SCC.

NETGEAR Insight app and Insight Cloud portal. You can change the management
mode of the switch so that you can use the NETGEAR Insight app and Insight Cloud
portal to manage the switch remotely. For more information, see Change the
management mode of the switch on page 37.
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Use a Windows-based computer to access the switch
on-network

For the following procedure, the network must provide Internet access.

To use a Windows-based computer to determine the switch IP address and access the
switch on-network:

1.
2.

© N o g A

Cable the switch to a network with a router or DHCP server that manages IP addresses.
Power on the switch.

The DHCP server assigns the switch an IP address.
Connect your computer to the same network as the switch.
You can use a WiFi or wired network connection.

Open Windows Explorer.

Click the Network link.

If prompted, enable the Network Discovery feature.

Under Network Infrastructure, locate the switch model number.

Double-click GSmodel-XXXXXX, in which GSmodel represents the model number of the
switch and XXXXXX represents the last six digits of the switch MAC address.

The page that displays depends on whether you logged in before.

Note: NETGEAR provides enhanced security by enforcing secure access
and communication between your web browser and the switch. Your
browser might display a security message that your connection is not
private or not secure, or that a problem with the security certificate
occurred. If such as security message displays, you cannot proceed
but must take action. See the next step.

If your browser displays a security message and does not let you proceed, do one of the

following, depending on the browser that you are using:

* Google Chrome. If Google Chrome displays a Your connection is not private
message, click the ADVANCED link. Then, click the Proceed to x.x.x.x (unsafe) link,
in which x.x.x.x represents the IP address of the switch.

» Apple Safari. If Apple Safari displays a This connection is not private message, click
the Show Details button. Then, click the visit this website link. If a warning pop-up
window opens, click the Visit Website button. If another pop-up window opens to let
you confirm changes to your certificate trust settings, enter your Mac user name and
password and click the Update Setting button.

* Mozilla Firefox. If Mozilla Firefox displays a Your connection is not secure message,
click the ADVANCED button. Then, click the Add Exception button. In the pop-up
window that opens, click the Confirm Security Exception button.

* Microsoft Internet Explorer. If Microsoft Internet Explorer displays a There is a
problem with this website’s security certificate message, click the Continue to this
website (not recommended).
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« Microsoft Edge. If Microsoft Edge displays a There is a problem with this website’s
security certificate message or a similar warning, select Details > Go on to the
webpage.

Note: Forinformation about installing a security certificate, see Use an HTTP
session to download and install an SSL security certificate file on the
switch on page 393.

10. Enter your credentials, which depend on the page that displays:

» Register to unlock all features page displays. If this is the first time that you log in
to the local browser Ul, the Register to unlock all features page displays. Click the
Log in with NETGEAR account button, and follow the directions onscreen to register
the switch with your NETGEAR email address and password. You are only prompted
to do this once to confirm registration of your switch.

If you did not yet create a NETGEAR account, click the Create account link, follow
the directions onscreen to create an account, and register the switch with your
NETGEAR email address and password.

* Local Device Login page displays. If you previously logged in to the local browser Ul
and already entered your NETGEAR email address and password, the Local Device
Login page displays. Enter one of the following credentials:

- Local device password. Enter the local device password.
The default local device password is password. The first time that you enter the

default local device password, the Change Default Password page displays,
requiring you to customize the local device password.

- Insight network password. If you previously logged in to the local browser Ul,
you changed the management mode to NETGEAR Insight, and you added the
switch to an Insight network location, enter the Insight network password to access
the local browser UI.

Note: After you add the switch to an Insight network location, the Insight
network password replaces the switch local device password.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
11. Click the Login button.

12. If the Change Default Password page displays, enter and confirm a new local device
password, and click the Submit button.

The System Information page displays. You can now configure the switch.
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Use the NETGEAR Insight mobile app to discover the

IP address of the switch
If the switch is connected to a WiFi router or access point, and the switch is connected to the
Internet, the NETGEAR Insight mobile app lets you discover the switch in your network.

Using the Netgear Insight app to discover the IP address of the switch in your network is not
the same as managing the switch with the Insight app or the Insight Cloud Portal.

Note: The default management mode of the switch is the local browser Ul.
If you want to use the Insight app or the Insight Cloud Portal to
manage the switch, you first must change the management mode
(see Change the management mode to NETGEAR Insight Mobile
App and Insight Cloud Portal on page 37). After you do so, you can
manage the switch with Insight and add the switch to an Insight
network location.

To use the NETGEAR Insight app to discover the IP address of the switch in your
network:

1. On your mobile device, go to the app store, search for NETGEAR Insight, and download
the latest version of the app.

# Download on the GETITON
S App Store ” Google Play

2. Connect your mobile device to the WiFi network of the WiFi router or access point to which
the switch is connected.

3. Open the NETGEAR Insight mobile app.

4. If you did not set up a NETGEAR account, tap Create NETGEAR Account and follow the
onscreen instructions.

5. Enter the email address and password for your account and tap LOG IN.

&

NETGEAR'

After you log in to your account, the IP address of the switch displays in the device list.
6. Write down the switch IP address.

You can use this IP address to access the switch directly from a web browser. For
information about how to access the local browser Ul of the switch, see Access the
switch on-network when you know the switch IP address on page 26.
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Use the NETGEAR Switch Discovery Tool to discover the
switch

For easiest access, we recommend that you cable the switch to a network with a router or
DHCP server that assigns IP addresses, power on the switch, and then use a computer that
is connected to the same network as the switch.

The NETGEAR Switch Discovery Tool lets you discover the switch in your network and
access the local browser Ul of the switch from a Mac or a 64-bit Windows-based computer.

To install the NETGEAR Switch Discovery Tool and discover the switch in your
network:

1.

Download the Switch Discovery Tool by visiting
netgear.com/support/product/netgear-switch-discovery-tool.aspx.

Depending on the computer that you are using, download either the Mac version or the
version for a 64-bit Windows-based computer.

Temporarily disable the firewall, Internet security, antivirus programs, or all of these on the
computer that you use to configure the switch.

Unzip the Switch Discovery Tool files, double-click the .exe or .dmg file (for example,
NETGEAR+Switch+Discovery+Tool+Setup+1.2.102.exe or
NetgearSDT-V1.2.102.dmg), and install the program on your computer.

The installation process places a NETGEAR Switch Discovery Tool icon on your
desktop.

Reenable the security services on your computer.
Power on the switch.

The DHCP server assigns the switch an IP address.
Connect your computer to the same network as the switch.

You can use a WiFi or wired connection. The computer and the switch must be on the
same Layer 2 network.

Open the Switch Discovery Tool.

To open the program, double-click the NETGEAR Switch Discovery Tool icon on your
desktop.

The initial page displays a menu and a button.

From the Choose a connection menu, select the network connection that allows the Switch
Discovery Tool to access the switch.

Click the Start Searching button.

The Switch Discovery Tool displays a list of switches that it discovers on the selected
network.

For each switch, the tool displays the IP address.
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10. Write down the switch IP address assigned by the DHCP server.

For information about how to access the local browser Ul of the switch, see Access the
switch on-network when you know the switch IP address on page 26.

Tip: After you complete the initial log-in process (see Register the switch
on page 31), you can access the local browser Ul from the Switch
Discovery Tool by clicking the ADMIN PAGE button next to your
switch.

Discover the switch in a network with a DHCP server
using the Smart Control Center

This section describes how to set up your switch in a network that includes a DHCP server.
The DHCP client on the switch is enabled by default. When you connect the switch to your
network, the DHCP server automatically assigns an IP address to the switch. Use the Smart
Control Center (SCC) to discover the IP address automatically assigned to the switch.

For information about the SCC, visit https://www.netgear.com/support/product/SCC.

To install the switch in a network with a DHCP server:

1. Connect the switch to a network with a DHCP server.

Power on the switch by connecting its power cord.

Install the SCC on your computer.

Start the SCC.

Click the Discover button for the SCC to discover all the devices in the subnet.

a s b

NETGEAR

Network Maintenance Tasks Adapter Help LQuIT

Discovered all network devices. Dis

iscover |

6. Write down the switch IP address assigned by the DHCP server.

For information about how to access the local browser Ul of the switch, see Access the
switch on-network when you know the switch IP address on page 26.
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Tip: After you complete the initial log-in process (see Register the switch
on page 31), you can access the local browser Ul from the SCC by
selecting your switch in the SCC and clicking the
Web Browser Access button.

Discover the switch in a network without a DHCP server
using the Smart Control Center

This section describes how to use the Smart Control Center (SCC) to set up your switch in a
network without a DHCP server. If your network does not include a DHCP service, you must
assign a static IP address to your switch.

If you prefer, you can assign the switch a static IP address even if your network does include
a DHCP server.

As an offline option, if you connect your computer directly to the switch using an Ethernet
cable (that is, offline), you can also use the SCC to assign a static IP address to your switch.
After you do so, you can connect your switch to the network.

For information about the SCC, visit netgear.com/support/product/SCC.

To assign a static IP address:

1.

o~ wD

Connect the switch to your existing network or directly to your computer using an
Ethernet cable.

Note: If you connect your computer directly to the switch using an Ethernet
cable, the IP address settings of your computer do not need to be in
the same IP subnet as the switch. The SCC can detect the IP address
settings of the switch even if they are in a different subnet.

Power on the switch by connecting its power cord.

Install the SCC on your computer.

Start the SCC.

Click the Discover button for the SCC to find your switch.

The utility broadcasts Layer 2 discovery packets within the broadcast domain to discover
the switch.

Select the switch, and then click the Configure Device button.
The page expands to display additional fields at the bottom.
Select the Disabled radio button.

DHCP is disabled.

Enter the static switch IP address, gateway IP address, and subnet mask that you want to
assign for the switch.
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NETGEAR

Network Maintenance Tasks Adapter Help (_QuIT

Current Network Adapter 192.168.100.102

P 1P Address | 102.168.100.107 Subnet Hask
Enabled Gateway  192.168.100.1 System Nama

cC g

Oisabled  Location " Current Password

Define the basic configuration. Cancel

9. Type the local device password to continue with the configuration change.

You must enter the local device password each time that you use the SCC to update the
switch settings. The default local device password is password.

10. Click the Apply button.

Your settings are saved.

For information about how to access the local browser Ul of the switch, see Access the
switch on-network when you know the switch IP address on page 26.

Tip: After you complete the initial log-in process (see Register the switch
on page 31), you can access the local browser Ul from the SCC by
selecting your switch in the SCC and clicking the
Web Browser Access button.

Use other options to discover the switch IP address

If the switch is on-network, you can use one of the following options to determine the switch
IP address:

» Access the DHCP server. You can access the DHCP server (or router that functions as
a DHCP server) in your network and view the IP address that is assigned to the switch.
For more information, see the documentation for your DHCP server (or router).

* Use an IP scanner utility. IP scanner utilities are available free of charge on the Internet.
An IP scanner utility lets you discover the IP address that is assigned to the switch.

For information about how to access the local browser Ul of the switch, see Access the
switch on-network when you know the switch IP address on page 26.
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Access the switch on-network when you know the switch IP
address

If the switch is on-network and you know the switch IP address, you can access the local
browser Ul.

For the following procedure, the network must provide Internet access.

To access the switch on-network when you know the switch IP address:

1. Launch a web browser.
2. In the address field of your web browser, enter the IP address of the switch.

The page that displays depends on whether you logged in before.

Note: NETGEAR provides enhanced security by enforcing secure access

and communication between your web browser and the switch. Your
browser might display a security message that your connection is not
private or not secure, or that a problem with the security certificate
occurred. If such as security message displays, you cannot proceed
but must take action. See the next step.

3. If your browser displays a security message and does not let you proceed, do one of the
following, depending on the browser that you are using:

4. If your browser displays a security message and does not let you proceed, do one of the
following, depending on the browser that you are using:

Google Chrome. If Google Chrome displays a Your connection is not private
message, click the ADVANCED link. Then, click the Proceed to x.x.x.x (unsafe) link,
in which x.x.x.x represents the IP address of the switch.

Apple Safari. If Apple Safari displays a This connection is not private message, click
the Show Details button. Then, click the visit this website link. If a warning pop-up
window opens, click the Visit Website button. If another pop-up window opens to let
you confirm changes to your certificate trust settings, enter your Mac user name and
password and click the Update Setting button.

Mozilla Firefox. If Mozilla Firefox displays a Your connection is not secure message,
click the ADVANCED button. Then, click the Add Exception button. In the pop-up
window that opens, click the Confirm Security Exception button.

Microsoft Internet Explorer. If Microsoft Internet Explorer displays a There is a
problem with this website’s security certificate message, click the Continue to this
website (not recommended).

Microsoft Edge. If Microsoft Edge displays a There is a problem with this website’s
security certificate message or a similar warning, select Details > Go on to the
webpage.

Note: Forinformation about installing a security certificate, see Use an HTTP

session to download and install an SSL security certificate file on the
switch on page 393.
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5. Enter your credentials, which depend on the page that displays:

Register to unlock all features page displays. If this is the first time that you log in
to the local browser Ul, the Register to unlock all features page displays. Click the
Log in with NETGEAR account button, and follow the directions onscreen to
register the switch with your NETGEAR email address and password. You are only
prompted to do this once to confirm registration of your switch.

If you did not yet create a NETGEAR account, click the Create account link, follow
the directions onscreen to create an account, and register the switch with your
NETGEAR email address and password.

Local Device Login page displays. If you previously logged in to the local browser Ul
and already entered your NETGEAR email address and password, the Local Device
Login page displays. Enter one of the following credentials:

- Local device password. Enter the local device password.

The default local device password is password. The first time that you enter the
default local device password, the Change Default Password page displays,
requiring you to customize the local device password.

- Insight network password. If you previously logged in to the local browser Ul,
you changed the management mode to NETGEAR Insight, and you added the
switch to an Insight network location, enter the Insight network password to access
the local browser UI.

Note: After you add the switch to an Insight network location, the Insight
network password replaces the switch local device password.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
6. Click the Login button.

7. If the Change Default Password page displays, enter and confirm a new local device
password, and click the Submit button.

The System Information page displays. You can now configure the switch.

Access the switch off-network

If the switch is off-network and not connected to the Internet, before you can unlock the full
menu of the local browser Ul, you must do one of the following:

» Connect the switch to a network with Internet access at least once so that you can
register the switch with NETGEAR.

* Get a registration key.

For more information about these registration options, see Register the switch on page 31.
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The default IP address of the switch is 192.168.0.239. The IP address of the computer that
you use to access the switch off-network must in the same subnet as the default IP address
of the switch.

To access the switch off-network and not connected to the Internet after you
registered the switch with NETGEAR or obtained a registration key:

1. Change the IP settings of your computer to be in the same subnet as the IP settings of
the switch.

If the DHCP client of the switch is enabled and you remove the switch from the network
with the DHCP server, the IP address reverts to the default IP address of 192.168.0.239
with a subnet of 255.255.255.0.

Note: If you already disabled the DHCP client and assigned a static IP
address to the switch, change the IP settings of your computer to be in
the same subnet as the static IP address.

For more information about changing the IP settings on your computer, see one of the
following knowledge base articles at the NETGEAR website:

* Windows-based computer. See the following article:
https://kb.netgear.com/27476/How-to-set-a-static-IP-address-in-Windows

e Mac. See the following article:
https://kb.netgear.com/000037250/Setting-a-static-IP-address-on-your-network-a
dapter-in-Mac-OS-for-direct-access-to-an-access-point

(The Mac article is written for an access point but is also valid for a switch.)

Connect your computer to the switch using an Ethernet cable.
Power on the switch by connecting its power cord.

Launch a web browser.

Open a web browser, and enter http://192.168.0.239.

This is the default IP address of the switch. If you already disabled the DHCP client and
assigned a static IP address to the switch, enter the static IP address of the switch.

SAE R <

The Local Device Login page displays.

Note: NETGEAR provides enhanced security by enforcing secure access
and communication between your web browser and the switch. Your
browser might display a security message that your connection is not
private or not secure, or that a problem with the security certificate
occurred. If such as security message displays, you cannot proceed
but must take action. See the next step.

6. If your browser displays a security message and does not let you proceed, do one of the
following, depending on the browser that you are using:

e Google Chrome. If Google Chrome displays a Your connection is not private
message, click the ADVANCED link. Then, click the Proceed to x.x.x.x (unsafe) link,
in which x.x.x.x represents the IP address of the switch.
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* Apple Safari. If Apple Safari displays a This connection is not private message, click
the Show Details button. Then, click the visit this website link. If a warning pop-up
window opens, click the Visit Website button. If another pop-up window opens to let
you confirm changes to your certificate trust settings, enter your Mac user name and
password and click the Update Setting button.

* Mozilla Firefox. If Mozilla Firefox displays a Your connection is not secure message,
click the ADVANCED button. Then, click the Add Exception button. In the pop-up
window that opens, click the Confirm Security Exception button.

* Microsoft Internet Explorer. If Microsoft Internet Explorer displays a There is a
problem with this website’s security certificate message, click the Continue to this
website (not recommended).

* Microsoft Edge. If Microsoft Edge displays a There is a problem with this website’s
security certificate message or a similar warning, select Details > Go on to the
webpage.

Note: Forinformation about installing a security certificate, see Use an HTTP
session to download and install an SSL security certificate file on the
switch on page 393.

7. Enter one of the following credentials:
« Local device password. Enter the local device password.

The default local device password is password. The first time that you enter the
default local device password, the Change Default Password page displays, requiring
you to customize the local device password.

* Insight network password. If you previously logged in to the local browser Ul, you
changed the management mode to NETGEAR Insight, and you added the switch to an
Insight network location, enter the Insight network password to access the local
browser Ul.

Note: After you add the switch to an Insight network location, the Insight
network password replaces the switch local device password.

« Registration key. If you obtained a registration key, enter it. For more information,
see Register the switch with your NETGEAR account and get a registration key for
offline access on page 33.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

8. If you enter a password, click the Login button. If you enter a registration key, click the
Submit button.

9. If the Change Default Password page displays, enter and confirm a new local device
password, and click the Submit button.

The System Information page displays. You can now configure the switch.

10. After you complete the configuration of the switch, reconfigure the computer that you used
for this process to its original TCP/IP settings.

You can now connect your switch to your network using an Ethernet cable.
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Credentials for the local browser Ul

The information in this section applies to accessing the switch local browser Ul in either
management mode. That is, it does not apply to accessing the NETGEAR Insight app and
Cloud portal.

Note: Until you register and access the switch with your NETGEAR account
or obtain and enter a registration key, you can access only a limited
menu of the local browser Ul. This limitation applies to either
management mode.

To access the local browser Ul, and depending on your situation, use one of the following
credentials:

« NETGEAR account credentials.

When you access the local browser Ul for the first time, you can register the switch by
entering your NETGEAR account credentials and unlock the full menu of the local
browser Ul (see Register the switch with your NETGEAR account and access the switch
online on page 32). If you do not own a free NETGEAR account, you can create one.

Alternatively, you can obtain a registration key and enter the key to unlock the full menu of
the local browser Ul (see Register the switch with your NETGEAR account and get a
reqgistration key for offline access on page 33).

e Local device password.

After you register the switch with your NETGEAR account, you can access the full menu
of the local browser Ul with your local device password. The first time that you access the
local browser Ul, you can enter the default password as the local device password, but
you are then required to customize the password for increased security. Subsequent
times that you log in to the local browser Ul, use your customized local device password.

* NETGEAR Insight network location password.

NETGEAR Insight can affect how you access the switch local browser Ul. If you add the
switch to an Insight network location (this process is referred to as claiming), the switch is
automatically registered to your NETGEAR account. After you add the switch to an
Insight network location, the Insight network location password replaces the switch local
device password. To access the local browser Ul, you must enter the Insight network
location password. For information about how the Insight network password functions,
visit netgear.com/support/product/Insight.aspx. For knowledge base articles about
NETGEAR Insight, visit netgear.com/support.

However, if you use the NETGEAR Insight app to discover the IP address of the switch in
your physical network but do not claim the switch by adding it to an Insight network location,
the switch is registered only after you access the switch local browser Ul with your

Get Started 30 User Manual


https://www.netgear.com/support/product/Insight.aspx
http://netgear.com/support/

24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

NETGEAR account credentials. After you do so, you can access the full menu of the local
browser Ul with your local device password.

The following table lists the essential credential options for access to the local browser Ul.

Table 3. Credentials for access to the local browser Ul

Management mode Registered Added to an Credentials Local browser Ul
Insight network menu
Default mode: No N/A Local device password Limited menu
Direct Connect Web
Browser Interface (Local Yes No Local device password Full menu
LAN Only) )
Yes Yes Insight network password  Full menu
NETGEAR Insight Mobile No N/A Local device password Limited menu
App and Insight Cloud
Portal (Cloud/Remote) Yes No Local device password Limited menu
Yes Yes Insight network password Limited menu

Register the switch

You only need to register and access the switch local browser Ul once with your NETGEAR
account. After you do so, you can access the local browser Ul with the local device
password, or if you previously added the switch to an Insight network, with the Insight
network password. For more information, see Credentials for the local browser Ul on

page 30.

You can use one the following methods to register the switch and unlock the full menu of the
local browser Ul:

« Onlineregistration for on-network access. If your switch is on-network or connected to
the Internet, you can access the full menu of the local browser Ul after you register the
switch with your NETGEAR account credentials. During the registration process, the
switch contacts a NETGEAR server. For more information, see Register the switch with
your NETGEAR account and access the switch online on page 32.

» Preregistration for off-network access. You can preregister your switch from any
device that is connected to the Internet and get a registration key. If the switch is
off-network or not connected to the Internet, you can enter the registration key to unlock
the full menu of the local browser Ul. For more information, see Register the switch with
your NETGEAR account and get a registration key for offline access on page 33.
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Register the switch with your NETGEAR account and

access the switch online
For initial registration and access with your NETGEAR account, the switch must be
connected to the Internet so that it can communicate with a NETGEAR server.
If you do not own a free NETGEAR account, you can create one during the registration
process.
To register and access the switch online over the local browser Ul with your NETGEAR
account:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

For information about finding the IP address of the switch, see Access the switch
on-network and connected to the Internet on page 18 or Access the switch off-network

on page 27.
The Reqgister to unlock all features page displays.

Note: NETGEAR provides enhanced security by enforcing secure access
and communication between your web browser and the switch. Your
browser might display a security message that your connection is not
private or not secure, or that a problem with the security certificate
occurred. If such as security message displays, you cannot proceed
but must take action. See the next step.

4. If your browser displays a security message and does not let you proceed, do one of the
following, depending on the browser that you are using:

e Google Chrome. If Google Chrome displays a Your connection is not private
message, click the ADVANCED link. Then, click the Proceed to x.x.x.x (unsafe) link,
in which x.x.x.x represents the IP address of the switch.

« Apple Safari. If Apple Safari displays a This connection is not private message, click
the Show Details button. Then, click the visit this website link. If a warning pop-up
window opens, click the Visit Website button. If another pop-up window opens to let
you confirm changes to your certificate trust settings, enter your Mac user name and
password and click the Update Setting button.

e Mozilla Firefox. If Mozilla Firefox displays a Your connection is not secure message,
click the ADVANCED button. Then, click the Add Exception button. In the pop-up
window that opens, click the Confirm Security Exception button.

e Microsoft Internet Explorer. If Microsoft Internet Explorer displays a There is a
problem with this website’s security certificate message, click the Continue to this
website (not recommended).
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» Microsoft Edge. If Microsoft Edge displays a There is a problem with this website’s
security certificate message or a similar warning, select Details > Go on to the
webpage.

Note: Forinformation about installing a security certificate, see Use an HTTP
session to download and install an SSL security certificate file on the
switch on page 393.

5. Click the Log in with NETGEAR account button and follow the directions onscreen to
register the switch with your NETGEAR email address and password.

You are only prompted to do this once to confirm registration of your switch.

If you did not yet create a NETGEAR account, click the Create account link, follow the
directions onscreen to create an account, and register the switch with your NETGEAR
email address and password.
For information about the credentials, see Credentials for the local browser Ul on
page 30.

6. Click the Login button.

7. If the Change Default Password page displays, enter and confirm a new local device
password, and click the Submit button.

The System Information page displays. You can now configure the switch.

Register the switch with your NETGEAR account and get a
registration key for offline access

After you register your switch with NETGEAR, you can get a registration key, access the
switch offline or not connected to the Internet, an unlock full access to the local browser Ul.

This procedure describes how you can visit mynetgear.com, log in to your NETGEAR
account, register the switch using its serial number, and get a registration key.

You can also use the NETGEAR Insight app to get a registration key. NETGEAR Insight
Premium or Pro subscribers can use the Insight Cloud Portal to get a registration key. For
information about how the registration key functions with Insight, visit
netgear.com/support/product/Insight.aspx. For knowledge base articles about NETGEAR
Insight, visit netgear.com/support.

To register the switch with your NETGEAR account, get a registration key, and access
the switch offline over the local browser Ul:

1. From a computer or mobile device that is connected to the Internet, go to
mynetgear.com.

2. Log in to your NETGEAR account.

If you do not own a free NETGEAR account, you can create one.
3. From the menu on the left, select Register a Product.

The page adjusts.
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4. In the Serial Number field, enter the serial number of the switch.

The serial number consists of 13 digits. The serial number is usually printed on a label on
the bottom or the back panel of the switch.

5. Click the Register button.
The switch is registered with NETGEAR.

6. If the My Products does not display, click My Products from the menu.
The page adjusts.

7. Select the radio button for the newly registered switch, and click the Get Registration Key
button.

The registration key is displayed, and an email with the registration key is sent to your
NETGEAR account email address.

8. Change the IP settings of your computer to be in the same subnet as the IP settings of the
switch.

If the DHCP client of the switch is enabled and you remove the switch from the network
with the DHCP server, the IP address reverts to the default IP address of 192.168.0.239
with a subnet of 255.255.255.0.

Note: If you already disabled the DHCP client and assigned a static IP
address to the switch, change the IP settings of your computer to be in
the same subnet as the static IP address.

For more information about changing the IP settings on your computer, see one of the
following knowledge base articles at the NETGEAR website:

* Windows-based computer. See the following article:
https://kb.netgear.com/2747 6/How-to-set-a-static-IP-address-in-Windows

* Mac. See the following article:
https://kb.netgear.com/000037250/Setting-a-static-IP-address-on-your-network-a
dapter-in-Mac-OS-for-direct-access-to-an-access-point

(The Mac article is written for an access point but is also valid for a switch.)

9. Connect your computer to the switch using an Ethernet cable.
10. Power on the switch by connecting its power cord.

11. Launch a web browser.

12. Open a web browser, and enter http://192.168.0.239.

This is the default IP address of the switch. If you already disabled the DHCP client and
assigned a static IP address to the switch, enter the static IP address of the switch.

The Local Device Login page displays.
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Note: NETGEAR provides enhanced security by enforcing secure access
and communication between your web browser and the switch. Your
browser might display a security message that your connection is not
private or not secure, or that a problem with the security certificate
occurred. If such as security message displays, you cannot proceed
but must take action. See the next step.

13. If your browser displays a security message and does not let you proceed, do one of the
following, depending on the browser that you are using:

* Google Chrome. If Google Chrome displays a Your connection is not private
message, click the ADVANCED link. Then, click the Proceed to x.x.x.x (unsafe) link,
in which x.x.x.x represents the IP address of the switch.

» Apple Safari. If Apple Safari displays a This connection is not private message, click
the Show Details button. Then, click the visit this website link. If a warning pop-up
window opens, click the Visit Website button. If another pop-up window opens to let
you confirm changes to your certificate trust settings, enter your Mac user name and
password and click the Update Setting button.

* Mozilla Firefox. If Mozilla Firefox displays a Your connection is not secure message,
click the ADVANCED button. Then, click the Add Exception button. In the pop-up
window that opens, click the Confirm Security Exception button.

» Microsoft Internet Explorer. If Microsoft Internet Explorer displays a There is a
problem with this website’s security certificate message, click the Continue to this
website (not recommended).

» Microsoft Edge. If Microsoft Edge displays a There is a problem with this website’s
security certificate message or a similar warning, select Details > Go on to the
webpage.

Note: Forinformation about installing a security certificate, see Use an HTTP
session to download and install an SSL security certificate file on the
switch on page 393.

14. Enter the registration key.
15. Click the Submit button.

16. If the Change Default Password page displays, enter and confirm a new local device
password, and click the Submit button.

The System Information page displays. You can now configure the switch.

17. After you complete the configuration of the switch, reconfigure the computer that you used
for this process to its original TCP/IP settings.

You can now connect your switch to your network using an Ethernet cable.
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Change the language of the local
browser Ul

By default, the language is set to Auto. You can set the language to a specific one.

To change the language of the local browser Ul:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. At the top of the page, to the left of Welcome, select a language from the language menu.
A confirmation pop-up window opens.

7. Click the OK button.

You are logged out. The language of the local browser Ul is set to the language that you
selected.

8. To continue configuring the switch, log in again.
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Change the management mode of the
switch

By default, the management mode on the switch is Directly Connect to Web Browser
Interface (which is the same as the local browser Ul). You can also change the management
mode to NETGEAR Insight Mobile App and Insight Cloud Portal.

About changing the management mode

The following applies to changing the management mode:

* Changing to the NETGEAR Insight Mobile App and Insight Cloud Portal mode.

- The first time that you enable this mode, the switch is reset to its factory default
settings so that you can create the switch configuration and network topology using
the Insight app or the Insight Cloud portal.

- If you previously added the switch to a network location on the Insight app or Insight
Cloud portal, all Insight-manageable device settings are returned to the last
configuration saved on the cloud server, including the switch local device password
(that is, the password is reset to the Insight network location password).

- If you use the Insight app or the Insight Cloud portal, you can temporarily change the
management mode of the switch back to Directly Connect to Web Browser Interface.
You can then access the local browser Ul for settings that are not
Insight-manageable, for complex tasks such as integrating with an existing network of
devices that are not managed through Insight, and for debugging purposes. When
you are done, you can change the management mode back to NETGEAR Insight
Mobile App and Insight Cloud Portal.

* Changing back to Directly Connect to Web Browser Interface mode.

- The NETGEAR Insight Mobile App and Insight Cloud Portal management mode is
disabled and the current Insight-manageable device settings are saved to the cloud
server.

- Any changes that you make using the Directly Connect to Web Browser Interface
management mode are not saved to the cloud server.

Change the management mode to NETGEAR Insight
Mobile App and Insight Cloud Portal

To change the management mode of the switch to NETGEAR Insight Mobile App and
Insight Cloud portal:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select the NETGEAR Insight Mobile App and Insight Cloud Portal radio button.
An Alert pop-up window opens.
7. Read the text, and click the OK button.
The pop-up window closes.
8. Click the Apply button.
Another pop-up window opens.
9. Click the OK button.

The pop-up window closes, the System Information page closes, and your settings are
saved.

The following occurs:

« The first time that you enable this mode, the switch is reset to its factory default
settings.

* The switch connects to the cloud server.

« If you previously added the switch to a network on the Insight app or Insight Cloud
portal, all Insight-manageable device settings are returned to the last configuration
saved on the cloud server, including the switch password (that is, the password is
reset to the Insight network password).

» The Local Device Login page might display again. (You can close the page.)

You can now manage the switch using the Insight mobile app or Insight Cloud portal.
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For more information about NETGEAR Insight, visit netgear.com/insight and
netgear.com/support/product/Insight.aspx. For knowledge base articles about NETGEAR

Insight, visit netgear.com/support.

Change the management mode back to Directly Connect
to Web Browser Interface

To change the management mode of the switch back to Directly Connect to Web
Browser Interface:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select the Directly Connect to Web Browser Interface radio button.
An Alert pop-up window opens.

Read the text, and click the OK button.

The pop-up window closes.

Click the Apply button.

Another pop-up window opens.

Click the OK button.
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The pop-up window closes, the System Information page closes, and your settings are
saved. Any current Insight-manageable device settings are saved to the cloud server.

The Local Device Login page displays.
10. Log in again.

The System Information page displays and the full menu of the local browser Ul is now
available.

Use the Device View of the local browser Ul

The Device View displays the ports on the switch. This graphic tool provides an alternate way
to navigate to configuration and monitoring options. The graphic tool also provides
information about device ports, configuration and status, tables, and feature components.
To use the Device View:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Device View.
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The following table describes the system LEDs in the Device View.

System LED  Color Description

Power LED Solid green Power is supplied to the switch and the switch is operating normally.

Note: The physical Power LED on the switch can also light solid amber.
Solid amber does not apply to the Device View. (If the switch is off or
booting, you cannot access the Device View.)

Fan LED Off The internal fan is operating normally

Solid yellow The internal fan failed.

Note: In this situation, the physical Fan LED on the switch lights solid
amber rather than yellow.

PoE Max LED Off Sufficient (more than 7W of) PoE power is available on the switch

Solid yellow Less than 7W of PoE power is available on the switch.

Note: In this situation, the physical POE Max LED on the switch lights
solid amber rather than yellow.

Note: The physical POE Max LED on the switch can also blink amber,
indicating that at least once during the previous two minutes, less than
7W of PoE power was available.

For each Ethernet port and for the two SFP fiber ports in the Device view, colors indicate
the link status of the port. In addition, each Ethernet port also provides two port LEDs,
which are located on the left. For each port, an upper port LED indicates the port speed
status and a lower port LED indicates the port PoE status.

The following table describes the ports and port LEDs in the Device View.

Port or Color Description
port LED
Ethernet port  Black No Ethernet link is established.
Solid green An Ethernet link is established.
Solid red An error occurred on the port or the port is administratively disabled.

Get Started 41 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

Port or Color Description
port LED
Upper Ethernet Solid dark green  No Ethernet link is established.
port LED
Solid green A 1000 Mbps Ethernet link is established
Blinking green The port is transmitting or receiving packets at 1000 Mbps.
Solid yellow A 10 Mbps or 100 Mbps Ethernet link is established.
Note: In this situation, the physical upper port LED on the switch lights
solid amber rather than yellow.
Blinking yellow The port is transmitting or receiving packets at 10 Mbps or 100 Mbps.
Note: In this situation, the physical upper port LED on the switch blinks
amber rather than yellow.
Lower Ethernet Solid dark green  The port is not delivering PoE.
port LED
Solid green The port is delivering PoE.
Solid yellow A PoOE fault occurred.
Note: In this situation, the physical lower port LED on the switch lights
solid amber rather than yellow.
SPF fiber port  Black No SFP module link is established.
Solid green A 1000 Mbps link is established.

Blinking green

The SFP fiber port is transmitting or receiving packets at 1000
Mbps.

7. Click a port to open a menu that displays statistics and configuration options.

You can select a menu option to access the page that contains the configuration or
monitoring options.

If you right-click the graphic, but do not right-click a specific port, the main menu displays.
This menu contains the same options as the navigation tabs at the top of the page.

Get Started

42 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

[ Spon | vy | Qo5 | Socuy | Worwow | Memewwwe | o | we | |

Management PoE SNMP LLDP Serices Timer Schedule
Device View Device View

*Device View NETOEAR 5o
System » Management )
Switching » Device View »
QoS » PoE »
Security » SNMP »
Monitoning » LLDP »
Maintenance ) DHCP Snooping »|  Global Configuration
Help » Timer Schedule ) Interface Configuration
Index »

Binding Configuration
Persistent Configuration
Statistics

Right-click the specific port that you want to view or configure to see a menu that displays
statistics and configuration options. Select the menu option to access the page that
contains the configuration or monitoring options.
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Contigure interface settings

The switch supports physical and logical interfaces. Interfaces are identified by their type and
the interface number. The physical ports are Gigabit interfaces and are numbered on the
front panel. You configure the logical interfaces by using the software.

The following table describes the naming convention for all interfaces available on the switch.

Table 4. Naming conventions for interfaces

Interface Description Example

Physical The physical ports are 1 Gigabit Ethernet interfaces and are g1, g2, g12
numbered sequentially starting from 1.

Link aggregation group (LAG) LAG interfaces are logical interfaces that are used only for 11, 12, I3
bridging functions.

CPU management interface This is the internal switch interface responsible for the switch c1
base MAC address. This interface is not configurable and is
always listed in the MAC Address Table.

For some features that allow you to configure interface settings, you can apply the same
settings simultaneously to any of the following:

e Asingle port

* Multiple ports

* All ports

* Asingle LAG

e Multiple LAGs

* AllLAGs

e Multiple ports and LAGs

* All ports and LAGs

Many of the pages that allow you to configure or view interface settings include links to
display all ports, all LAGs, or all ports and LAGs on the page.

Use these links as follows:

» To display all ports, click the 1 link.
* To display all LAGs, click the LAG link.
» To display all ports and LAGs, click the All link.

The procedures in this section describe how to select the ports and LAGs to configure. The
procedures assume that you are already logged in to the switch. If you do not know how to
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log in to the switch, see Access the switch on-network and connected to the Internet on
page 18 or Access the switch off-network on page 27.

To configure a single port by using the Go To Interface field:

1. Ensure that the page is displaying all ports, and not only the LAGs.

2. Inthe Go To Interface field, type the port number, for example g3.
For more information, see Configure interface settings on page 44.

3. Click the Go button.

The check box associated with the interface is selected, the row for the selected interface
is highlighted, and the interface number appears in the heading row.

Interface Configuration

1 LAG Al Go To Interface m
Interface Trust Mode

g3

4
o @ @ Q a
BN =

g10
J )

gi1

4. Configure the desired settings.
5. Click the Apply button.

Your settings are saved.

To configure a single LAG by using the Go To Interface field:
1. Click the LAG link or the All link to display the LAGs.
In the Go To Interface field, type the LAG number, for example 13.
For information, see Configure interface settings on page 44.
3. Click the Go button.

The check box associated with the interface is selected, the row for the selected interface
is highlighted, and the interface number appears in the heading row.

4. Configure the desired settings.
5. Click the Apply button.

Your settings are saved.
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To configure a single port:

1. Ensure that the page is displaying all ports, and not only the LAGs.
2. Select the check box next to the port number.

The row for the selected interface is highlighted, and the interface number appears in the
heading row.

3. Configure the desired settings.
4. Click the Apply button.

Your settings are saved.

To configure a single LAG:

1. Click the LAG link or the All link to display the LAGs.
2. Select the check box next to the LAG number.

The row for the selected interface is highlighted, and the interface number appears in the
heading row.

3. Configure the desired settings.
4. Click the Apply button.

Your settings are saved.

To configure multiple ports:

1. Ensure that the page is displaying all ports, and not only the LAGs.
2. Select the check box next to each port to configure.

The row for each selected interface is highlighted.

Interface Configuration
1 LAG All Go To Interface m
Interface Trust Mode
Disabled
g2 Disabled
v g3 Disabled
g4 Disabled
s g5 Disabled
v g6 Disabled
gT
8
a9

3. Configure the desired settings.
4. Click the Apply button.

Your settings are saved.
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To configure multiple LAGs:

1. Click the LAG link or the All link to display the LAGs.
2. Select the check box next to each LAG to configure.

The check box associated with each interface is selected, and the row for each selected
interface is highlighted.

3. Configure the desired settings.

4. Click the Apply button.

Your settings are saved.

To configure all ports:

1. Ensure that the page is displaying only ports, and not LAGs.
2. Select the check box in the heading row.

The check box associated with every port is selected, and the rows for all ports are
highlighted.

Interface Configuration

1 LAG All

v Interface Trust Mode
v gl Disabled
4 g2 Disabled
v g3 Disabled
C4 gd Disabled
v g5 Disabled
Ci g6 Disabled
7| g7 Disabled
v g8 Disabled
v g9 Disabled
v gl0 Disabled
v g1 Disabled
v gi2 Disabled
v gi3 Disabled
v gl4 Disabled
v g15 Disabled
o alé Disabled

3. Configure the desired settings.

4. Click the Apply button.
Your settings are saved.

To configure all LAGs:

1. Click the LAG link to display only the LAG interfaces.
2. Select the check box in the heading row.

The check box associated with every LAG is selected, and the rows for all LAGs are
highlighted.

3. Configure the desired settings.
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4. Click the Apply button.

Your settings are saved.

To configure multiple ports and LAGs:

1. Click the All link to display all ports and LAGs.

2. Select the check box associated with each port and LAG to configure.
The rows for the selected ports and LAGs are highlighted.

3. Configure the desired settings.
4. Click the Apply button.

Your settings are saved.

To configure all ports and LAGs:
1. Click the All link to display all ports and LAGs.
Select the check box in the heading row.

The check box associated with every port and LAG is selected, and the rows for all ports
and LAGs are highlighted.

3. Configure the desired settings.
4. Click the Apply button.

Your settings are saved.

Access the NETGEAR support website

From the local browser Ul, you can access the NETGEAR support website at
netgear.com/support.

To access the support website from the local browser Ul:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Help > Support.
The Support page displays.
7. To access the NETGEAR support site for the switch, click the Apply button.

Access the user manual online

The user manual (the guide you are now reading) is available at the NETGEAR download
center at netgear.com/support/download/.

To access the user manual online from the local browser Ul:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.
5. Click the Login button.

The System Information page displays.

6. Select Help > Online Help > User Guide.
The User Guide page displays.

7. To access the NETGEAR download center, click the Apply button.
8. Enter the model number of the switch.
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Configure System Information

This chapter contains the following sections:

* View or define switch system information

» Configure the switch IP address settings

e Configure the IPv6 network interface

e Configure the time settings

» Configure Denial of Service settings

e Configure the DNS settings

» Configure Green Ethernet settings

e Use the Device View

* Configure Power over Ethernet
e Configure SNMP
 Configure LLDP

» Configure DHCP snooping

* Set up PoE timer schedules
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View or define switch system information

You can view or define system information, view temperature information, view fan
information, and view software information.

View or define system information

When you log in, the System Information page displays. You can configure and view general
device information.

To view or define system information:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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NETGEAR B e

GST24TPP: 24-Port G:Bablt Hi-Power PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports and Cloud Management Auto «| Welcome admin | )

T B e O T

Device View PoE SNMP LLDP  Services  Timer Schedule

(o |
Management Management Mode ]
* System Information @® Directly Connect to Web Browser Interface MNETGEAR Insight Mobile App and Insight Cloud Portal
*IP Configuration (Local LAN Only) {Cloud/Memote)
% :?;Sﬁrgéff;?cm * Insight Subscnption Required
= IPvE Network Neighbor
«Time -
«Donial of Sarvice . Application Information @
*DNS > | App Name App Status Version
+Green Ethemet v CloudAgent Device not added in Account ~ 5.8.0.50800050
Confighgent Operational £.8.0.50800050
DiscoveryAgent  Operational 5.8.0.50800050
System Information V]
Product Name GST24TPP: 24-Port Gigabit Hi-Power PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports and Cloud Management

System Name
Syslem Location

System Contact

Serial Number 65F1995TF0052

System Object OID 1.3.6.1.4.1.4526.100.4 62

Date & Time Dec 02 23:38:16 2019 (UTC+0)
System Up Time 0 days 2 hours 31 mins 16 secs
Base MAC Address BC:A5:11:21:80:94

6. Define the following fields:

« System Name. Enter the name to identify this switch. You can use up to 255
alphanumeric characters. The default is blank.

e System Location. Enter the location of this switch. You can use up to 255
alphanumeric characters. The default is blank.

» System Contact. Enter the contact person for this switch. You can use up to 255
alphanumeric characters. The default is blank.

7. Click the Apply button.
Your settings are saved.

The following table describes the status information that the System Information page

displays.

Field Description

Product Name The product name of this switch.

Serial Number The serial number of the switch.

System Object OID The base object ID for the switch's enterprise MIB.
Date & Time The current date and time.
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Field Description
System Up Time The time in days, hours, and minutes since the last switch reboot.
Base Mac Address Universally assigned hardware address of the switch.

View the fan status

The fans remove the heat generated by the power, CPU, and other components, and allow
the switch to function normally.

Model GS724TPv2 integrates two fans. Model GS724TPP integrates three fans. You can
view the fan status.

To view the fan status:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Scroll down to the Fans section.
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Fans

FAN Description Type Speed Duty Level (%) State
1 Fan-1 Fixed 0 20 Off
2 Fan-2 Fixed 0 20 Off
3 Fan-3 Fixed 0 20 Off

7. To refresh the page, click the Refresh button.
The following table describes the nonconfigurable temperature and fan status information.

Table 5. Fan status

Field Description

FAN The fan index used to identify the fan for the switch.
Description The description of the fan temperature sensor.

Type Specifies whether the fan module is fixed or removable.
Speed The fan speed.

Duty level (%) The duty level of the fan.

State Specifies whether the fan is operational.

View the software versions
You can view the software versions that are running on the switch.

To view the software versions:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Scroll down to the Versions section.

Versions
Model Name Boot Version Software Version
GST24TPP 1.0.04 1.2.012

7. To refresh the page, click the Refresh button.

The following table describes the nonconfigurable information displayed in the Versions
section of the System Information page.

Field Description

Model Name The model name of the switch.

Boot Version The version of the bootloader software of the switch.

Software Version The version number of the code currently running on the switch.

Configure the switch IP address settings

You can configure network information for the local browser Ul, which is the logical interface
used for in-band connectivity with the switch through any of the switch’s front-panel ports.
The configuration parameters associated with the switch’s network interface do not affect the
configuration of the front panel ports through which traffic is switched or routed.

To configure the IP address and management VLAN information for the local browser
ul:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > Management > IP Configuration.
The IP Configuration page displays.

7. Select the appropriate radio button to specify how to configure the network information for
the switch local browser UI:
« Dynamic IP Address (DHCP). Specifies that the switch must obtain the IP address
through a DHCP server.

« Dynamic IP Address (BOOTP). Specifies that the switch must obtain the IP address
through a BootP server.

e Static IP Address. Specifies that the IP address, subnet mask, and default gateway
must be manually configured. Enter this information in the fields below this radio
button.

8. If you selected the Static IP Address radio button, configure the following network
information:
* IP Address. The IP address of the network interface. The default is 192.168.0.239.
Each part of the IP address must start with a number other than zero. For example, IP
addresses 001.100.192.6 and 192.001.10.3 are not valid.

« Subnet Mask. The IP subnet mask for the interface. The default is 255.255.255.0.

« Default Gateway. The default gateway for the IP interface. The default is
192.168.0.254.

9. Specify the VLAN ID for the management VLAN.

The management VLAN is used to establish an IP connection to the switch from a
workstation that is connected to a port in the same VLAN. If not specified, the active
management VLAN ID is 1 (default), which allows an IP connection to be established
through any port.

When the management VLAN is set to a different value, an IP connection can be made
only through a port that is part of the management VLAN. Also, the port VLAN ID (PVID)
of the port to be connected in that management VLAN must be the same as the
management VLAN ID.
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Note: Make sure that the VLAN that must be the management VLAN exists.
Also make sure that the PVID of at least one port in the VLAN is the
same as the management VLAN ID. For information about creating
VLANs and configuring the PVID for a port, see Configure VLANs on

page 140.

The following requirements apply to the management VLAN:

e Only one management VLAN can be active at a time.

* When a new management VLAN is configured, connectivity through the existing
management VLAN is lost.

* The management station must be reconnected to the port in the new management
VLAN.

10. Click the Apply button.

Your settings are saved.

Configure the IPv6 network interface

To access the switch over an IPv6 network, you must initially configure the switch with IPv6
information (IPv6 prefix, prefix length, and default gateway). IPv6 can be configured using
any of the following options:

You can configure the IPv6 network interface, which is the logical interface used for in-band
connectivity with the switch through all of the switch’s front-panel ports. The configuration
parameters associated with the switch’s network interface do not affect the configuration of
the front panel ports through which traffic is switched or routed.

To access the switch over an IPv6 network, you must initially configure the switch with IPv6
information (IPv6 prefix, prefix length, and default gateway). You can configure IPv6 using
any of the following options:

* IPv6 auto-configuration
+ DHCPv6

When in-band connectivity is established, IPv6 information can be changed using
SNMP-based management or web-based management.

To configure the IPv6 network interface information:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > Management > IPv6 Network Configuration.
The IPv6 Network Global Configuration page displays.

7. Next to Admin Mode, ensure that the Enable radio button is selected.
8. Determine how the switch acquires an IPv6 address:

» IPv6 Address Auto Configuration Mode. Select the Enable radio button to enable
the network interface to acquire an IPv6 address through IPv6 Neighbor Discovery
Protocol (NDP) and through the use of router advertisement messages. If you select
the Disable radio button (which is the default selection), the network interface does
not use the native IPv6 address auto-configuration features to acquire an IPv6
address. Auto-configuration functions only if DHCPvV6 is not enabled on the
management interface.

 DHCPv6. Next to Current Network Configuration Protocol, select the DHCPV6 radio
button to enable the DHCPvV6 client on the management interface. The switch
attempts to acquire network information from a DHCPv6 server. If you select the
None radio button (which is the default selection), the DHCPv6 client on the network
interface is disabled. If DHCPvV6 is enabled, the DHCPv6 Client DUID field displays
the client identifier used by the DHCPV®6 client (if enabled) when sending messages to
the DHCPV6 server.

9. Inthe IPv6 Gateway field, specify the default gateway for the IPv6 network interface.
The gateway address is in IPv6 global or link-local address format.

10. To configure one or more static IPv6 addresses for the local browser Ul, do the following:

a. Inthe IPv6 Address/Prefix Length field, specify the static IPv6 prefix and prefix to
the IPv6 network interface.
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The address is in the global address format.

b. In the EUI64 menu, select True to enable the Extended Universal Identifier (EUI)
flag for IPv6 address, or select False to omit the EUI flag.

c. Click the Add button.
11. Click the Apply button.

Your settings are saved.

View the IPv6 network neighbors

You can view information about the IPv6 neighbors that the switch discovered through the
network interface by using the Neighbor Discovery Protocol (NDP).

To view the IPv6 Network Neighbor Table:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > IPv6 Network Neighbor.
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IPv6 Network Interface Neighbor Table

; : Neighbor Last
IPv6 Address MAC Address isRtr State Updated

The following table describes the information the IPv6 Network Neighbor page displays about
each IPv6 neighbor that the switch discovered.

Table 6. IPv6 network interface neighbor table information

Field Description

IPv6 address The IPv6 address of a neighbor switch visible to the network interface.
MAC address The MAC address of a neighbor switch.

IsRtr e true (1). The neighbor machine is a router.

« false (2). The neighbor machine is not a router.

Neighbor State The state of the neighboring switch:
* reachable (1). The neighbor is reachable by this switch.
« stale (2). Information about the neighbor is scheduled for deletion.

« delay (3). No information was received from the neighbor during
the delay period.

* probe (4). The switch is attempting to probe for this neighbor.
e unknown (5). Unknown status.

Last Updated The last sysUpTime that this neighbor was updated.

Contigure the time settings

The switch supports the Simple Network Time Protocol (SNTP). As its name suggests, itis a
less complicated version of Network Time Protocol, which is a system for synchronizing the

clocks of networked computer systems, primarily when data transfer is handled through the

Internet. You can also set the system time manually.

Configure the time settings manually

You can view and adjust the date and time settings.

To manually configure the time setting:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.
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Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select System > Management > Time > Time Configuration.

Time Configuration

Clock Source @ Local @ SNTP
Date 01/03/1970 (MM/DD/YYYY)
Time 03:12:55 (HH:MM:SS)

3. 1£.99 |

Select the Clock Source Local radio button.
In the Date field, specify the current date in months, days, and years (MM/DD/YYYY).
In the Time field, specify the current time in hours, minutes, and seconds (HH:MM:SS).

Note: If you select the Clock Source Local radio button and enter information
in the Date and Time fields, over a period of time, the date and time
might become inaccurate. However, if you use SNTP, the date and
time remain accurate (see Configure the time settings with SNTP on
page 63 and Configure the global SNTP settings on page 65).

Note: If you do not enter a date and time, the switch calculates the date and
time using the CPU'’s clock cycle.

Click the Apply button.

Your settings are saved.
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Configure the time settings with SNTP

To configure the time by using SNTP:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Time > Time Configuration.
The Time Configuration page displays.

7. Next to Clock Source, select the SNTP radio button.

The page refreshes and displays the SNTP Global Configuration section and the SNTP
Global Status section.

The default is SNTP. The local clock can be set to SNTP only if the following two
conditions are met:
e The SNTP server is configured.
* The SNTP last attempt status is successful.
8. Next to Client Mode, select the mode of operation of the SNTP client:

» Disable. SNTP is not operational. No SNTP requests are sent from the client nor are
any incoming SNTP messages processed.

* Unicast. SNTP operates in a point-to-point fashion. A unicast client sends a request
to a designated server at its unicast address and expects a reply from which it can
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determine the time and, optionally, the round-trip delay and local clock offset relative
to the server.

« Broadcast. SNTP operates in the same manner as multicast mode but uses a local
broadcast address instead of a multicast address. The broadcast address provides a
single-subnet scope while a multicast address provides an Internet-wide scope.

The default is Disable.

9. If the SNTP client mode is Unicast, you can add the IP address or DNS name of one or
more SNTP servers for the switch to poll.

For more information, see Configure an SNTP server on page 69.

10. In the Port field, specify the local UDP port that the SNTP client receives server packets on.

The allowed range is 1025 to 65535 and 123. The default is 123. When the default is
configured, the actual client port value used in SNTP packets is assigned by the OS.

11. In the Unicast Poll Interval field, specify the number of seconds between unicast poll
requests expressed as a power of 2. to The allowed range is 6 to 10. The default is 6.

12. In the Broadcast Poll Interval field, specify the number of seconds between broadcast poll
requests expressed as a power of 2.

Broadcasts received prior to the expiry of this interval are discarded. The allowed range is
6 to 10. The default is 6.

13. In the Unicast Poll Timeout field, specify the number of seconds to wait for an SNTP
response to a unicast poll request.

The allowed range is 1 to 30. The default is 5.

14. In the Unicast Poll Retry field, specify the number of times to retry a unicast poll request to
an SNTP server after the first time-out before the switch attempts to use the next configured
server.

The allowed range is 0 to 10. The default is 1.
15. In the Time Zone Name field, specify a time zone.

You can also specify the number of hours and number of minutes that the time zone is
different from the Coordinated Universal Time (UTC). The time zone can affect the
display of the current system time. The default is UTC.

Note: When using SNTP/NTP time servers to update the switch’s clock, the
time data received from the server is based on the UTC, which is the
same as Greenwich Mean Time (GMT). This might not be the time
zone in which the switch is located.

16. In the Offset Hours field, specify the number of hours that the time zone is different from
UTC.
The allowed range is —12 to 13. The default is 0.

17. In the Offset Minutes field, specify the number of minutes that the time zone is different
from UTC.
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The allowed range is 0 to 59. The default is O.
18. Click the Apply button.

Your settings are saved.

Configure the global SNTP settings

To configure the global SNTP settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Time > Time Configuration > SNTP Global
Configuration.

When you select the SNTP option as the clock source, the SNTP Global Configuration
section is displayed below the Time Configuration section of the page.
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« System Information

Clock Source Local ® SNTP
Date
Time HH:MM:SS
= |Pv6 Network Neighbor
= Time -~
SNTP Global Configuration
*SNTP Server Client Mode Disable ® Unicast Bro
Configuration
Port 123 123
Unicast Poll Interval 6
L Broadcast Poll Interval 6

Unicast Poll Timeout 5
= Green Ethemet ¥ Unicast Poll Retry

Time Zone Name

Offset Hours 0

Offset Minutes 0

7. Select a Client mode radio button to specify the mode of operation of the SNTP client:
» Disable. SNTP is not operational. No SNTP requests are sent from the client and no
received SNTP messages are processed.

* Unicast. SNTP operates in a point-to-point fashion. A unicast client sends a request
to a designated server at its unicast address and expects a reply from which it can
determine the time and, optionally, the round-trip delay and local clock offset relative
to the server.

» Broadcast. SNTP operates in the same manner as multicast mode but uses a local
broadcast address instead of a multicast address. The broadcast address provides a
single-subnet scope while a multicast address provides an Internet-wide scope.

The default is Unicast.
8. In the Port field, specify the local UDP port that the SNTP client receives server packets on.

The allowed range is 1025 to 65535 and the value 123. The default is 123. When the
default is configured, the actual client port value used in SNTP packets is assigned by the
operating system.

9. In the Unicast Poll Interval field, specify the number of seconds between unicast poll
reguests expressed as a power of 2.

The allowed range is 6 to 10. The default is 6.

10. In the Broadcast Poll Interval field, specify the number of seconds between broadcast poll
requests expressed as a power of 2.

Broadcasts received prior to the expiry of this interval are discarded. The allowed range is
6 to 10. The default is 6.

11. In the Unicast Poll Timeout field, specify the number of seconds to wait for an SNTP
response to a unicast poll request.
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The allowed range is 1 to 30. The default is 5.

12. In the Unicast Poll Retry field, specify the number of times to retry a unicast poll request to
an SNTP server after the first time-out before the switch attempts to use the next configured
server.

The allowed range is 0 to 10. The default is 1.
13. In the Time Zone Name field, specify a time zone.

You can also specify the number of hours and number of minutes that the time zone is
different from the Coordinated Universal Time (UTC). The time zone can affect the
display of the current system time. The default is UTC.

Note: When using SNTP/NTP time servers to update the switch’s clock, the
time data received from the server is based on the UTC, which is the
same as Greenwich Mean Time (GMT). This might not be the time
zone in which the switch is located.

14. In the Offset Hours field, specify the number of hours that the time zone is different from
UTC.
The allowed range is —12 to 13. The default is 0.

15. In the Offset Minutes field, specify the number of minutes that the time zone is different
from UTC.

The allowed range is 0 to 59. The default is 0.
16. Click the Apply button.
Your settings are saved.

17. To refresh the page, click the Refresh button.

View the SNTP global status

When you select the SNTP option as the clock source, the SNTP global status is displayed
below the SNTP Global Configuration section of the page. The SNTP Global Status table
displays information about the system’s SNTP client.

To view SNTP global status:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > Management > Time > Time Configuration > SNTP Global Status.

When you select the SNTP option as the clock source, the SNTP Global Status is
displayed below the SNTP Global Configuration section.

SNTP Global Status

7. Click the Refresh button to update the page with the latest information about the switch.
The following table displays the nonconfigurable information on the page.

Table 7. SNTP Global Status information

Field Description

Version The SNTP version that the client supports.

Supported mode The SNTP modes that the client supports. Multiple modes can be supported by
a client.
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Table 7. SNTP Global Status information (continued)

Field

Last Update Time

Description

The local date and time (UTC) that the SNTP client last updated the system
clock.

Last Attempt Time

The local date and time (UTC) of the last SNTP request or receipt of an
unsolicited message.

Last Attempt Status

The status of the last SNTP request or unsolicited message for both unicast
and broadcast modes. If no message was received from a server, a status of
Other is displayed. These values are appropriate for all operational modes.

e Other. The status of the last request is unknown.

e Success. The SNTP operation was successful and the system time was
updated.

* Request Timed Out. After an SNTP request was sent to an SNTP server,
the response timer expired before a response from the server was
received.

« Bad Date Encoded. The time provided by the SNTP server is not valid.

« Version Not Supported. The SNTP version supported by the server is
not compatible with the version supported by the client.

e Server Unsynchronized. The SNTP server is not synchronized with its
peers. This is indicated by the leap indicator field in the SNTP message.

» Server Kiss Of Death. The SNTP server indicated that no further queries
were to be sent to this server. This is indicated by a stratum field equal to
0 in a message received from a server.

Server IP Address

The IP address of the server for the last received valid packet. If no message
was received from any server, an empty string is shown.

Address Type

The address type of the SNTP server address for the last received valid
packet.

Server Stratum

The claimed stratum of the server for the last received valid packet.

Reference Clock ID

The reference clock identifier of the server for the last received valid packet.

Server mode

The mode of the server for the last received valid packet.

Unicast Server Max Entries

The maximum number of unicast server entries that can be configured on this
client.

Unicast Server Current Entries

The number of current valid unicast server entries configured for this client.

Broadcast Count

The number of unsolicited broadcast SNTP messages that were received and
processed by the SNTP client since the last reboot.

Configure an SNTP server

SNTP assures accurate network device clock time synchronization up to the millisecond.
Time synchronization is performed by a network SNTP server. The switch operates only as
an SNTP client and cannot provide time services to other systems.
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Time sources are established by strata. Strata define the accuracy of the reference clock.
The higher the stratum (where zero is the highest), the more accurate the clock. The device
receives time from Stratum 1 and above since it is itself a Stratum 2 device.

The following is an example of strata:

e Stratum 0. A real-time clock is used as the time source, for example, a GPS system.

e Stratum 1. A server that is directly linked to a Stratum 0 time source is used. Stratum 1
time servers provide primary network time standards.

e Stratum 2. The time source is distanced from the Stratum 1 server over a network path.
For example, a Stratum 2 server receives the time over a network link, through NTP, from
a Stratum 1 server.

Information received from SNTP servers is evaluated based on the time level and server
type.
SNTP time definitions are assessed and determined by the following time levels:

e T1. Time that the original request was sent by the client.

e T2. Time that the original request was received by the server.
e T3. Time that the server sent a reply.

e T4. Time that the client received the server's reply.

The device can poll unicast server types for the server time.

Polling for unicast information is used for polling a server for which the IP address is known.
SNTP servers that were configured on the device are the only ones that are polled for
synchronization information. T1 through T4 are used to determine server time. This is the
preferred method for synchronizing device time because it is the most secure method. If this
method is selected, SNTP information is accepted only from SNTP servers defined on the
device using the SNTP Server Configuration page.

The device retrieves synchronization information, either by actively requesting information or
at every poll interval.

You can view and modify information for adding and modifying Simple Network Time Protocol
SNTP servers.

Add an SNTP server
To add an SNTP server:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select System > Management > Time > SNTP Server Configuration.

SNTP Server Configuration

| Server

Address Port Priority Version
Type

SNTP Server Status

Last Last Last i
Address Update Attempt Attempt Requests
. Requests
Time Time Status

From the Server Type menu, select the type of SNTP address to enter in the address field.

The address can be either an IP address (IPv4 or IPv6) or a host name (DNS). The
default is IPv4.

In the Address field, specify the IP address or the host name of the SNTP server.

This is a text string of up to 64 characters, containing the encoded unicast IP address or
host name of an SNTP server. Unicast SNTP requests are sent to this address. If this
address is a DNS host name, then that host name is resolved into an IP address each
time an SNTP request is sent to it.

If the UDP port on the SNTP server to which SNTP requests are sent is not the standard
port (123), specify the port number in the Port field.

The valid range is 1 to 65535. The default is 123.

10. In Priority field, specify the priority order which to query the servers.
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The SNTP client on the device continues sending SNTP requests to different servers until
a successful response is received, or all servers are exhausted. The priority indicates the
order in which to query the servers. The request is sent to an SNTP server with a priority
value of 1 first, then to a server with a priority value of 2, and so on. If any servers are
assigned the same priority, the SNTP client contacts the servers in the order that they
appear in the table. The valid range is 1 to 3. The default is 1.

In the Version field, specify the NTP version running on the server.
The range is 1 to 4. The default is 4.

Click the Add button.

The SNTP server entry is added.

Repeat the previous steps to add additional SNTP servers.

You can configure up to three SNTP servers.

The SNTP Server Status table displays status information about the SNTP servers
configured on your switch. The following table describes the fields in the SNTP Server Status
table.

Table 8. SNTP Server Status information

Field Description

Address All the existing server addresses. If no server configuration exists, a message stating

that no SNTP server exists displays on the page.

Last Update Time The local date and time (UTC) that the response from this server was used to update

the system clock.

Last Attempt Time The local date and time (UTC) that this SNTP server was last queried.

Last Attempt Status The status of the last SNTP request or unsolicited message for both unicast and

broadcast modes. If no message was received from a server, a status of Other is
displayed. These values are appropriate for all operational modes:

e Other. The status of the last request is unknown, or no SNTP responses were
received.

e Success. The SNTP operation was successful and the system time was updated.

* Request Timed Out. After an SNTP request was sent to an SNTP server, the
response timer expired before a response from the server was received.

 Bad Date Encoded. The time provided by the SNTP server is not valid.

* Version Not Supported. The SNTP version supported by the server is not
compatible with the version supported by the client.

» Server Unsynchronized. The SNTP server is not synchronized with its peers. This
is indicated by the leap indicator field on the SNTP message.

» Server Kiss Of Death. The SNTP server indicated that no further queries were to
be sent to this server. This is indicated by a stratum field equal to 0 in a message
received from a server.

Requests The number of SNTP requests made to this server since last agent reboot.

Failed Requests The number of failed SNTP requests made to this server since the last reboot.
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Change the settings for an existing SNTP server
To change the settings for an existing SNTP server:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > Management > Time > SNTP Server Configuration.
The SNTP Server Configuration page displays.

7. Select the check box next to the configured server.
. Specify new values in the available fields.
9. Click the Apply button.

Your settings are saved.

Remove an SNTP server
To remove an SNTP server:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Time > SNTP Server Configuration.
The SNTP Server Configuration page displays.

7. Select the check box next to the configured server to remove.

8. Click the Delete button.

The entry is removed, and the device is updated.

Configure daylight saving time settings

You can configure settings for summer time, which is also known as daylight saving time.
Used in some countries around the world, summer time is the practice of temporarily
advancing clocks during the summer months. Typically clocks are adjusted forward one or
more hours near the start of spring and are adjusted backward in autumn.

To configure the daylight saving time settings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Time > Daylight Saving Configuration.

m DayLight Saving (DST) Configuration
ystany iioemation DayLight Saving (DST

7. Select a Daylight Saving (DST) radio button:
« Disable. Disable daylight saving time.

» Recurring. Daylight saving time occurs at the same time every year. The start and
end times and dates for the time shift must be manually configured.

* Recurring EU. The system clock uses the standard recurring summer time settings
used in countries in the European Union. When this option is selected, the rest of the
applicable fields on the page are automatically populated and cannot be edited.

* Recurring USA. The system clock uses the standard recurring daylight saving time
settings used in the United States. When this option is selected, the rest of the
applicable fields on the page are automatically populated and cannot be edited.

« Non Recurring. Daylight saving time settings are in effect only between the start date
and end date of the specified year. When this option is selected, the summer time
settings do not repeat on an annual basis.
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8. Click the Apply button.

Your settings are saved.

The fields that are described in the following table are visible on the page only if the DayLight
Saving (DST) Recurring, Recurring EU, or Recurring USA radio button is selected.

Table 9. Daylight saving setting is Recurring, Recurring EU, or Recurring USA

Field

Begins At

Description

These fields are used to configure the start values of the date and time.

Week. Configure the start week.
Day. Configure the start day.

Month. Configure the start month.
Hours. Configure the start hours.
Minutes. Configure the start minutes.

Ends At

These fields are used to configure the end values of date and time.

Week. Configure the end week.
Day. Configure the end day.

Month. Configure the end month.
Hours. Configure the end hours.
Minutes. Configure the end minutes.

Offset

Configure recurring offset in minutes. The valid range is 1-1440

minutes.

Zone

Configure the time zone.

The fields that are described in the following table are visible on the page only if the DayLight
Saving (DST) Non Recurring radio button is selected.

Table 10. Daylight saving setting is Non Recurring

Field

Begins At

Description

These fields are used to configure the start values of the date and time.

Week. Configure the start week.
Day. Configure the start day.

Month. Configure the start month.
Hours. Configure the start hours.
Minutes. Configure the start minutes.

Ends At

These fields are used to configure the end values of date and time.

Week. Configure the end week.
Day. Configure the end day.

Month. Configure the end month.
Hours. Configure the end hours.
Minutes. Configure the end minutes.
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Table 10. Daylight saving setting is Non Recurring (continued)

Field Description

Offset Specify the number of minutes to shift the summer time from the standard

time. The valid range is 1-1440 minutes.

Zone Specify the acronym associated with the time zone when summer time

is in effect. This field is not validated against an official list of time zone
acronyms.

View the daylight saving time status

The Daylight Saving (DST) Status section shows information about the summer time settings
and whether the time shift for summer time is currently in effect.

To view the daylight saving time status:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select System > Management > Time > DayLight Saving Configuration.
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DayLight Saving (DST) Configuration
« System | ation DayLight Saving (DST

® Disable (0 Recurming Recuming EU Recurring USA Non Recurring

7. To refresh the page, click the Refresh button.

The following table displays the nonconfigurable information on the page.

Table 11. Daylight Saving (DST) Status information

Field

Daylight Saving (DST)

Description

The Daylight Saving value, which is one of the following:
* Disable

* Recurring

¢ Recurring EU

¢ Recurring USA

¢« Non Recurring

Begins At Displays when the daylight saving time begins. This field is not
displayed when daylight saving time is disabled.
Ends At Displays when the daylight saving time ends. This field is not displayed

when daylight saving time is disabled.

Offset (in Minutes)

The offset value in minutes.This field is not displayed when daylight
saving time is disabled.

Zone

The zone acronym. This field is not displayed when daylight saving
time is disabled.

Daylight Saving (DST) in Effect

Displays whether daylight saving time is in effect.
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Configure Denial of Service settings

You can configure Denial of Service (DoS), allowing the switch to classify and block specific
types of DoS attacks.

Configure Auto-DoS

The Auto-DoS Configuration page lets you automatically enable all the DoS features
available on the switch, except for the L4 Port attack. For information about the types of DoS
attacks the switch can monitor and block, see Configure Denial of Service on page 80.

To enable the Auto-DoS feature:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Denial of Service > Auto-DoS Configuration.
The Auto-DoS Configuration page displays.

7. Next to Auto-DoS Mode, select the Enable radio button.
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When an attack is detected, a warning message is logged to the buffered log and is sent
to the syslog server. At the same time, the port is shut down and can be enabled only
manually by the admin user.

8. Click the Apply button.

Your settings are saved.

Configure Denial of Service
You can select which types of DoS attacks the switch monitors and blocks.

To configure individual DoS settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Denial of Service > Denial of Service Configuration.
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Denial of Service Configuration

Denial of Service ICMPv4 ® Disable Enable

Denial of Service Max ICMPv4 Packet Size

Denial of Service ICMPvE& * Disable Enable

Denial of Service Max ICMPv6 Packet Size {0 to 1023

Select the types of DoS attacks for the switch to monitor and block and configure any
associated values:

Denial of Service ICMPv4. Enabling ICMPv4 DoS prevention causes the switch to
drop ICMPvV4 packets with a type set to ECHO_REQ (ping) and a size greater than
the configured ICMPV4 packet size.

Denial of Service Max ICMPv4 Packet Size. Specify the maximum ICMPv4 packet
size allowed. If ICMPv4 DoS prevention is enabled, the switch drops IPv4 ICMP ping
packets with a size greater than the configured value.

Denial of Service ICMPv6. Enabling ICMPv6 DoS prevention causes the switch to
drop ICMPV6 packets with a type set to ECHO_REQ (ping) and a size greater than
the configured ICMPV6 packet size.

Denial of Service Max ICMPv6 Packet Size. Specify the maximum IPv6 ICMP
packet size allowed. If ICMPv6 DoS prevention is enabled, the switch drops IPv6
ICMP ping packets with a size greater than the configured maximum ICMPVv6 packet
size.

Click the Apply button.

Your settings are saved.

Configure the DNS settings

You can configure information about DNS servers that the network uses and how the switch
operates as a DNS client.

Configure the global DNS settings

You can configure global DNS settings and DNS server information.

To configure the global DNS settings:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > DNS > DNS Configuration.

« System Information DT oo -~ x
S DNS St Disable ® Enable

DNS Default Name 1 to 255 alphanumeric characters)

+ DNS Server Configuration

ID DNS Server Preference

7. Select the Disable or Enable radio button to specify whether to disable or enable the
administrative status of the DNS client.

* Enable. Allow the switch to send DNS queries to a DNS server to resolve a DNS
domain name. The DNS is enabled by default.

« Disable. Prevent the switch from sending DNS queries.

8. In the DNS Default Name field, enter the default DNS domain name to include in DNS
queries.

When the system is performing a lookup on an unqualified host name, this field is
provides the domain name (for example, if default domain name is netgear.com and the
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user enters test, then test is changed to test.netgear.com to resolve the name). The name
must not be longer than 255 characters.

9. In the DNS Server field, specify the IPv4 address to which the switch sends DNS queries.
10. Click the Add button.

The server is added to the list. You can specify up to eight DNS servers. The Preference
field displays the server preference order. The preference is set in the order in which
preferences were entered.

11. To remove a DNS server from the list, select its check box and click the Delete button.

If you click the Delete button without selecting a DNS server, all the DNS servers are
deleted.

12. Click the Apply button.
Your settings are saved.
13. To refresh the page, click the Refresh button.

The following table describes the fields that are shown in the DNS Server Configuration
table.

Table 12. DNS Server Configuration information

Field Description
ID The identification of the DNS Server.
Preference Shows the preference of the DNS server. The preferences are

determined by the order in which they were entered.

Contfigure and view host name-to-IP address information

You can manually map host names to IP addresses and view dynamic host mappings.

Add a static entry to the dynamic host mapping table

To add a static entry to the local dynamic host mapping table:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > DNS > Host Configuration.

DNS Host Configuration

Host Name {1 to 255 characters) [Pv4/IPvb Address

Dynamic Host Mapping

Host Total Elapsed Type [Pv4/IPv6 Address

7. Inthe Host Name (1 to 255 characters) field, specify the static host name to add.
Its length cannot exceed 255 characters and it is a required field.

8. In the IPv4/IPv6 Address field, enter the IP address to associate with the host name.
9. Click the Add button.

The entry displays in the list on the page.

Remove an entry from the dynamic host mapping table

To remove an entry from the dynamic host mapping table:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select System > Management > DNS > Host Configuration.
The DNS Host Configuration page displays.

Select the check box next to the entry to remove.
Click the Delete button.

Change the host name or IP address in an entry of the dynamic host mapping
table and view all entries

To change the host name or IP address in an entry of the dynamic host mapping table
and view all entries:

1.

4.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.
5. Click the Login button.

The System Information page displays.
6. Select System > Management > DNS > Host Configuration.
The DNS Host Configuration page display.

7. Select the check box next to the entry to update.
8. Enter the new information in the appropriate field.
9. Click the Apply button.

Your settings are saved.
10. To clear all the dynamic host name entries from the list, click the Clear button.

The Dynamic Host Mapping table shows host name-to-IP address entries that the switch
learned. The following table describes the dynamic host fields.

Table 13. Dynamic Host Mapping information

Field Description

Host Lists the host name that you assign to the specified IP address.
Total Time since the dynamic entry was first added to the table.
Elapsed Time since the dynamic entry was last updated.

Type The type of the dynamic entry.

Addresses Lists the IP address associated with the host name.

Configure Green Ethernet settings

Using the Green Ethernet feature allows for power consumption savings.

Configure the Green Ethernet global settings
You can configure Green Ethernet features.

To configure the Green Ethernet settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Green Ethernet > Green Ethernet Configuration.

Green Ethemnet Configuration

EEE Mode # Disable ¢ Enable

7. Select the EEE Mode Disable or Enable radio button.

Energy Efficient Ethernet (EEE) combines the MAC with a family of physical layers that
support operation in a low-power mode. It is defined by IEEE 802.3az Energy Efficient
Task Force. Lower power mode enables both the send and receive sides of the link to
disable some functionality for power savings when lightly loaded. Transition to low-power
mode does not change the link status. Frames in transit are not dropped or corrupted in
transition to and from low-power mode. Transition time is transparent to upper layer
protocols and applications.

8. Click the Apply button.
Your settings are saved.
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Configure the Green Ethernet interface settings
You can configure per-port Green Ethernet settings.

To configure the Green Ethernet interface settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Management > Green Ethernet > Green Ethernet Interface
Configuration.

Green Ethemet Interface Configuration

Port EEE Mode
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7. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number (for example, g1) in the Go To Interface field and click the Go
button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

8. From the EEE mode menu, select Enable or Disable.
The default is Disable.
9. Click the Apply button.

Your settings are saved.

Use the Device View

For device view information, see Use the Device View of the local browser Ul on page 40.

Contfigure Power over Ethernet

You can configure the global Power over Ethernet (PoE) configuration settings and the PoE
settings for each port.

PokE concepts

The following table shows the PoE+ capacity for each model.

Table 14. PoE capacities

Model Maximum Power Budget Maximum PoE Power
Across All Active PoE+ Ports Per Individual Port

GS724TPv2 190w

30W PoE+ (IEEE 802.3at)
GS724TPP 380W

By default, supplied power is prioritized in ascending port order, up to the total power budget
of the device. If the power requirements for the attached devices exceed the total power
budget of the switch, the power to the device on the highest-numbered PoE+ port is disabled
to make sure that the devices connected to the higher-priority, lower-numbered PoE+ ports
are supported first.
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It is important to note that although a device is listed as an 802.3at (PoE+) powered or
802.3af (PoE) powered device, it might not require the maximum power limit that is specified.
Many devices require less power, allowing all POE+ ports to be active simultaneously, when
the devices correctly report their PoE class to the switch.

Device class power requirements

PoE and PoE+ use Ethernet cables to supply power to PoE-capable devices on the network,
such as WiFi access points, IP cameras, VolP phones, and switches. The switch is compliant
with the IEEE 802.3at standard (PoE+) and backward compatible with the IEEE 802.3af
standard (PoE). The switch can pass power through to any powered device (PD) that
supports these standards. PoE and PoE+ let you power such devices without the need for a
separate power supply.

The switch supports a Plug-and-Play process by which it detects the type of device that is
connected to one of its POE+ ports and whether that device needs power and how much so
that the switch can provide the correct power to the device.

During the Plug-and-Play process, the connected device can provide its Class response to
the switch in many ways, depending on how the vendor programmed the device.

The following table shows the device classes for PoOE+ devices adhering to the IEEE 802.3at
standard. The device classes for PoE devices adhering to the IEEE 802.3af standard are
identical with the exception that Device Class 4 is not supported.

Table 15. PoE and PoE+ device class power allocation

Device Standard Range of Power Deliv- Minimum Output at Maximum Output at

Class ered to the Powered PoE Switch Port (Mini- PoE Switch Port (Maxi-
Device mum Allocated) mum Allocated)

0 PoE and PoE+ 0.44W-12.95W 15.4W 16.2W

1 PoE and POE+ 0.44W-3.84W 4.0W 4.2W

2 PoE and PoOE+ 3.84W-6.49W 7.0W 7.4W

3 PoE and PoE+ 6.49W-12.95W 15.4W 16.2W

4 PoE+ only 12.95W-25.5W 30.0W 31.6W

Power allocation and power budget concepts

The switch is a smart switch in that it can allocate the required power to a connected device
by using a prioritization scheme: By default, power is supplied in ascending port order (that is,
lower port numbers are served first) until the power budget is consumed and insufficient
power remains to allocate to the next device. When less than 7W of PoE power is available
on a port, the port PoE LED lights yellow, and the attached device does not receive power
from the port. However, the switch continues to send data through the port connection.
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The switch is also a smart switch in that it can override the IEEE power classification of a
powered device (PD): If the PD consumes less power than required by its power
classification, the switch provides only the power that the PD consumes instead of the power
that is required by the PD’s power classification.

If some PoE+ ports are in use and deliver power, you can calculate the available power
budget for the other POE+ ports by subtracting the consumed (that is, delivered power) from
the total available power budget. (For information about the total available power budget, see
PoE concepts on page 89.)

An example for model GS724TPv2:
Port 1 delivers 4.4W to a PD. The available power budget is 185.6W (190W-4.4W).

An example for model GS724TPP:

A Class 4 PD is attached to Port 1, a Class 2 PD to Port 2, and another Class 4 PD to Port 3.
However, the PDs consume less power than defined by their classes: The PD attached to
Port 1 consumes 7.3W, the PD attached to Port 2 consumes 4.7W, and the PD attached to
Port 3 consumes 8.9W. So even though the switch provides power to two Class 4 devices
and one Class 3 device, if the default power adapter is installed, the available power budget
is 359.1W (380W-7.3-4.7-8.9W).

To determine the delivered power by a PoE+ port:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

Configure System Information 91 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

6. Select System > PoE > Advanced > PoE Port Configuration.

Port Admin Mode  High Power Max Power Priorty Level High Power Mode Detection Mode  Class | Timer Schedule Output Voltage (Volt) | Output Cumrent (mA) | Output Power (Watt) Power Limit Typa  Power Limat {miVat

The delivered power is stated in the Output Power (Watt) column.

Contigure PoE trap settings and view PoE information

You can configure the PoE trap settings and view PoE information such as nominal power,
threshold power, and consumed power.

To configure the POE trap settings and view PoE information:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > PoE > Basic > PoE Configuration.
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PoE Configuration

Firmware Version Power Status Nominal Power Threshold Power Consumed Power Traps

7. From the Traps menu, select Enable or Disable.

The default is Enable. Selecting Disable deactivates the PoE traps.
8. Click the Apply button.

Your settings are saved.
The following table describes the nonconfigurable fields on the page.

Table 16. PoE Configuration fields

Field Description

Firmware Version The firmware version of the PoE firmware component.

Power Status The power status.

Nominal Power The maximum amount of power in watts that the switch can deliver to all ports.
Threshold Power Watts If the consumed power is below the threshold power, the switch can power up

another port. The consumed power can be between the nominal and threshold
power. The threshold power is displayed in watts.

Consumed Power Watts The total amount of power in watts that is being delivered to all ports.

Configure the PoE port settings
You can configure PoE settings for individual PoE ports.

To configure the POE port settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > PoE > Advanced > PoE Port Configuration.

Port Admin Mode  High Power Max Power Priority Level High Power Mode Detection Mode Class  Timer Schedule Output Voltage (Volt) Ouiput Curent (mA) | Output Power (Watt) | Power Limit Type  Power Limat (m'Wat

7. Select one or more ports by taking one of the following actions:

« To configure a single port, select the check box associated with the port, or type the
port number (for example, gl) in the Go To Interface field and click the Go button.

« To configure multiple ports with the same settings, select the check box associated
with each interface.

« To configure all ports with the same settings, select the check box in the heading row.
8. From the Admin Mode menu, select the administrative POE mode of the port:

« Enable. The port’s capacity to deliver power is enabled. This is the default setting.

» Disable. The port’s capacity to deliver power is disabled.

9. From the Port Priority menu, select the priority for the port in relation to other ports if the
total power that the switch is capable of delivering exceeds the total power budget:

e Low. Low priority. This is the default setting.

e Medium. Medium priority.

* High. High priority.

» Critical. Critical priority.

The port priority determines which ports can still deliver power after the total power
delivered by the switch exceeds the total power budget. (In such a situation, the switch

might not be able to deliver power to all connected devices.) If the same priority applies to
two ports, the lower-numbered port receives higher priority.

Configure System Information 94 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

10. From the High Power Mode menu, select the POE mode that the port must function in:

e 802.3af. The port is powered in and limited to the IEEE 802.3af mode. A PD that
requires IEEE 802.3at does not receive power if the port functions in IEEE 802.3af
mode.

» Legacy. The port is powered using high-inrush current, which is used by legacy PDs
that require more than 15W to power up.

* Pre-802.3at. The port is initially powered in the IEEE 802.3af mode and, before
75 msec pass, is switched to the high-power IEEE 802.3at mode. Select this mode if
the PD does not perform Layer 2 classification or if the switch performs
2-event Layer 1 classification.

e 802.3at. The port is powered in the IEEE 802.3at mode and is backward compatible
with IEEE 802.3af. The 802.3at mode is the default mode. In this mode, if the switch
detects that the attached PD requests more power than IEEE 802.3af but is not an
IEEE 802.3at Class 4 device, the PD does not receive power from the switch.

11. From the Detection Type menu, select how the port detects the attached PD:
e pre-ieee. The port performs legacy detection.
e ieee auto. The port performs a 4-point resistive detection. This is the default setting.

e auto. The port performs a 4-point resistive detection, and if required, continues with
legacy detection.

12. From the Timer Schedule menu, select a timer schedule or select None, which is the
default selection.

For information about setting up and configuring PoE timer schedules, see Set up PoE
timer schedules on page 125.

13. Click the Apply button.

Your settings are saved.

The following table describes the nonconfigurable fields on the page.

Table 17. PoE Port Configuration

Field Description

High Power All ports supports high-power mode.

Max Power The maximum power in milliwatts that can be provided by the port.

Class The class defines the range of power that a powered device (PD) is drawing from

the switch. The class definitions are as follows:
e 0: 0.44-12.95W

1 0.44-3.83W

1 0.44-6.48W

1 0.44-12.95W

1 0.44-25.5W

)
A W N P

Output Voltage The voltage that is delivered to the PD in volts.

Output Current The current that is delivered to the PD in mA.

Configure System Information 95 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

Table 17. PoE Port Configuration (continued)

Field Description
Output Power The power that is delivered to the PD in watts.
Status The operational status of the port. The possible values are as follows:

Disabled. No power is delivered.

DeliveringPower. Power is being drawn by the PD.

Fault. A problem occurred with the power.

Test. The port is in test mode.

otherFault. The port is idle because of an error condition.
Searching. The port is not in one of the other states in this list.

Fault Status The error description when the PoE port is in a fault state. The possible values are
as follows:

No Error. The port is not in any error state and can provide power.

MPS Absent. The port detected the absence of the main power supply,
preventing the port from providing power.

Short. The port detected a short circuit condition, preventing the port from
providing power.

Overload. The PD that is connected to the port attempts to draw more power
than allowed by the port’s settings, preventing the port from providing power at
all.

Power Denied. The port was denied power because of a shortage of power or
because of an administrative condition. In this condition, the port cannot
provide power.

Configure SNMP

You can configure SNMP settings for SNMPv1/v2 and SNMPV3. The switch supports the
configuration of SNMP groups and users that can manage traps that the SNMP agent

generates.

The switch uses both standard public MIBs for standard functionality and private MIBs that
support additional switch functionality. The main object for interface configuration is in the
NetgearSmartSwitch-MIB, which is a private MIB. Some interface configurations also involve
objects in the public MIB, IF-MIB.

Configure the SNMPv1 and SNMPv2 community

Only the communities that you define can access to the switch using the SNMP V1 and
SNMP V2 protocols. Only those communities with read/write level access can be used to
change the configuration using SNMP.
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Add an SNMP community:
To add an SNMP community:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/V2 > Community Configuration.

Community Configuration
Management Station [P Management Station [P Mask Community String Access Mode  Status
0.00.0 0.0.00 public ReadOnly Enable

As an example, the previous figure shows one community configuration.

7. Inthe Management Station IP field, specify the IP address of the management station.

8. In the Management Station IP Mask field, specify the subnet mask to associate with the
management station IP address.

Together, the management station IP and the management station IP mask denote a
range of IP addresses from which SNMP clients can use that community to access this
device. If either the management station IP or management station IP mask value is
0.0.0.0, access is allowed from any IP address. Otherwise, every client’s address is
ANDed with the mask, as is the management station IP address. If the values are equal,
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access is allowed. For example, if the management station IP address and management
station IP mask parameters are 192.168.1.0/255.255.255.0, any client with an IP address
from one 192.168.1.0 through 192.168.1.255 (inclusive) is allowed access. To allow
access from only one station, use a management station IP mask value of
255.255.255.255, and use that machine’s IP address for client address.

9. In the Community String field, specify a community name.

10. From the Access Mode menu, select the access level for this community, which is either
Read/Write or Read Only.

11. From the Status menu, select to enable or disable the community.

If you select Enable, the community name must be unique among all valid community
names or the set requests are rejected. If you select Disable, the community name
becomes invalid.

12. Click the Add button.

The selected community is added.

Modify an existing SNMP community
To modify an existing SNMP community:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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6. Select System > SNMP > SNMP V1/V2 > Community Configuration.
The Community Configuration page displays.

7. Select the check box next to the community.
8. Update the desired fields.
9. Click the Apply button.

Your settings are saved.

Delete an SNMP community

To delete an SNMP community:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.
6. Select System > SNMP > SNMP V1/V2 > Community Configuration.

The Community Configuration page displays.

7. Select the check box next to the community to remove.
8. Click the Delete button.

The community is removed.
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Configure SNMPv1 and SNMPv2 trap settings

You can configure settings for each SNMPv1 or SNMPv2 management host that must
receive notifications about traps generated by the device. The SNMP management host is
also known as the SNMP trap receiver.

Add an SNMP trap receiver

To add an SNMP trap receiver:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/\V2 > Trap Configuration.

S

= SNMP V12 ~

Recipients [P Version Community String Status

» Community SNMP W4
Coenfiguration

= Trap Flags

¥ Disable ~

7. Inthe Recipients IP field, enter the IPv4 address in the x.x.x.x format to receive SNMP
traps from this device.
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8. From the Version menu, select the trap version to be used by the SNMP trap receiver:

* SNMPvL1. The switch uses SNMPvV1 to send traps to the receiver. The default setting
is SNMPv1.

*  SNMPv2. The switch uses SNMPv2 to send traps to the receiver.

9. In the Community String field, specify the name of the SNMP community that includes
the SNMP management host and the SNMP agent on the device.

This name can be up to 16 characters and is case-sensitive.

10. From the Status menu, select Enable to send traps to the receiver or select Disable to
prevent the switch from sending traps to the receiver.

11. Click the Add button.

The receiver configuration is added.

Modify information about an existing SNMP recipient
To modify information about an existing SNMP recipient:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/V2 > Trap Configuration.
The Trap Configuration page displays.
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7. Select the check box next to the recipient.
8. Update the desired fields.
9. Click the Apply button.

Your settings are saved.

Delete an SNMP recipient
To delete an SNMP trap recipient:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/VV2 > Trap Configuration.
The Trap Configuration page displays.

7. Select the check box next to the recipient to remove.
8. Click the Delete button.

The trap recipient is removed.
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Configure SNMPv1 and SNMPv2 trap flags

You can enable or disable traps that the switch can send to an SNMP manager. When the
condition identified by an active trap is encountered by the switch, a trap message is sent to
any enabled SNMP trap receivers, and a message is written to the trap log.

To configure the trap flags:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/V2 > Trap Flags.

“ Tmp Flags‘
Authentication

« SNMP V1/V2 -~ o R
’ d - Disable @ Enable
» Community

Configuration Disable ® Enable
Configuration

" o 3 Disable ® Enable
*lrap C onniguration

« Supported MIBS

»SNMP V3 ~

7. Enable or disable the following system traps:

* Authentication. When enabled, SNMP traps are sent when events involving
authentication occur, such as when a user attempts to access the switch local
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browser Ul and fails to provide a valid user name and password. The default is
Enable.

e Link Up/Down. When enabled, SNMP traps are sent when the administrative or
operational state of a physical or logical link changes. The default is Enable.

e Spanning Tree. When enabled, SNMP traps are sent when various spanning tree
events occur. The default is Enable.

8. Click the Apply button.
Your settings are saved.

View the supported MIBs
You can view a list of all MIBs that are supported by the switch.

To view the supported MIBs:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMP V1/\V2 > Supported MIBs.
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Status
Name Description

RFC 1907 - SNMPv2-MIB The MIB module for SNMPv2 entities
| is MIB, published as RFC3273
HCNUM-TC A MIB medule containing textual conventions for high capacity data types

The original version o

SNMP-COMMURNITY-MIB This MIB medule defines objects to help support coexistence between SNMPv1, SNMPv2, and SNMPv3
SNMP-MPD-MIB The MIB for Message Processing and Dispatching

SNMP-TARGET-MIB The Target MIB Module

SNMP-VIEW-BASED-ACM-MIB The management information definitions for the View-based Access Control Model for SNMP.
NETGEAR-UDLD-MIB UDLD MIB

The following table describes the nonconfigurable information on the page.

Table 18. SNMP supported MIBs

Field Description
Name The RFC number if applicable and the name of the MIB.
Description The RFC title or MIB description.

Configure SNMPv3 users

Any user can connect to the switch using the SNMPv3 protocol, but for authentication and
encryption, the switch supports only one user (admin). Therefore, you can create or modify
only one profile.

To configure authentication and encryption settings for the SNMPv3 admin profile by
using the web interface:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > SNMP > SNMPv3 > User Configuration.
The User Configuration page displays.

The SNMPv3 Access Mode field is a read-only field that shows the access privileges for
the user account. Access for the admin account is always Read/Write. Access for all
other accounts is Read Only.

7. To enable authentication, select an Authentication Protocol radio button.

You can select the MD5 radio button or the SHA radio button. With either of these
options, the user login password is used as SNMPv3 authentication password. For
information about how to configure the login password, see Change the local device
password for the local browser Ul on page 242.

8. To enable encryption:

a. Nextto Encryption Protocol, select the DES radio button to encrypt SNMPv3 packets
using the DES encryption protocol.

b. Inthe Encryption Key field, enter an encryption code of eight or more alphanumeric
characters.

9. Click the Apply button.

Your settings are saved.

Configure LLDP

The IEEE 802.1AB-defined standard, Link Layer Discovery Protocol (LLDP), allows stations
on an 802 LAN to advertise major capabilities and physical descriptions. This information is
viewed by a network manager to identify system topology and detect bad configurations on
the LAN.

LLDP is a one-way protocol without any request/response sequences. Information is
advertised by stations implementing the transmit function, and is received and processed by
stations implementing the receive function. The transmit and receive functions can be
enabled or disabled separately per port. By default, both transmit and receive are enabled on
all ports. The application is responsible for starting each transmit and receive state machine
appropriately, based on the configured status and operational state of the port.

The Link Layer Discovery Protocol-Media Endpoint Discovery (LLDP-MED) is an
enhancement to LLDP with the following features:

» Autodiscovery of LAN policies (such as VLAN, Layer 2 priority, and DiffServ settings),
enabling plug and play networking.
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» Device location discovery for creation of location databases.
» Extended and automated power management of Power over Ethernet endpoints.

* Inventory management, enabling network administrators to track their network devices
and determine their characteristics (manufacturer, software and hardware versions,
serial/asset number).

Configure LLDP global settings
You can specify the global LLDP and LLDP-MED parameters that are applied to the switch.

To configure global LLDP settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > LLDP > Basic > LLDP Configuration.
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*Basic ~  TLV Advertised Interval 30 (5 to 32768 secs)

*LLDP Configuration Hold Multiplier 4 (2 to 10 secs)

= Advanced ¥ Reinitializing Delay 2 (1 to 10 secs)

Transmit Delay 5 (5 to 3600 secs)

LLDP-MED Properties

Fast Start Duration 3 (1 to 10 Times)

7. To configure nondefault values for the following LLDP properties, specify the following

options:
e TLV Advertised Interval. The number of seconds between transmissions of LLDP
advertisements.

e Hold Multiplier. The transmit interval multiplier value, where transmit hold multiplier x
transmit interval = the time to live (TTL) value that the device advertises to neighbors.

* Re-initializing Delay. The number of seconds to wait before attempting to re-initialize
LLDP on a port after the LLDP operating mode on the port changes.

e Transmit Delay. The minimum number of seconds to wait between transmissions of
remote data change notifications to one or more SNMP trap receivers configured on
the switch.

8. To configure a nondefault value for LLDP-MED, enter a value in the Fast Start Duration
field.

This value sets the number of LLDP packets sent when the LLDP-MED fast start
mechanism is initialized, which occurs when a new endpoint device links with the
LLDP-MED network connectivity device.

9. Click the Apply button.

Your settings are saved.

Configure LLDP port settings
You can specify per-interface LLDP settings.

To configure the LLDP interface:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > LLDP > Advanced > LLDP Port Settings.

«Basic -

To Inted
L m

Interface Admin Status Management |P Address  Nolification  Optional TLVs

*LLDP Port Settings gl Tx and Rx Auto Adverise Disable

and B x

7. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

8. Use the following menus to configure the LLDP settings for the selected ports:
* Admin Status. Select the status for transmitting and receiving LLDP packets:
- Tx Only. Enable only transmitting LLDP PDUs on the selected ports.
- Rx Only. Enable only receiving LLDP PDUs on the selected ports.

- Tx and Rx. Enable both transmitting and receiving LLDP PDUs on the selected
ports.

- Disabled. Do not transmit or receive LLDP PDUs on the selected ports.

The default is Tx and Rx.
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« Management IP Address. Choose whether to advertise the management IP address
from the interface. The possible field values are as follows:

- Stop Advertise. Do not advertise the management IP address from the interface.
- Auto Advertise. Advertise the current IP address of the device as the
management IP address.
The default is Auto Advertise.
* Notification. When notifications are enabled, LLDP interacts with the trap manager to
notify subscribers of remote data change statistics. The default is Disable.

e Optional TLV(s). Enable or disable the transmission of optional type-length value
(TLV) information from the interface. The default is Enable. The TLV information
includes the system name, system description, system capabilities, and port
description.

For information about how to configure the system name, see View or define switch
system information on page 52. For information about how to configure the port
description, see Configure the port settings and maximum frame size on page 131.

9. Click the Apply button.

Your settings are saved.

View LLDP-MED network policy information

You can display information about the LLPD-MED network policy TLVs transmitted in the
LLDP frames on the selected local interface.

To view LLDP-MED network policy information for an interface:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > LLDP > Advanced > LLDP-MED Network Policy.
The LLDP-MED Network Policy page displays.

7. From the Interface menu, select the interface for which you want to view the information.

Note: The menu includes only the interfaces on which LLDP is enabled. If no
interfaces are enabled for LLDP, the Interface menu does not display.

The page refreshes and displays the data transmitted in the network policy TLVs for the
interface.
The following table describes nonconfigurable information on the page.

Table 19. LLDP-MED network policy information

Field Description

Network Policy Number The policy number.

Application The media application type associated with the policy, which can be one of
the following:
e Unknown
* Voice

» Guest Voice

e Guest Voice Signaling

* Softphone Voice

» Video Conferencing

e Streaming Video

* Video Signaling

A port can receive multiple application types. The application information is
displayed only if a network policy TLV was transmitted from the port.

VLAN ID The VLAN ID associated with the policy.

VLAN Type Indicates whether the VLAN associated with the policy is tagged or
untagged.

User Priority The priority associated with the policy.

DSCP The DSCP associated with a particular policy type.
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Configure LLDP-MED port settings
You can enable LLDP-MED mode on an interface and configure its properties.

To configure LLDP-MED settings for a port:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > LLDP > Advanced > LLDP-MED Port Settings.
The LLDP-MED Port Settings page displays.

7. From the Port menu, select the port to configure.
8. Use the following menus to enable or disable the following LLDP-MED settings for the
selected port:

« LLDP-MED Status. The administrative status of LLDP-MED on the interface. When
LLDP-MED is enabled, the transmit and receive function of LLDP is effectively
enabled on the interface.

* Notification. When Notification is enabled, the port sends a topology change
notification if a device is connected or removed.

e Transmit Optional TLVs. When Transmit Optional TLVs is enabled, the port
transmits the following optional type length values (TLVs) in the LLDP PDU frames:

- MED Capabilities
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- Network Policy
- Location Identification
- Extended Power via MDI: PSE
- Extended Power via MDI: PD
- Inventory

9. Click the Apply button.

Your settings are saved.

View local LLDP information
You can view the data that each port advertises through LLDP.

To view local LLDP information:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > LLDP > Advanced > Local Information.
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The page includes only the interfaces on which LLDP is enabled.

The following table describes the LLDP device information and port summary information.

Field Description

Chassis ID Subtype The type of information used to identify the switch in the Chassis ID field.
Chassis ID The hardware platform identifier for the switch.

System Name The user-configured system name for the switch.

System Description The switch description, which includes information about the product model

and platform.

System Capabilities The primary functions that the switch supports.

Interface The interface associated with the rest of the data in the row.

Port ID Subtype The type of information used to identify the interface in the Port ID field.
Port ID The port number.

Port Description The user-defined description of the port. For information about how to

configure the port description, see Configure the port settings and
maximum frame size on page 131.

Advertisement The TLV advertisement status of the port.

7. To view additional details about a port, click the name of the port in the Interface column of
the Port Information table.
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The following table describes the detailed local information that displays for the selected

port.

Field

Managed Address

Description

Address SubType

The type of address the local browser Ul uses, such as an IPv4 address.

Address

The address used to manage the device.

Interface SubType

The port subtype.

Interface Number

The number that identifies the port.

MAC/PHY Details

Auto Negotiation Supported

Indicates whether the interface supports port speed autonegotiation. The
possible values are True and False.

Auto Negotiation Enabled

The port speed autonegotiation support status. The possible values are True
(enabled) or False (disabled).

Auto Negotiation Advertised

Capabilities

The port speed autonegotiation capabilities such as 100BASE-T half-duplex
mode or 10BASE-TX full-duplex mode.

Operational MAU Type

The Medium Attachment Unit (MAU) type. The MAU performs physical layer
functions, including digital data conversion from the Ethernet interface
collision detection and bit injection into the network.

MED Details

Capabilities Supported

The MED capabilities enabled on the port.

Current Capabilities

The TLVs advertised by the port.

Device Class

Network Connectivity indicates that the device is a network connectivity
device.

Network Policies

Application Type

The media application type associated with the policy.

VLAN ID

The VLAN ID associated with the policy.

VLAN Type

Specifies whether the VLAN associated with the policy is tagged or untagged.

User Priority

The priority associated with the policy.

DSCP

The DSCP associated with a particular policy type.
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View LLDP neighbors information
You can view the data that a specific interface receives from other LLDP-enabled systems.

To view LLDP information received from a neighbor device:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select System > LLDP > Advanced > Neighbor Information.

“ h‘-‘iﬁ-"hc""-‘ Lo oo

MSAP Entry Local Port Chassis ID Subtype Chassis ID Port ID Sublype PortID System Name

If no information was received from a neighbor device, or if the link partner is not
LLDP-enabled, no information displays.
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The following table describes the information that displays for all LLDP neighbors that

were discovered.

Field Description

MSAP Entry The Media Service Access Point (MSAP) entry number for the remote
device.

Local Port The interface on the local system that received LLDP information from a

remote system.

Chassis ID Subtype

The type of data displayed in the Chassis ID field on the remote system.

Chassis ID

The remote 802 LAN device’s chassis.

Port ID Subtype

The type of data displayed in the remote system'’s Port ID field.

Port ID

The physical address of the port on the remote system from which the data
was sent.

System Name

The system name associated with the remote device. If the field is blank, the
name might not be configured on the remote system.

column.

7. To view additional information about the remote device, click the link in the MSAP Entry

A pop-up window displays information for the selected port.

The following table describes the information transmitted by the neighbor.

Field Description

Port Details

Local Port The interface on the local system that received LLDP information from a
remote system.

MSAP Entry The Media Service Access Point (MSAP) entry number for the remote device.

Basic Details

Chassis ID Subtype

The type of data displayed in the Chassis ID field on the remote system.

Chassis ID

The remote 802 LAN device’s chassis.

Port ID Subtype

The type of data displayed in the remote system’s Port ID field.

Port ID

The physical address of the port on the remote system from which the data
was sent.

Port Description

The user-defined description of the port.

System Name

The system name associated with the remote device.

System Description

The description of the selected port associated with the remote system.

System Capabilities

The system capabilities of the remote system.
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Field

Managed Addresses

Description

Address SubType

The type of the management address.

Address

The advertised management address of the remote system.

Interface SubType

The port subtype.

Interface Number

The port on the remote device that sent the information.

MAC/PHY Details

Auto-Negotiation Supported

Specifies whether the remote device supports port-speed autonegotiation.
The possible values are True or False.

Auto-Negotiation Enabled

The port speed autonegotiation support status. The possible values are True
and False.

Auto Negotiation Advertised

Capabilities

The port speed autonegotiation capabilities.

Operational MAU Type

The Medium Attachment Unit (MAU) type. The MAU performs physical layer
functions, including digital data conversion from the Ethernet interface
collision detection and bit injection into the network.

MED Details

Capabilities Supported

The supported capabilities that were received in MED TLV from the device.

Current Capabilities

The advertised capabilities that were received in MED TLV from the device.

Device Class

The LLDP-MED endpoint device class. The possible device classes are as

follows:

» Endpoint Class 1 Indicates a generic endpoint class, offering basic LLDP
services.

« Endpoint Class 2 Indicates a media endpoint class, offering media
streaming capabilities as well as all Class 1 features.

« Endpoint Class 3 Indicates a communications device class, offering all
Class 1 and Class 2 features plus location, 911, Layer 2 switch support,
and device information management capabilities.

Hardware Revision

The hardware version advertised by the remote device.

Firmware Revision

The firmware version advertised by the remote device.

Software Revision

The software version advertised by the remote device.

Serial Number

The serial number advertised by the remote device.

Model Name

The model name advertised by the remote device.

Asset ID

The asset ID advertised by the remote device.
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Field

Location Information

Description

Civic

The physical location, such as the street address, that the remote device
advertised in the location TLV, for example, 123 45th St. E. The field value
length range is 6-160 characters.

Coordinates

The location map coordinates that the remote device advertised in the
location TLV, including latitude, longitude, and altitude.

ECS ELIN The Emergency Call Service (ECS) Emergency Location Identification
Number (ELIN) that the remote device advertised in the location TLV. The
field range is 10-25.

Unknown Displays unknown location information for the remote device.

Network Policies

Application Type

The media application type associated with the policy advertised by the
remote device.

VLAN ID

The VLAN ID associated with the policy.

VLAN Type

Specifies whether the VLAN associated with the policy is tagged or untagged.

User Priority

The priority associated with the policy.

DSCP

The DSCP associated with a particular policy type.

LLDP Unknown TLVs

Type

The unknown TLV type field.

Value

The unknown TLV value field.

Contigure DHCP snooping

DHCP snooping is a useful feature that provides security by filtering untrusted DHCP
messages and by building and maintaining a DHCP snooping binding table. An untrusted
message is a message that is received from outside the network or firewall and that can
cause traffic attacks within your network. The DHCP snooping binding table contains the
MAC address, IP address, lease time, binding type, VLAN number, and interface information
that corresponds to the local untrusted interfaces of a switch. An untrusted interface is an
interface that is configured to receive messages from outside the network or firewall. A
trusted interface is an interface that is configured to receive only messages from within the
network.

DHCP snooping acts like a firewall between untrusted hosts and DHCP servers. It also
provides way to differentiate between untrusted interfaces connected to the end user and
trusted interfaces connected to the DHCP server or another switch.
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Configure the global DHCP snooping settings
You can view and configure the global settings for DHCP snooping.

To configure the global DHCP snooping settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Services > DHCP Snooping > Global Configuration.

DHCP Snooping Global Configuration

*DHCP Snooping ~

DHCP Snooping Mode ® Disable Enable

- MAAP Add Edabinm e 3
MAC Address Validation Disable ® Enable

*Interface Configuration
* Binding Configuration

VLAN Configuration

VLAN ID DHCP Snooping Mode

w w

7. Next to DHCP Snooping Mode, select the Enable radio button.

8. To enable the verification of the sender's MAC address for DHCP snooping, next to MAC
Address Validation, select the Enable radio button.
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When MAC address validation is enabled, the device checks packets that are received
on an untrusted interface to verify that the MAC address and the DHCP client hardware
address match. If the addresses do not match, the device drops the packet.

9. Click the Apply button.

Your settings are saved.

Enable DHCP for all interfaces in a VLAN

To enable DHCP snooping for all interfaces that are members of a VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Services > DHCP Snooping > Global Configuration.
The DHCP Snooping Global Configuration page displays.

7. Inthe VLAN ID field, specify the VLAN on which DHCP snooping is enabled.

8. From the DHCP Snooping Mode menu, select Enable.
9. Click the Apply button.

Your settings are saved.
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Configure DHCP snooping interface settings

You can view and configure each port as a trusted or untrusted port. Any DHCP responses
received on a trusted port are forwarded. If a port is configured as untrusted, any DHCP (or
BootP) responses received on that port are discarded.

To configure DHCP snooping interface settings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Services > DHCP Snooping > Interface Configuration.

Interface Configuration

Interface Trust Mode
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7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

* LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.
8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Trust Mode menu, select the desired trust mode:

» Disabled. The interface is considered to be untrusted and could potentially be used
to launch a network attack. DHCP server messages are checked against the bindings
database. On untrusted ports, DHCP snooping enforces the following security rules:

- DHCP packets from a DHCP server (DHCPOFFER, DHCPACK, DHCPNAK,
DHCPRELEASEQUERY) are dropped.

- DHCPRELEASE and DHCPDECLINE messages are dropped if the MAC address
is in the snooping database but the binding’s interface is other than the interface
where the message was received.

- DHCP packets are dropped when the source MAC address does not match the
client hardware address if MAC address validation is globally enabled.

« Enabled. The interface is considered to be trusted and forwards DHCP server
messages without validation.

10. Click the Apply button.
Your settings are saved.

Configure static DHCP bindings

You can view, add, and remove static bindings in the DHCP snooping bindings database and
view or clear the dynamic bindings in the bindings table.

To configure static DHCP bindings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

» After registration, enter the local device password.

By default, the local device password is password. You must change this password

at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.
6. Select System > Services > DHCP Snooping > Binding Configuration.
Static Binding Configuration
*DHCP Snooging “ Intedface MAC Address VLAN 1D IP Address
vt Cortprin |
Dynamic Binding Configuration
Iinterface MAC Address VLAN ID P Address Lease Time
7. From the Interface menu, select the interface on which the DHCP client is authorized.
8. In the MAC Address field, specify the MAC address for the binding to be added.
This is the key to the binding database.
9. From the VLAN ID menu, select the ID of the VLAN the client is authorized to use.
10. In the IP Address field, specify the IP address of the client.
11. Click the Add button.

The DHCP snooping binding entry is added to the database.

The Dynamic Binding Configuration table shows information about the DHCP bindings that
were learned on each interface on which DHCP snooping is enabled. The following table
describes the dynamic bindings information.
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Table 20. DHCP Dynamic Configuration information

Field Description

Interface The interface on which the DHCP client message was received.

MAC Address The MAC address associated with the DHCP client that sent the message. This is the
key to the binding database.

VLAN ID The VLAN ID of the client interface.

IP Address The IP address assigned to the client by the DHCP server.

Lease Time The remaining IP address lease time for the client.

Set up PoE timer schedules

The switch lets you define multiple timer schedules that you can use for POE power delivery
to attached PDs.

After you create a timer schedule, you can associate it with one or more PoE ports (see
Configure the PoE port settings on page 923). You can use a separate timer schedule for
each PoE port.

After you associate a timer schedule with a PoE port, the start date and time force the PoE
port to stop delivering power and the stop date and time enable the PoE port to start
delivering power.

Create a PoE timer schedule
The maximum number of timer schedules that you can add is 25.

To create a PoE timer schedule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Timer Schedule > Basic > Timer Global Configuration.

Timer Schedule

Admin Mode Disable ® Enable

Timer Schedule Name

Timer Schedule Name ID

test 1

7. Select the Admin Mode Enable radio button.
By default, the Disable button is selected and PoE timer schedules are disabled.

8. Inthe Timer Schedule Name field, specify the name for a timer schedule.
9. Click the Add button.

The timer schedule is added to the Timer Schedule Name table and is assigned an ID.

Specify the settings for a PoE timer schedule

The PoE timer schedule functions as a recurring schedule, which lets you to set up a single

schedule that starts at a particular date and that recurs either with a specific end date or
indefinitely.

You can specify a daily, weekly, monthly, or yearly recurring schedule.

To specify the settings for a PoE timer schedule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.

6. Select System > Timer Schedule > Advanced > Timer Schedule Configuration.

Timer Schedule Selection

Timer Schedule Name test ~

Timer Schedule Configuration

Shutdown Time Start 09:11 (hh:mm

Shutdown Time End 09:12 hh:mm

Date Start 17-Mar-2017 |

Date Stop nd Date @ End Date 18-Mar-2017 ]
Recurmrence Pattern Dail v

Daily Mode ® Every WeekDay ) Every Day(s

7. From the Timer Schedule Name menu, select the name of the timer schedule that you
want to configure.

You can select only names of schedules that you created (see Create a PoE timer
schedule on page 125).

8. In the Shutdown Time Start field, enter the time of day in the HH:MM format to specify
when the timer schedule must start.

9. In the Shutdown Time End field, enter the time of day in the HH:MM format to specify
when the timer schedule must stop.

10. Next to the Date Start field, click the calendar icon and use the menus in the pop-up window
to enter the date in the DD-Mon-YYYY format to specify when the timer schedule must start.

11. Either select the No End Date radio button or select the End Date radio button, and next to
the End Date field, click the calendar icon and use the menus in the pop-up window to enter
the date in the DD-Mon-YYYY format to specify when the timer schedule must stop.
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12. From the Recurrence Pattern menu, select the pattern:
« Daily. The timer schedule works with daily recurrence. The fields adjust. Select one of
the following radio buttons:
- Every WeekDay. The schedule operates from Monday through Friday.

- Every Day(s). Enter a number from 0 to 65534 in the field. The schedule is
triggered every specified number of days. If the number of days is not specified, or
if you enter 0, then the schedule is triggered only once.

* Weekly. The timer schedule works with weekly recurrence. The fields adjust. Specify
the following field and select one or more of the following check boxes:

- Every Week(s). In the field, enter a number from 0 to 65534 to specify that the
schedule must be triggered every specified number of weeks. If the number of
weeks is not specified, or if you enter 0, then the schedule is triggered only once.

- Select a single Week Day check box, multiple check boxes, or all check boxes to
specify the day or days of the week that the schedule must operate.

e Monthly. The timer schedule works with monthly recurrence. The fields adjust. Select
one of the following radio buttons:

- Upper Day radio button and field. In the Day field, enter a number from 1 to 31 to
specify the day of the month when the schedule must be triggered.

In the Every Month(s) field, enter a number from 0 to 65534 to specify that the
schedule must be triggered every specified number of months. If the number of
months is not specified, or if you enter 0, then the schedule is triggered only once.

- Lower Day radio button and field. Select an option from both the left menu and
right menu.

In the Every Month(s) field, enter a number from 0 to 65534 to specify that the
schedule must be triggered every specified number of months. If the number of
months is not specified, or if you enter 0, then the schedule is triggered only once.

* Yearly. The timer schedule works with yearly recurrence. The fields adjust. Select
one of the following radio buttons:

- Day(s). In the Day(s) field, enter a number from 1 to 31 to specify the day of the
month when the schedule must be triggered.

From the Month menu, select the month in which the schedule must be triggered.
The schedule is triggered yearly but only in the selected month.

- Day(s). Select an option from both the left menu and right menu.

From the Month menu, select the month in which the schedule must be triggered.
The schedule is triggered yearly but only in the selected month.

13. Click the Apply button.

Your settings are saved.
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Delete a PoE timer schedule

You can delete a PoE timer schedule that you no longer need. The associated timer
schedule configuration is also deleted.

To delete a PoE timer schedule:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After registration, enter the local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select System > Timer Schedule > Advanced > Timer Global Configuration.
The Timer Schedule Configuration page displays.

7. Select the check box for the timer schedule that you want to delete.
You can simultaneously delete multiple or all timer schedules.

8. Click the Delete button.

The timer schedule is deleted.
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This chapter contains the following sections:

» Configure the port settings and maximum frame size

» Configure link aggregation groups
e Configure VLANs
e Configure a voice VLAN

» Configure Auto-VolP

» Configure Spanning Tree Protocol

» Configure multicast

* View, search, and manage the MAC address table

e Configure Layer 2 loop protection
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Contfigure the port settings and maximum
frame size

You can view, configure, and monitor the physical port information for the ports (that is, the
physical interfaces) on the switch.

To configure the port settings and maximum frame size:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Ports > Port Configuration.
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7. In the Frame Size field, specify the maximum Ethernet frame size that each interface can
support.

The frame size includes the Ethernet header, CRC, and payload. The range is 1522 to
10000. The default maximum frame size is 1522.

8. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

« LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.

9. Select one or more interfaces by taking one of the following actions:

« To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.

10. In the Description field, enter the description string to be attached to a port.
The string can be up to 64 characters in length.
11. From the Admin Mode menu, select Enable or Disable.

This sets the port control administrative mode. You must select Enable in order for the
port to participate in the network. The default is Enable.

12. From the Autonegotiation menu, select Enable or Disable.

This specifies the autonegotiation mode for this port. The default is Enable.

Note: After you change the autonegotiation mode, the switch might be
inaccessible for a number of seconds while the new settings take effect.

13. In the Speed field, specify the speed value for the selected port.
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Possible field values are as follows:

e Auto. All supported speeds. This is the default setting.

e 10Mbps. 10 Mbits/second.

* 100Mbps. 100 Mbits/second.

 1000Mbps. 1000 Mbits/second.

The delimiter characters for setting different speed values are a comma (,), a period (.)

and a space (). For you to set the autonegotiation speed, the autonegotiation mode must
be set to Enable. The default is Auto.

Note: After you change the speed value, the switch might be inaccessible for
a number of seconds while the new settings take effect.

14. From the Duplex Mode menu, select the duplex mode for the selected port.
Possible values are as follows:

e Auto. Indicates that speed is set by the auto-negotiation process.

e Full. Indicates that the interface supports transmission between the devices in both
directions simultaneously.

« Half. Indicates that the interface supports transmission between the devices in only
one direction at a time.

The default is Auto.

Note: After you change the duplex mode, the switch might be inaccessible for
a number of seconds while the new settings take effect.

15. From the Auto Power Down Mode menu, select whether the auto power down mode of the
Green Ethernet feature is enabled or disabled.

The default is disabled.

16. Use the Link Trap menu to select whether to send a trap when link status changes.
The default is enabled for normal interfaces and disabled for LAG interfaces.

17. From the Flow Control menu, select to enable or disable IEEE 802.3 flow control.

The default is disabled. The switch does not send pause frames if the port buffers
become full. Flow control helps to prevent data loss when the port cannot keep up with
the number of frames being switched. When flow control is enabled, the switch can send
a pause frame to stop traffic on a port if the amount of memory used by the packets on
the port exceeds a preconfigured threshold and responds to pause requests from partner
devices. The paused port does not forward packets for the period of time specified in the
pause frame. When the pause frame time elapses, or the utilization returns to a specified
low threshold, the switch enables the port to again transmit frames. For LAG interfaces,
flow control mode is displayed as a blank field because flow control is not applicable.

18. Click the Apply button.

Your settings are saved.
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The following table describes the nonconfigurable information on the page.

Table 21. Port Configuration information

Field Description
Port Type For normal ports this field is blank. Otherwise, the possible values are as
follows:

e Mirrored. The port is a mirrored port on which all the traffic is copied to
the probe port.
¢ Probe. Use this port to monitor a mirrored port.

e Trunk Member. The port is a member of a link aggregation trunk. Look
at the LAG pages for more information.

Physical Status Indicates the port speed and duplex mode.
Link Status Indicates whether the link is up or down.
Frame Size (1522 to 10000) The maximum Ethernet frame size that each interface can support. The

frame size depends on your selection from the Frame Size menu above
the table and applies to each interface.

MAC Address Displays the physical address of the specified interface.

PortList Bit Offset Displays the bit offset value that corresponds to the port when the MIB
object type PortList is used to manage in SNMP.

ifindex The ifindex of the interface table entry associated with this port.

Contigure link aggregation groups

Link aggregation groups (LAGs), which are also known as port channels, allow you to
combine multiple full-duplex Ethernet links into a single logical link. Network devices treat the
aggregation as if it were a single link, which increases fault tolerance and provides load
sharing. You assign the LAG VLAN membership after you create a LAG. The LAG by default
becomes a member of the default management VLAN (that is, VLAN 1).

A LAG interface can be either static or dynamic, but not both. All members of a LAG must
participate in the same protocols. A static port channel interface does not require a partner
system to be able to aggregate its member ports.

Static LAGs are supported. When a port is added to a LAG as a static member, it neither
transmits nor receives LACPDUSs. The switch supports eight LAGs.

Configure LAG settings
You can group one or more full-duplex Ethernet links to be aggregated together to form a link

aggregation group, which is also known as a port channel. The switch treats the LAG as if it
were a single link.
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To configure LAG settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > LAG > Basic > LAG Configuration.

LAG Configuration
LAG Name Description :‘5\6 Admin Mode Hash Mode STP Mode | Link Trap | LAG Type ';:i": LAG State
chl I Enabled 1 Src/Dest MAC, incoming port Disable Enable Static Link Down
¢ch? I2 Enabled 1 Sre/Dest MAC, incoming port Disable Enable Static Link Down
¢ch3 13 Enabled 1 Src/Dest MAC, incoming port Disable Enable Static Link Down
chd 14 Enabled 1 Src/Dest MAC, incoming port Disable Enable Static Link Down
chs 15 Enabled 1 Sre/Dest MAC, incoming port Disable Enable Static Link Dow
chb 6 Enabled 1 Src/Dest MAC, incoming port Disable Enable Static Link Down
¢ch? I7 Enabled 1 Sre/Dest MAC, incoming port Disable Enable Static Link Down
chd 8 Enabled 1 Sre/Dest MAC, incoming port Disable Enable Static Link Down

7. Inthe LAG Name field, enter the nhame to be assigned to the LAG.

You can enter any string of up to 15 alphanumeric characters. A valid name must be
specified for you to create the LAG.

8. In the Description field, enter the description string to be attached to a LAG.
The description can be up to 64 characters in length.

9. From the Admin Mode menu, select Enable or Disable.

Configure Switching 135 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

When the LAG is disabled, no traffic flows and LACPDUSs are dropped, but the links that
form the LAG are not released. The default is Enable.
10. From the Hash Mode menu, select the load-balancing mode for a port channel (LAG):

e 1 Src/Dest MAC, incoming port. This mode uses the source MAC address,
destination MAC address, and incoming port that are associated with the packet.

e 2 Src/Dest IP and TCP/UDP Port Fields. This mode uses the source and destination
IP addresses and source and destination TCP or UDP port values that are associated
with the packet.

Note: The switch balances traffic on a port channel (LAG) by selecting one of
the links in the channel over which packets must be transmitted. The
switch selects the link by creating a binary pattern from selected fields
in a packet and associating that pattern with a particular link.

11. From the STP Mode menu, select the Spanning Tree Protocol (STP) administrative mode
associated with the LAG. The possible values are as follows:

« Disable. Spanning tree is disabled for this LAG.
e Enable. Spanning tree is enabled for this LAG. Enable is the default.

12. From the Link Trap menu, select Enable or Disable to specify whether to send a trap when
the link status changes.

The default is Enable, which causes the trap to be sent.

13. From the LAG Type menu, select Static or LACP:

e Static. Disables Link Aggregation Control Protocol (LACP) on the selected LAG. The
LAG is configured manually. The default is Static.

« LACP. Disables LACP on the selected LAG. The LAG is configured automatically.
14. Click the Apply button.

Your settings are saved.
The following table describes the nonconfigurable information on the page.

Table 22. LAG Configuration information

Field Description

LAG ID Identification of the LAG.

Active Ports Indicates the ports that are actively participating in the port channel.
LAG State Indicates whether the link is up or down.

Configure LAG membership

You can select two or more full-duplex Ethernet links to be aggregated together to form a link
aggregation group (LAG), which is also known as a port channel. The switch can treat the
port channel as a single link.
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To configure LAG membership:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > LAG > Basic > LAG Membership.

* Basic ~ LAGID TE"
*LAG Configuration LAG Name chi
= Advanced v - Unit 1

g 11 13 15 17 19 21 23 25

" T A
OO

14 16 18 20 22 24 2%

7. From the LAG ID menu, select the LAG ID.
8. In the LAG Name field, enter the name to be assigned to the LAG.

You can enter any string of up to 15 alphanumeric characters. A valid name must be
specified for you to create the LAG.

9. In the Ports table, click each port that you want to include as a member of the selected
LAG.

A selected port is displayed by a check mark.
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10. Click the Apply button.

Your settings are saved.

Set the LACP system priority
You can set the LACP system priority that applies to all LAGs on the switch.

To set the LACP system priority:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. Inthe address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > LAG > Advanced > LACP Configuration.

*Basic v LACP System Priority 32768 {1 to 65535)
= Advanced A
=LAG Membership
= LACP Configuration
=LACP Port
Configuration
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7. Inthe LACP System Priority field, specify the device’s link aggregation priority relative to
the devices at the other ends of the links on which link aggregation is enabled.

A higher value indicates a lower priority. You can change the value of the parameter
globally by specifying a priority from 1 to 65535. The default is 32768.

8. Click the Apply button.

Your settings are saved.

Set the LACP port priority settings
You can configure the LACP priority value and administrative LACP time-out value for a port.

To configure LACP port priority settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > LAG > Advanced > LACP Port Configuration.
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7. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the interface, or
type the interface number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading

rOw.

8. Inthe LACP Priority field, specify the LACP priority value for the selected interfaces.

This value specifies the device’s link aggregation priority relative to the devices at the
other ends of the links on which link aggregation is enabled. A higher value indicates a
lower priority. The range is 0 to 255. The default is 128.

9. In the Timeout field, configure the administrative LACP time-out value:

e Long. Specifies a long time-out value.
e Short. Specifies a short time-out value.

10. Click the Apply button.

Your settings are saved.

Contfigure VLANs

Adding virtual LAN (VLAN) support to a Layer 2 switch offers some of the benefits of both
bridging and routing. Like a bridge, a VLAN switch forwards traffic based on the Layer 2
header, which is fast, and like a router, it partitions the network into logical segments, which

provides better administration, security, and management of multicast traffic.

By default, all ports on the switch are in the same broadcast domain. VLANSs electronically
separate ports on the same switch into separate broadcast domains so that broadcast
packets are not sent to all the ports on a single switch. When you use a VLAN, users can be

grouped by logical function instead of physical location.
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Each VLAN in a network is assigned an associated VLAN ID, which appears in the IEEE
802.1Q tag in the Layer 2 header of packets transmitted on a VLAN. An end station can omit
the tag, or the VLAN portion of the tag, in which case the first switch port to receive the
packet can either reject it or insert a tag using its default VLAN ID. A given port can handle
traffic for more than one VLAN, but it can support only one default VLAN ID.

You can define VLAN groups stored in the VLAN membership table. The switch supports up
to 64 VLANS.

The following VLANS are preconfigured on the switch and you cannot delete them:

*  VLAN 1. The default VLAN of which all ports are members.

* VLAN 4088. The default Auto-VolP VLAN. By default, this VLAN does not include any
members but you can manually add members.

Configure VLAN settings

You can configure the various VLAN settings.

Add a VLAN
To add a VLAN:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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Select Switching > VLAN > Basic > VLAN Configuration.

* Basic ~ Ll VLANID || VLAN Name WLAN Type
* Advanced v 1 default Default
4088 Auto-VolP Auto-VolP

Ressat

Reset Configuration

In the VLAN ID field, specify the VLAN identifier for the new VLAN.

The range of the VLAN ID can be from 2 to 4093, excluding 4088. (The default VLANs
are 1 and 4088).

In the VLAN Name field, specify a name for the VLAN.

The VLAN name can be up to 32 alphanumeric characters long, including blanks. The
default is blank. VLAN ID 1 always uses the name Default.

The VLAN Type field displays the type of the VLAN that you are configuring.

The VLAN name can be up to 32 alphanumeric characters long, including blanks. You
cannot change the names of the default VLANS (that is, the VLANs with ID 1 and 4088).

The VLAN Type field displays the type of the VLAN that you are configuring.

You cannot change the type of the default VLANS (that is, the VLANs with ID 1 and 4088).
When you create a VLAN using this page, its type is always static. A VLAN that is created
by the Generic VLAN Registration Protocol (GVRP) initially uses a type of dynamic. You
can change the type of a dynamic VLAN to static.

Click the Add button.
The VLAN is added to the switch.

Delete a VLAN
To delete a VLAN from the switch:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select Switching > VLAN > Basic > VLAN Configuration.
The VLAN Configuration page displays.

In the VLAN ID field, specify the VLAN identifier.

The range of the VLAN ID can be from 2 to 4093. You cannot delete VLANs 1 and 4088,
which are predefined.

Click the Delete button.
The VLAN is removed.

Reset the VLAN configuration on the switch to the default settings

If you reset the VLAN configuration on the switch to the default settings, all VLANS that you
added are deleted. (The predefined VLANS are not deleted).

The VLAN default values are as follows:

All ports are assigned to the default VLAN of 1.

All ports are configured with a PVID of 1.

All ports are configured to an Acceptable Frame Types value of Admit All Frames.
All ports are configured with ingress filtering disabled.

All ports are configured to transmit only untagged frames.

GVRP is disabled on all ports and all dynamic entries are cleared.

To reset the VLAN configuration on the switch to the default settings:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > VLAN > Basic > VLAN Configuration.
The VLAN Configuration page displays.

7. Select the Reset Configuration check box.
8. Click the Apply button.

Your settings are saved. Except for the predefined default VLANSs, all VLANs are deleted.

Configure VLAN membership

To configure VLAN membership:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.
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By default, the local device password is password. You must change this password

at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter

the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on

page 30.
Click the Login button.
The System Information page displays.

Select Switching > VLAN > Advanced > VLAN Membership.

“ VLAN Membership
= Basic v 1AM IR
VLAN ID 1 v
* Advanced & Group Operation Untag Al 7
*VLAN Configuration VLAN Name
AN IN¢
VLAN Type
*VLAN Status .
»Port PVID Configuration - Unit 1
« Voice VLAN Pots:_ 135 _ 9 1119 15 - 17 19 - 21 z 23 35,
Configuration mmmmﬂmumnmmmml
LoJLuJ{oJ{oJ{vJ{v]{v){v)v)v]lv)v]ly)
2 4 6 8 10 12 14 16 18 20 22 24 26
[ [0S
LAG 1 3 § 7.
(VRURuNV]
ogooo

7. In the VLAN ID menu, select the VLAN ID.
8. Inthe Group Operation menu, select one of the following options, which applies to all ports

in the VLAN:

* Untag All. For all ports and LAGs that are members of the VLAN, tags are removed
from all egress packets.

o Tag All. For all ports and LAGs that are members of the VLAN, all egress packets are

tagged.

* Remove All. All ports and LAGs are removed from the VLAN, including the ports and
LAGs that were dynamically registered through GVRP.

9. Inthe Ports table, click each port once, twice, or three times to configure one of the following
modes or reset the port to the default settings:

» T (Tagged). Selects the port as a tagged port in the VLAN. All frames transmitted on
the port are tagged for this VLAN.

* U (Untagged). Selects the port as an untagged port in the VLAN. All frames
transmitted on the port are untagged for this VLAN.

* Blank. The port is excluded from the VLAN.
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10. In the LAG table, click each LAG once, twice, or three times to configure one of the following
modes or reset the LAG to the default settings:

e T (Tagged). Selects the LAG as a tagged LAG in the VLAN. All frames transmitted on
the LAG are tagged for this VLAN.

e U (Untagged). Selects the LAG as an untagged LAG in the VLAN. All frames
transmitted on the LAG are untagged for this VLAN.

+ Blank. The LAG is excluded from the VLAN.
11. Click the Apply button.

Your settings are saved.
The following table describes the nonconfigurable information on the page.

Table 23. Advanced VLAN membership

Field Definition

VLAN Name The name for the VLAN that you selected. It can be up to 32 alphanumeric characters long,
including blanks. The names for the following VLANS are predefined:

e VLAN 1. Default.
* VLAN 4088. Auto-VolIP.

VLAN Type The type of the VLAN you selected:
» Default (VLAN ID = 1). Always present.
e Static. A VLAN that you configured.

e Dynamic. A VLAN that is created through GVRP registration, that you did not convert to
a static VLAN, and that GVRP can therefore remove.

View the VLAN status

You can view the status of all currently configured VLANS.

To view the VLAN status:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on

page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > VLAN > Advanced > VLAN Status.

= Basic

* Advanced

=Voice VLAN
Configuration

=VLAN Configuration

*VLAN Membership

= Port PVID Configuration

¥ VLAN ID VLAN Name VLAN Type Member Ports
-~ 1 default Default g1-g26,11-18
4088 Auto-VolP Auto-VolP

The following table describes the nonconfigurable information on the page.

Table 24. VLAN status

Field Definition

VLAN ID The VLAN identifier (VID) of the VLAN. The range of the VLAN ID is 1 to 4093.
VLAN Name The name of the VLAN. VLAN ID 1 is always named Default.

VLAN Type The VLAN type:

Default (VLAN ID = 1). Always present.
Auto-VoIP (VLAN ID = 4088). Always present.
Static. A VLAN that you configured.

Dynamic. A VLAN that is created through GVRP registration, that you did not convert to
a static VLAN, and that GVRP can therefore remove.

Member Ports

The ports that are included in the VLAN.

Configure the port PVID settings

You can assign a port VLAN ID (PVID) to an interface. The following requirements apply to a

PVID:

e By default, the PVID for each port is 1.
« If you do not specify another value, the default VLAN PVID is used.
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e To change the port’s default PVID, you must first create a VLAN that includes the port as
a member (see Configure VLAN membership on page 144).

To configure PVID settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

e If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > VLAN > Advanced > Port PVID Configuration.

VLAN Tog Accaptable Frame Ingress Fierng | Curtent Ingress Fitering| Unitagged VLANs  Tagged VLAMNs | Forbicden VLANS || Dynamic VLANS Port Priocity

e r Diesable Diaat 1 Mo

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

e 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

e LAG. Only LAGs are displayed.
e All. Both physical interfaces and LAGs are displayed.
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8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. In the PVID field, specify the VLAN ID to assign to untagged or priority-tagged frames
received on this port.

The default is 1.
10. In the VLAN Member field, specify the VLAN ID or list of VLANs of a member port.

VLAN IDs range from 1 to 4093. The default is 1. Use a hyphen (-) to specify arange or a
comma (,) to separate VLAN IDs in a list. Spaces and zeros are not permitted.

11. In the VLAN Tag field, specify the VLAN ID or list of VLANS of a tagged port.

VLAN IDs range from 1 to 4093. Use a hyphen (-) to specify a range or a comma (,) to
separate VLAN IDs in a list. Spaces and zeros are not permitted. You can specify port
tagging for the VLAN only if the port that you want to add as a tagged port is also member
of the VLAN. To reset the VLAN tag configuration to the defaults, use the None keyword.

12. From the Acceptable Frame menu, specify one if the following types of frames that can be
received on the port:

* Admit All. Untagged frames or priority-tagged frames that are received on the port
are accepted and assigned the value of the port VLAN ID for the port. This is the
default selection.

* VLAN Only. Untagged frames or priority-tagged frames that are received on the port
are discarded.

« Admit Untagged Only. Untagged frames that are received on the port are accepted.
With the Admit All and VLAN Only selections, VLAN-tagged frames are forwarded in
accordance to the 802.1Q VLAN specification.

13. From the Ingress Filtering menu, select one of the following options:

« Enable. The frame is discarded if this port is not a member of the VLAN with which
this frame is associated. In a tagged frame, the VLAN is identified by the VLAN ID in
the tag. In an untagged frame, the VLAN is the port VLAN ID specified for the port that
received this frame.

» Disable. All frames are forwarded in accordance with the 802.1Q VLAN bridge
specification. The default is Disable.

14. In the Port Priority field, specify the default 802.1p priority assigned to untagged packets
arriving at the port.

You can enter a number from 0 to 7.
15. Click the Apply button.

Your settings are saved.

Configure Switching 149 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

The following table describes the nonconfigurable fields on the page.

Table 25. Nonconfigurable fields on the PVID Configuration page

Field Description

Current Ingress Filtering Indicates whether ingress filtering is enabled for the interface.
Untagged VLANSs The number of untagged VLANS for the interface.

Tagged VLANS The number of tagged VLANS for the interface.

Forbidden VLANSs The number of forbidden VLANS for the interface.

Dynamic VLANs The number of dynamically added VLANS for the interface.

Configure a voice VLAN

You can configure the settings for a voice VLAN.

To configure a voice VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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6. Select Switching > VLAN > Advanced > Voice VLAN Configuration.

_, LA} Voice VLAN Global Admin
* Basic ¥ Admin Mode ® Disable @ Enable
* Advanced -~
*VLAN Configuration
“VLAN Membership Voice VLAN Configuration
=VLAN Status 1 Go To Interface m
* Port PVID Configuration - ot N s
_| | Interface Interface Mode | Value S‘ﬁ o Op i alion | psep value
=Voice VLAN e State Mode
Configuration - ™ G
] g1 Disable 0 Disable Disable Enable 0
g2 Disable 0 Disable Disable Enable 0
B g3 Disable 0 Disable Disable Enable 0
J g4 Disable 0 Disable Disable Enable 0
g5 Disable 0 Disable Disable Enable 0
g6 Disable 0 Disable Disable Enable 0
g7 Disable 0 Disable Disable Enable 0
g8 Disable 0 Disable Disable Enable 0
g9 Disable 0 Disable Disable Enable 0
1 g10 Disable 0 Disable Disable Enable 0
gl Disable 0 Disable Disable Enable 0
g12 Disable 0 Disable Disable Enable 0

7. Select the Admin Mode Disable or Enable radio button.

This specifies the administrative mode for the voice VLAN for the switch. The default is
Disable.

8. Select the interface by taking one of the following actions:

To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

To configure multiple interfaces with the same settings, select the check box

associated with each interface.

To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Interface Mode menu, select the voice VLAN mode for selected interfaces:

Disable. This is the default value.
None. Allow the IP phone to use its own configuration to send untagged voice traffic.

VLAN ID. Configure the phone to send tagged voice traffic. You must enter the VLAN
ID in the Value field (see the next step).

Dotlp. Configure voice VLAN 802.1p priority tagging for voice traffic. You must enter
the dotlp value in the Value field (see the next step).

Untagged. Configure the phone to send untagged voice traffic.

10. In the Value field, enter the VLAN ID or dotlp value.

This field is enabled only if you select VLAN ID or Dotlp from the Interface Mode menu.

11. In the CoS Override Mode field, select Disable or Enable.
The default is Disable.

12. In the Authentication Mode field, select Enable or Disable.
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The default is Enable. When the authentication mode is enabled, voice traffic is allowed
on an unauthorized voice VLAN port. When the authentication mode is disabled, devices
are authorized through dot1x.

Note: Authentication through dotlx is possible only if dotlx is enabled.

13. In the DSCP Value field, configure the Voice VLAN DSCP value for the port.
The valid range is 0 to 64. The default is 0.

14. Click the Apply button.
Your settings are saved.

The Operational State field displays the operational status of the voice VLAN on the given
interface.

Configure Auto-VolP

Voice over Internet Protocol (VolP) enables telephone calls over a data network. Because
voice traffic is typically more time-sensitive than data traffic, the Auto-VolIP feature provides a
classification for voice packets so that they can be prioritized above data packets, allowing
the switch to provide better Quality of Service (QoS). With the Auto-VolP feature, voice
prioritization is provided based on the SIP call-control protocol or OUI bits.

Configure the Auto-VolP protocol-based settings

To prioritize time-sensitive voice traffic over data traffic, protocol-based Auto-VolP checks for
packets carrying the Session Initiation Protocol (SIP) VolIP protocol.

VolP frames that are received on ports that for which the Auto-VolP feature is enabled are
marked with the specified CoS traffic class value.

To configure the Auto-VoIP protocol-based settings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Auto-VoIP > Protocol-based > Port Settings.

Auto-VoIP Protocol Based Global Settings
* Protocol Based ~ | Prioritization Type Traffic Class ~
* Port Settings Class Value 7~

*QUl-Based v
= Auto-VolP Status
Protocol Based Port Settings

1 LAG Al  Go To Interface m

_| | Interface  Auto VoIP Mode = Operational Status

g1 Disable Down
g2 Disable Down
g3 Disable Down
g4 Disable Down
1 g5 Disable Down
g6 Disable Down
g7 Disable Down
g8 Disable Down

7. From the Prioritization Type menu, select Traffic Class or Remark.
This specifies the type of prioritization.

8. From the Class Value menu, specify the CoS tag value to be reassigned for packets
received on the voice VLAN when Remark CoS is enabled.
9. In the Protocol Based Global Settings section, specify the Auto VolP Mode settings:

a. Select whether to display physical interfaces, LAGs, or both by clicking one of the
following links above the table heading:

e 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the
default setting.

e LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.
b. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or
type the port number in the Go To Interface field and click the Go button.
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« To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the
heading row.

c. From the Auto VolP Mode menu, select to enable or disable the Auto VolP mode
for the interface or interfaces.

10. Click the Apply button.

Your settings are saved.

The Operational Status field displays the current operational status of each interface.

Configure the Auto-VolP OUl-based properties

With Organizationally Unique Identifier (OUI)-based Auto-VolP, voice prioritization is
provided based on OUI bits.

To configure the Auto-VolP OUl-based properties:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Auto-VoIP > OUIl-based > Properties.
The OUI-Based Properties page displays.
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7. In the Auto-VolP VLAN ID field, enter the VolP VLAN ID of the switch.

The default Auto-VolP VLAN ID is 4088. You can use that VLAN ID or create another
VLAN ID for Auto-VoIP.

8. From the OUl-based priority menu, select the OUI-based priority of the switch, from 0 to 7.
The default value is 7.
9. Click the Apply button.

Your settings are saved.

Configure the OUl-based port settings
You can configure the OUI port settings.

To configure OUl-based port settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Auto-VoIP > OUl-based > Port Settings.
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7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default

setting.

 LAG. Only LAGs are displayed.
» All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading

row.

9. From the Auto VolP Mode menu, select Disable or Enable.
Auto-VoIP is disabled by default.

The Operational Status field displays the current operational status of each interface.
10. Click the Apply button.
Your settings are saved.

Manage the OUI table

Device hardware manufacturers can include an OUI in a network adapter to help identify a
hardware device. The OUI is a unique 24-bit number assigned by the IEEE registration
authority. The switch comes preconfigured with the following OUls that identify the IP phone

manufacturer:

* 00:01:E3: SIEMENS

* 00:03:6B: CISCO1
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00:12:43: CISCO2
00:60:B9: NITSUKO
00:DO0:1E: PINTEL
00:E0:75: VERILINK
00:E0:BB: 3COM
00:04:0D: AVAYAL
00:1B:4F: AVAYA2

You can select an existing OUI or add a new OUI and description to identify the IP phones on
the network.

Configure the OUI table
To configure the OUI table:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select Switching > Auto-VoIP > OUIl-based > OUI Table.
The OUI Table page displays.

In the Telephony OUI(s) field, specify the VolP OUI prefix to be added in the format
AA:BB:CC.
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You can configure up to 32 OUIs.

8. In the Description field, enter the description for the OUI.
The maximum length of description is 32 characters.

9. Click the Add button.
The telephony OUI entry is added.

Delete one or more OUI prefixes from the OUI table

To delete one or more OUI prefixes from the OUI table:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Auto-VolIP > OUl-based > OUI Table.
The OUI Table page displays.

7. Select the check box next to each OUI prefix to be removed.
8. Click the Delete button.

The telephony OUI entries are removed.
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Display the Auto-VolP status
You can display the Auto-VolP status.

To view the Auto-VoIP status:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.

6. Select Switching > Auto-VoIP > Auto-VolP Status.

The Auto-VoIP Status page displays.
7. To refresh the page with the latest information about the switch, click the Refresh button.
The following table describes the nonconfigurable Auto-VolP status information on the page.

Table 26. Auto-VoIP status information

Field Description
Auto-VolP VLAN ID The Auto-VoIP VLAN ID.
Maximum Number of Voice The maximum number of voice channels supported.

Channels Supported

Number of Voice Channels The number of VoIP channels prioritized successfully.
Detected
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Contigure Spanning Tree Protocol

The Spanning Tree Protocol (STP) provides a tree topology for any arrangement of network
devices. STP also provides one path between end stations on a network, eliminating loops.
STP (also referred to as “classic” STP) provides a single path between end stations, avoiding
and eliminating loops. For information about configuring the global STP settings for the
switch, see Configure the STP settings and view the STP status on page 160.

The switch support the following spanning tree versions:

e CST. Common STP. For information on configuring CST, see Configure the CST settings

on page 163 and Configure the CST port settings on page 164.

e MSTP. Multiple Spanning Tree Protocol (MSTP, also referred to as MST) supports
multiple instances of spanning tree to efficiently channel VLAN traffic over different
interfaces. For information on configuring MSTP, see Manage the MST settings on
page 170 and Configure and view the port settings for an MST instance on page 173.

* RSTP. Rapid STP. Each instance of the spanning tree behaves in the manner specified in
IEEE 802.1w, Rapid Spanning Tree (RSTP), with slight modifications in the working but
not the end effect (chief among the effects is the rapid transitioning of the port to the
forwarding state). For information on viewing the RSTP state, see View the Rapid STP
information on page 168.

The difference between the RSTP and the traditional STP (IEEE 802.1D) is the ability to
configure and recognize full-duplex connectivity and ports that are connected to end
stations, resulting in rapid transitioning of the port to the forwarding state and the
suppression of Topology Change Notification. These features are represented by the
parameters pointtopoint and edgeport. MSTP is compatible with both RSTP and STP. It
behaves in a way that is appropriate for STP and RSTP bridges. An MSTP bridge can be
configured to behave entirely as an RSTP bridge or an STP bridge.

Note: For two bridges to be in the same region, the force version must be
802.1s and their configuration names, digest keys, and revision levels
must match. For additional information about regions and their effect
on network topology, refer to the IEEE 802.1Q standard.

Configure the STP settings and view the STP status
You can configure the STP settings and view the STP status on the switch.

To configure the STP settings and view the STP status:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.
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2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > STP > Basic > STP Configuration.

STP Global Settings
=Basic ~ ' Spanning Tree State ® Disable © Enable
STP Operation Mode STP@® RSTP @ MSTP
hcvanced ¥ Configuration Name BC-AS-11-21-8D-94
Configuration Revision Level 0 (0 to 65535)
Configuration Digest Key Oxac36177150283cd4b83821d8ab26deb2
Forward BPDU while STP Disabled ® Disable @ Enable

7. Configure the following global settings for the switch:
a. Spanning Tree State. Enable or disable the spanning tree operation on the switch.

By default, spanning tree operation is disabled.
b. STP Operation Mode. Specify the STP version for the switch.
The options are STP, RSTP, and MSTP. The default is RSTP.

c. Configuration Name. Specify a hame to identify the STP, RSTP, or MSTP
configuration.

The name can be up to 32 alphanumeric characters.

d. Configuration Revision Level. Specify an identifier to identify the STP, RSTP, or
MSTP configuration.

The values can be from 0 to 65535. The default value is 0.
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e. Forward BPDU while STP Disabled. Enable or disable the bridge protocol data unit

(BPDU) flood.

This setting specifies whether spanning tree BPDUs are forwarded while spanning
tree is disabled on the switch.

8. Click the Apply button.

Your settings are saved.

The following table describes the nonconfigurable STP Status fields displayed on the page.

Table 27. STP Configuration status

Field

Global Settings

Description

Configuration Digest Key

The identifier used to identify the configuration currently being used.

STP Status

Bridge Identifier

The bridge identifier for the CST. It is made up using the bridge priority and
the base MAC address of the bridge.

Time Since Topology Change

The time in day-hour-minute-second format since the topology of the CST
last changed.

Topology Change Count

The number of times that the topology changed for the CST.

Topology Change

The value of the topology change setting for the switch that indicates if a
topology change is in progress on any port assigned to the CST. The option
is True or False.

Designated Root

The bridge identifier of the root bridge. It consists of the bridge priority and
the base MAC address of the bridge.

Root Path Cost

The path cost to the designated root for the CST.

Root Port

The port to access the designated root for the CST.

Max Age (secs)

The maximum age timer controls the maximum length of time in seconds
that passes before a bridge port saves its configuration BPDU information.

Forward Delay (secs)

The derived value of the Root Port Bridge Forward Delay setting.

Hold Time (secs)

The minimum time in seconds between the transmission of configuration
BPDUSs.

CST Regional Root

The priority and base MAC address of the CST regional root.

CST Path Cost

The path cost to the CST tree regional root.
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Configure the CST settings
You can configure Common Spanning Tree (CST) and Internal Spanning Tree on the switch.

To configure CST settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > STP > Advanced > CST Configuration.

= Basic v

Bridge Priority 32768 (0 to 61440)
*Advanced *  Bridge Max Age (secs) 20 (6 to 40
* STP Configuration Bridge Hello Time (secs)
Bridge Forward Delay (secs)
« CST Port Configuration
« CST Port Status
«RSTP
* MST Configuration

«MST Port Configuration

« STP Statistics
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7. Specify the CST options:

« Bridge Priority. When switches or bridges are running STP, each is assigned a
priority. After exchanging BPDUSs, the switch with the lowest priority value becomes
the root bridge. Specify the bridge priority value for the Common and Internal
Spanning Tree (CST). The valid range is 0—-61440. The bridge priority is a multiple of
4096. If you specify a priority that is not a multiple of 4096, the priority is automatically
set to the next lowest priority that is a multiple of 4096. For example, if you set the
priority to any value between 0 and 4095, the switch automatically sets the value to 0.
The default is 32768.

« Bridge Max Age (secs). The bridge maximum age time for the Common and Internal
Spanning Tree (CST), which indicates the time in seconds a bridge must wait before
implementing a topological change. The valid range is 6—40, and the value must be
less than or equal to (2 * Bridge Forward Delay) — 1 and greater than or equal to 2 *
(Bridge Hello Time +1). The default is 20.

* Bridge Hello Time (secs). The bridge hello time for the Common and Internal
Spanning Tree (CST), which indicates the time in seconds a root bridge must wait
between configuration messages. The value is fixed at 2 seconds. The value must be
less than or equal to (Bridge Max Age / 2) — 1.

» Bridge Forward Delay (secs). The bridge forward delay time, which indicates the
time in seconds a bridge must remain in a listening and learning state before
forwarding packets. The value must be greater or equal to (Bridge Max Age / 2) + 1.
The time range is from 4 seconds to 30 seconds. The default is 15 seconds.

e Spanning Tree Maximum Hops. The maximum number of bridge hops the
information for a particular CST instance can travel before being discarded. The
range is from 6 to 40. The default is 20 hops.

8. Click the Apply button.
Your settings are saved.

Configure the CST port settings
You can configure Common Spanning Tree (CST) and Internal Spanning Tree on a specific

port on the switch.

A port can become diagnostically disabled (D-Disable) when DOT1S experiences a severe
error condition. The most common cause is when the DOT1S software experiences BPDU
flooding. The flooding criteria are such that DOT1S receives more than 15 BPDUs in a
3-second interval. The other causes for DOT1S D-Disable are extremely rare.

To configure CST port settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.

6. Select Switching > STP > Advanced > CST Port Configuration.

STP Port Configuration
= Basic ~ 1 LAG Al Go To Interface m
kit " 10| Interface  STP Status | Fast Link g:ral:l ding Ao Edge | Port State Path Cost Priority E)::tma] EedEat :‘5’" '.I'.’;"':’l
+STP Configuration
CST Configuration = . il k2
g1 Disable Disable Enable Enable Disabled 0 128 0 1281 2
g2 Disable Disable Enable Enable Disabled ] 128 0 1282 2
+CST Port Status g3 Disable Disable Enable Enable Disabled 0 128 0 128:3 | 2
+RSTP g4 Disable Disable Enable Enable Disabled 0 128 0 128:4 | 2
5 3 g5 Disable Disable Enable Enable Manual Forwarding 20000 128 20000 128:5 |2
*MST Configuration
g6 Disable Disable Enable Enable Disabled 0 128 0 1286 | 2
*MST Port Configuration gl Disable Disable  Enable Enable Disabled 0 128 0 1287 2
= STP Statistics g8 Disable Disable Enable Enable Disabled ] 128 0 1288 2
g9 Disable Disable Enable Enable Disabled 1] 128 0 12819 2
g10 Disable Disable Enable Enable Disabled 0 128 ] 128:10 2
gl Disable Disable Enable Enable Disabled 0 128 0 128:11 2
g12 Disable Disable Enable Enable Disabled ] 128 0 12812 2

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

 LAG. Only LAGs are displayed.
» All. Both physical interfaces and LAGs are displayed.
8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.
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From the STP Status menu, select the option to enable or disable the spanning tree
administrative mode that is associated with the port or port channel.

The possible values are Enable and Disable. The default is Enable.
From the Fast Link menu, select whether the specified port is an edge port within the CST.

The possible values are Enable, Disable, and Auto. The default value is Auto, which
specifies that the switch waits three seconds (with no BPDUSs received on the interface)
before placing the interface into the PortFast mode.

From the BPDU Forwarding menu, configure BPDU forwarding.

The possible values are Enable and Disable. The default value is Disable. When BPDU
forwarding is enabled, the switch forwards the BPDU traffic arriving on this port when
STP is disabled on this port.

From the Auto Edge menu, specify if the port is allowed to become an edge port if it does
not detect BPDUs for some time.

The option is Enable or Disable. The default value is Enable.

In the Path Cost field, set the path cost to a hew value for the specified port in the common
and internal spanning tree.

Specify a value in the range of 0 to 200000000. The default is 0. When the path cost is
set to 0, the value is updated with the external path cost from a received STP packet.

In the Priority field, specify the priority for a particular port within the CST.

The port priority is set in multiples of 16. For example if you attempt to set the priority to
any value between 0 and 15, it is set to 0. If you try to set it to any value between 16 and
(2*16 — 1), it is set to 16, and so on. The range is 0 to 240. The default is 128.

In the External Port Path Cost field, set the external path cost to a new value for the
specified port in the spanning tree.

The value range is 0 to 200000000. The default is O.
Click the Apply button.
Your settings are saved.

To refresh the page with the latest information about the switch, click the Refresh button.

The following table describes the nonconfigurable information on the page.

Table 28. CST port configuration

Field Description
Port State The forwarding state of this port. The default is Disabled.
Port ID The port identifier for the specified port within the CST. It is made up from

the port priority and the interface number of the port.

Hello Timer The value of the parameter for the CST. The default is 2 seconds.
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View the CST port status

You can display Common Spanning Tree (CST) and Internal Spanning Tree on a specific
port on the switch.

To view the CST port status:

1.

7.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select Switching > STP > Advanced > CST Port Status.

Interface  Port Role Designated Root Desgnated Cost  Designated Brdge Desgnaled Port  Topology Change Acknowledge  Edge Port  Point.lo-Point MAC  Port Forwarding State
b 3! ! ¥ 7 PHOgY T H 3

=CST Port Status

Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.
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e LAG. Only LAGs are displayed.
e All. Both physical interfaces and LAGs are displayed.

8. To refresh the page with the latest information about the switch, click the Refresh button.

The following table describes the CST port status information on the page.

Table 29. CST port status

Field Description
Interface The physical port or LAG that is associated with the CST.
Port Role Each MST bridge port that is enabled is assigned a port role for each span-

ning tree. The port role can be Root, Designated, Alternate, Backup, Master,
or Disabled.

Designated Root

The root bridge for the CST. It is made up using the bridge priority and the
base MAC address of the bridge.

Designated Cost

The path cost offered to the LAN by the designated port.

Designated Bridge

The identifier of the bridge with the designated port. It is made up using the
bridge priority and the base MAC address of the bridge.

Designated Port

The port identifier on the designated bridge that offers the lowest cost to the
LAN. It is made up from the port priority and the interface number of the port.

Topology Change Acknowledge

Identifies whether the topology change acknowledgement flag is set for the
next BPDU to be transmitted for the port. It is either True or False.

Edge port

Indicates whether the port is enabled as an edge port. It is either Enabled or
Disabled.

Point-to-Point MAC

The derived value of the point-to-point status.

CST Regional Root

The bridge identifier of the CST regional root. It is made up using the bridge
priority and the base MAC address of the bridge.

CST Path Cost

The path cost to the CST regional root.

Port Forwarding State

The forwarding state of the port.

View the Rapid STP information

You can view information about the status of the Rapid Spanning Tree (RSTP) port.

To view information about RSTP:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.

3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > STP > Advanced > RSTP.
The Rapid STP page displays.

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

e LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.

The following table describes the Rapid STP status information on the page.

Table 30. Rapid STP status information

Field Description
Interface The physical or port channel interfaces associated with VLANs associated with the CST.
Role Each MST bridge port that is enabled is assigned a port role for each spanning tree. The port

role can be Root, Designated, Alternate, Backup Master, or Disabled.

Mode Specifies the spanning tree operation mode. Different modes are STP, RSTP, and MSTP.
Fast Link Indicates whether the port is enabled as an edge port.
Status The forwarding state of this port.
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Manage the MST settings

You can configure Multiple Spanning Tree (MST) on the switch.

Configure an MST instance
To configure an MST instance:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > STP > Advanced > MST Configuration.

MST Configuration

Root Root

MST ID  Prority Vian Id Bridge Identifier Last TCN Topology Change Count Topology Change Designated Root Path Cost  Port

0 32768 1,4089 80:00:00:0D:70:16:58:12 2day 14 hr29 min 54 sec D False 80:00:00:0D:70:16:58:12 0 00:00

7. Configure the MST values:
e MST ID. Specify the ID of the MST to create. The valid values for this are 1 to 64. This

is visible only when the select option of the MST ID select box is selected. The switch
supports up to four instances.

e Priority. The bridge priority value for the MST. When switches or bridges are running
STP, each is assigned a priority. After exchanging BPDUs, the switch with the lowest
priority value becomes the root bridge. The bridge priority is a multiple of 4096. If you
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specify a priority that is not a multiple of 4096, the priority is automatically set to the
next lowest priority that is a multiple of 4096. For example, if you set the priority to any
value between 0 and 4095, the switch automatically sets the value to 0. The default is
32768. The valid range is 0-61440.

 VLAN ID The menu includes all VLANS that are configured on the switch. You can
select VLANSs that must be associated with the MST instance or clear VLANSs that are
already associated with the MST instance.

8. Click the Add button.

The MST is added.

The following table describes the nonconfigurable information on the page.

Table 31. MST configuration

Field

Bridge Identifier

Description

The bridge identifier for the selected MST instance. It is made up using the bridge
priority and the base MAC address of the bridge.

Last TCN

The time in the format day:hour:minute:second since the topology of the selected
MST instance last changed.

Topology Change Count

Number of times that the topology changed for the selected MST instance.

Topology Change

The value of the topology change settings for the switch, indicating if a topology
change is in progress on any port assigned to the selected MST instance. It is either
True or False.

Designated Root

The bridge identifier of the root bridge. It is made up from the bridge priority and the
base MAC address of the bridge

Root Path Cost

The path cost to the designated root for this MST instance.

Root Port

The port to access the designated root for this MST instance.

Modify an MST instance

To modify an MST instance:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > STP > Advanced > MST Configuration.
The MST Configuration page displays.

7. Select the check box next to the instance.
8. Update the values.
9. Click the Apply button.

Your settings are saved.

Delete an MST instance

To delete an MST instance:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > STP > Advanced > MST Configuration.
The MST Configuration page displays.

7. Select the check box for the instance.
8. Click the Delete button.

The MST instance is removed.

Configure and view the port settings for an MST instance
You can configure and display Multiple Spanning Tree (MST) settings on a specific port on

the switch.

A port can become diagnostically disabled (D-Disable) when DOTL1S experiences a severe
error condition. The most common cause is when the DOTL1S software experiences BPDU
flooding. The flooding criteria is such that DOT1S receives more than 15 BPDUs in a
3-second interval. The other causes for DOT1S D-Disable are extremely rare.

To configure MST port settings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.
The System Information page displays.

6. Select Switching > STP > Advanced > MST Port Configuration.

Note: If no MST instances are configured on the switch, the page displays a
“No MSTs Available” message.

7. From the Select MST menu, select the MST instance.

You can select only instances that you added to the switch (see Configure an MST
instance on page 170).

8. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

e« LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.

9. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.

10. Configure the MST values for the selected interfaces:

* Port Priority. The priority for a particular port within the selected MST instance. The
port priority is set in multiples of 16. If you specify a value that is not a multiple of 16,
the priority is set to the priority is automatically set to the next lowest priority that is a
multiple of 16. For example, if you set a value between 0 and 15, the priority is set to
0. If you specify a number between 16 and 31, the priority is set to 16. Specify a value
in the range of 0—240.

« Port Path Cost. Set the path cost to a new value for the specified port in the selected
MST instance. Specify a value in the range of 0—200000000.
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11. Click the Apply button.

Your settings are saved.

The following table describes the nonconfigurable information on the page.

Table 32. MST port status information

Field

Auto-calculated Port Path

Description

Displays whether the path cost is automatically calculated (Enabled) or not

Cost (Disabled). Path cost is calculated based on the link speed of the port if the
configured value for Port Path Cost is zero.
Port ID The port identifier for the specified port within the selected MST instance. It is

made up from the port priority and the interface number of the port.

Port Up Time Since Counters
Last Cleared

The time since the counters were last cleared, displayed in days, hours,
minutes, and seconds.

Port Mode

The Spanning Tree Protocol administrative mode associated with the port or
port channel. Possible values are Enable or Disable.

Port Forwarding State

The current STP state of a port. If enabled, the port state determines what

forwarding action is taken on traffic. The options are as follows:

« Disabled. STP is currently disabled on the port. The port forwards traffic
while learning MAC addresses.

« Discarding. The port is currently blocked. The port cannot forward traffic
nor can it learn MAC addresses.

* Manual Forwarding. STP is currently disabled on the port. The port
forwards traffic while learning MAC addresses.

e Learning. The port is currently in the learning mode. The port cannot
forward traffic. However, it can learn new MAC addresses.

e Forwarding. The port is currently in the forwarding mode. The port can
forward traffic and learn new MAC addresses.

Port Role

Each MST bridge port that is enabled is assigned a port role for each spanning
tree. The port role can be Root, Designated, Alternate, Backup, Master, or
Disabled.

Designated Root

The root bridge for the selected MST instance. It is made up using the bridge
priority and the base MAC address of the bridge.

Designated Cost

The cost of the port participating in the STP topology. Ports with a lower cost
are less likely to be blocked if STP detects loops.

Designated Bridge

The bridge identifier of the bridge with the designated port. It is made up using
the bridge priority and the base MAC address of the bridge.

Designated Port

The port identifier on the designated bridge that offers the lowest cost to the
LAN. It is made up from the port priority and the interface number of the port.
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View the STP statistics

You can view information about the number and type of bridge protocol data units (BPDUs)
transmitted and received on each port.

To view Spanning Tree statistics:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > STP > Advanced > STP Statistics.

STP Statistics

1 LAG All

Interface STP BPDUSs Received STP BPDUs Transmitted RSTP BPDUs Received RSTP BPDUs Transmitted MSTP BPDUs Recelved MSTP BPDUs Transmitted
g1 a a . =

g2

g3 0 0

g4
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7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

* LAG. Only LAGs are displayed.

« All. Both physical interfaces and LAGs are displayed.
8. To refresh the page with the latest information about the switch, click the Refresh button.
The following table describes the nonconfigurable information on the page.

Table 33. STP Statistics

Field Description

Interface The physical port or LAG on the switch.

STP BPDUs Received The number of STP BPDUSs received at the selected port.

STP BPDUs Transmitted The number of STP BPDUSs transmitted from the selected port.
RSTP BPDUs Received The number of RSTP BPDUs received at the selected port.
RSTP BPDUs Transmitted The number of RSTP BPDUs transmitted from the selected port.
MSTP BPDUs Received The number of MSTP BPDUSs received at the selected port.
MSTP BPDUs Transmitted The number of MSTP BPDUs transmitted from the selected port.

Contigure multicast

Multicast IP traffic is traffic that is destined to a host group. Host groups for IPv4 multicast are
identified by class D addresses, which range from 224.0.0.0 to 239.255.255.255.

View, search, or clear the MFDB table

The Multicast Forwarding Database (MFDB) holds the port membership information for all
active multicast forwarding address entries. The key for an entry consists of a VLAN ID and
MAC address pair. Entries can contain data for more than one protocol.

To view, search, or clear the MFDB table:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Multicast > MFDB > MFDB Table.

MFDE Table

Search MAC Address m

MAC Address VLAN ID Component Type Description Interfaces Forwarding Interfaces

7. Inthe Search by MAC Address field, enter a MAC address.

Enter six two-digit hexadecimal numbers separated by colons, for example
01:00:5€e:45:67:89.

8. Click the Go button.
If the address exists, the entry is displayed. An exact match is required.
The following describes the nonconfigurable information on the page.

Table 34. MFDB table information

Field Description

MAC Address The multicast MAC address for which you requested data.

VLAN ID The VLAN ID to which the multicast MAC address is related.

Type The type of the entry. Static entries are those that are configured by the end user.

Dynamic entries are added to the table as a result of a learning process or protocol.

Component The component that is responsible for this entry in the Multicast Forwarding Database.
The options are IGMP snooping, GMRP, Static Filtering, and MLD snooping.
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Table 34. MFDB table information (continued)

Field Description

Description The text description of this multicast table entry. The options are Management

Configured, Network Configured, and Network Assisted.

Forwarding Interfaces  The resultant forwarding list is derived from combining all the forwarding interfaces and

removing the interfaces that are listed as the static filtering interfaces.

View the MFDB statistics

To view the MFDB statistics:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select Switching > Multicast > MFDB > MFDB Statistics.
The MFDP Statistics page displays.

To refresh the page with the latest information about the switch, click the Refresh button.
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The following table describes the MFDB Statistics fields.

Table 35. MFDB Statistics information

Field Description

Max MFDB Table Entries The maximum number of entries that the Multicast Forwarding Database
table can hold (256 entries).

Most MFDB Entries Since Last The largest number of entries that were present in the Multicast Forwarding
Reset Database table since last reset. This value is also known as the MFDB
high-water mark.

Current Entries The current number of entries in the Multicast Forwarding Database table.

Manage IGMP snooping

Internet Group Management Protocol (IGMP) snooping is a feature that allows a switch to
forward IPv4 multicast traffic intelligently. Multicast IPv4 traffic is traffic that is destined to a
host group. Host groups are identified by class D IP addresses, which range from 224.0.0.0
to 239.255.255.255. Based on the IGMP query and report messages, the switch forwards
traffic only to the ports that request the multicast traffic. This prevents the switch from
broadcasting the traffic to all ports and possibly affecting network performance.

A traditional Ethernet network can be separated into different network segments to prevent
placing too many devices onto the same shared media. Bridges and switches connect these
segments. When a packet with a broadcast or multicast destination address is received, the
switch forwards a copy to each of the remaining network segments in accordance with the
IEEE MAC Bridge standard. Eventually, the packet is made accessible to all nodes
connected to the network.

This approach works well for broadcast packets that are intended to be detected or
processed by all connected nodes. For multicast packets, this approach could lead to a less
efficient use of the network bandwidth, particularly when the packets are intended for a small
number of nodes only. Packets are flooded into network segments where no node is
receptive to the packet. Although nodes rarely incur any processing overhead to filter packets
addressed to unrequested group addresses, the nodes cannot transmit new packets onto the
shared media while the multicast packets are being flooded. Such as waste of bandwidth is
even worse when the LAN segment is not shared, for example in full-duplex links.

Allowing switches to snoop IGMP packets can solve this problem. While the IGMP packets
are being forwarded throughout the network, the switch uses the information in the packets to
determine which segments must receive packets that are directed to the group address.
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Configure IGMP snooping

You can configure the parameters for IGMP snooping, which is used to build forwarding lists
for multicast traffic.

To configure IGMP snooping:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Multicast > IGMP Snooping > IGMP Snooping Configuration.

The following figure does not display all information on the page.

IGMP Snooping Configuration
IGMP Snooping Status ® Disable () Enable
Validate IGMP IP header Disable ® Enable
IGMP Statistics
Multicast Control Frame Count 0
Interfaces Enabled for IGMP Snooping
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7. Select the IGMP Snooping Status Enable or Disable radio button.

This selection specifies the administrative mode for IGMP snooping for the switch. The
default is Disable.

8. Select the Validate IGMP IP header Enable or Disable radio button.

When IGMP IP header validation is enabled, any IGMP IP header must include the
Router Alert, ToS, and TTL information. Otherwise, the IGMP packet is discarded. The
default value is Enable.

9. Click the Apply button.

Your settings are saved.
10. To refresh the page with the latest information about the switch, click the Refresh button.
The following table describes the nonconfigurable information on the page.

Table 36. IGMP Snooping Configuration information

Field Description

Multicast Control Frame Count The number of multicast control frames that are processed by the switch.
Interfaces Enabled for IGMP The interfaces that are enabled for IGMP snooping.

Snooping

VLAN IDs Enabled For IGMP The IDs of the VLANS that are enabled for IGMP snooping.

Snooping

VLAN IDs Enabled For IGMP The IDs of the VLANSs that are enabled for IGMP snooping querier.

Snooping Querier

Configure IGMP snooping for interfaces

To configure IGMP snooping for interfaces:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.
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By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping > IGMP Snooping Interface
Configuration.

m IGMP Snooping Interface Configuration
*MFDB v 1LAG Al Go To Interface | Go |
*|IGMP Snooping ~ Fast
) Max MRouter
+IGMP Snooping |_| | Interface Admin Mode Host Timeout Response Time | Timeout Leave
Configuration Mode
= IGMP Snooping Y ¥
g1 Disable 260 10 0 Disable
=IGMP Snooping Table ]| g2 Disable 260 10 0 Disable
- IGMP Snooping VLAN ]| g3 Disable 260 10 1] Disable
Configuration | g4 Disable 260 10 0 Disable
« Multicast Router ]| g5 Disable 260 10 0 Disable
Configuration ]| g6 Disable 260 10 0 Disable
« Multicast Router VLAN I o7 Disable 260 10 0 Disable
Configuration g Disable 260 10 0 Disable
«IGMP Snooping Querier ~ ] g9 Disable 260 10 1] Disable
g10 Disable 260 10 0 Disable
] gl Disable 260 10 0 Disable
gi2 Disable 260 10 0 Disable

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

« LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Admin Mode menu, select Disable or Enable.

This selection specifies the interface mode for the selected interface for IGMP snooping
for the switch. The default is Disable.
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10. In the Host Timeout field, specify the time that the switch must wait for a report for a
particular group on a particular interface before it deletes that interface from the group.

Enter a value between 1 and 3600 seconds. The default is 260 seconds.

11. In the Max Response Time field, specify the time that the switch must wait after sending a
guery on an interface because it did not receive a report for a particular group on that
interface.

Enter a value greater or equal to 1 and less than the group membership interval in
seconds. The default is 10 seconds. The configured value must be less than the group
membership interval.

12. In the MRouter Timeout field, specify the time that the switch must wait to receive a query
on an interface before removing it from the list of interfaces with multicast routers attached.

Enter a value between 0 and 3600 seconds. The default is O seconds. A value of zero
indicates an infinite time-out, that is, no expiration.

13. From the Fast Leave Mode menu, select whether fast leave mode is enabled.
The option are Enable and Disable. The default is Disable.
14. Click the Apply button.

Your settings are saved.

View, search, or clear the IGMP snooping table

You can view and clear all entries in the Multicast Forwarding Database that were created for
IGMP snooping.

To view, search, or clear the IGMP snooping table:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select Switching > Multicast > IGMP Snooping > IGMP Snooping Table.
The IGMP Snooping Table page displays.

In the Search By MAC Address field, specify the MAC address for which you want to view
the entry in the MFDB table.

Enter six two-digit hexadecimal numbers separated by colons, for example
01:00:5€:45:67:89.

Click the Go button.
If the address exists, the entry is displayed. An exact match is required.

The following table describes the nonconfigurable information on the page.

Table 37. IGMP Snooping Table information

Field Description

MAC Address The multicast MAC address for which the switch holds forwarding and/or filtering

information. The format is six two-digit hexadecimal numbers that are separated
by colons, for example, 01:00:5e:45:67:89.

VLAN ID The VLAN ID for which the switch holds forwarding and filtering information.

Type The type of the entry. Static entries are those that are configured by the end
user. Dynamic entries are added to the table as a result of a learning process or
protocol.

Description The text description of this multicast table entry. The options are Management

Configured, Network Configured, and Network Assisted.

Interface The interfaces that are designated for forwarding (Fwd) and filtering (FIt) for the

associated address.

Configure IGMP snooping for VLANs

To configure IGMP snooping settings for VLANS:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping > IGMP Snooping VLAN Configuration.

IGMP Snooping VLAN Configuration

A Fast Leave Maximum Response Report Suppression Query Interval
VLAN ID Admin Mode Mods Host Timeout Tenia MRouter Timeout Mode Query Mode (1 to 1800) secs

~ - v -

1 Disable Disable 260 10 0 Disable Disable 60
4088 Disable Disable 260 10 o Disable Disable 60

7. Select the check boxes for one or more VLANS.
If you select the check box for a single VLAN, the VLAN ID displays in the VLAN ID field.

8. Configure the IGMP snooping values for the selected VLAN or VLANS:

« Admin Mode. Enable or disable IGMP snooping for the specified VLAN ID. The
default is Disable.

« Fast Leave Mode. Enable or disable the IGMP snooping fast leave mode for the
specified VLAN ID. The default is Disable.

« Host Timeout. Set the value for group membership interval of IGMP snooping for the
specified VLAN ID. The range is from the value for the Maximum Response Time plus
1 to 3600 seconds. The default is 260 seconds.

* Maximum Response Time. Set the value for the maximum response time of IGMP
snooping for the specified VLAN ID. The range is from 1 to the Host Timeout value
minus 1. This value must be greater than group membership interval value. The
default is 10 seconds.

* MRouter Timeout. Set the value for multicast router expiry time of IGMP snooping for
the specified VLAN ID. The range is from 0 to 3600 seconds. The default is
0 seconds.
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* Report Suppression Mode. Enable or disable IGMP snooping report suppression
mode for the specified VLAN ID. IGMP snooping report suppression allows the
suppression of the IGMP reports sent by the multicast hosts by building a Layer 3
membership table. The results is that only the most essential reports are sent to the
IGMP routers so that the routers can continue to receive the multicast traffic. The
default is Disable.

* Querier Mode. Enable or disable the IGMP querier mode. The default is Disable.

e Query Interval. Set the IGMP query interval for the specified VLAN ID. The range is
from 1 to 1800 seconds. The default is 60 seconds.

9. Click the Apply button.

Your settings are saved.

Modify IGMP snooping settings for a VLAN

To modify IGMP snooping settings for a VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Multicast > IGMP Snooping > IGMP Snooping VLAN Configuration.
The IGMP Snooping VLAN Configuration page displays.
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7. Select the check box next to the VLAN ID.
8. Update the values.
9. Click the Apply button.

Your settings are saved.

Disable IGMP snooping on a VLAN

To disable IGMP snooping on a VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Switching > Multicast > IGMP Snooping > IGMP Snooping VLAN Configuration.
The IGMP Snooping VLAN Configuration page displays.

7. Select the check box next to the VLAN ID.
8. From the Admin Mode menu, select Disable.
9. Click the Apply button.

Your settings are saved.
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Configure one or more IGMP multicast router interfaces

You can configure an interface as the designated interface to which a multicast router is
connected. All IGMP packets snooped by the switch are forwarded to the multicast router
reachable from the interface. Configuring a multicast router interface is usually not required
because the switch automatically detects the multicast router and forwards IGMP packets
accordingly. This configuration is required only if you want to make sure that the multicast
router always receives IGMP packets from the switch in a complex network.

To configure one or more IGMP multicast router interfaces:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping > Multicast Router Configuration.
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Multic ast Router Configuration
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7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

e 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

* LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.
8. Select one or more interfaces by taking one of the following actions:

« To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Multicast Router menu, select Enable or Disable.
10. Click the Apply button.

Your settings are saved.

Configure an IGMP multicast router VLAN

You can configure an interface to forward only snooped IGMP packets from a specific VLAN
to the multicast router connected to the interface. This configuration is usually not required
because the switch automatically detects a multicast router and forwards the IGMP packets
accordingly. This configuration is required only in a complex network if you want to make sure
that the multicast router always receives IGMP packets from the switch.

To configure an IGMP multicast router VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping > Multicast Router VLAN
Configuration.

Multicast Router VLAN Cenfiguration

Interface gl ~

Multic ast Router VLAN Configuration

VLAN D Multicast Router

W

7. From the Interface menu, select the interface.

8. Inthe VLAN ID field, enter the VLAN ID.

9. From the Multicast Router menu, select Enable or Disable.
10. Click the Apply button.

Your settings are saved.

IGMP snooping querier overview

IGMP snooping requires that one central switch or router periodically queries all end-devices
on the network to announce their multicast memberships. This central device is the IGMP
guerier. The IGMP gquery responses, known as IGMP reports, keep the switch updated with
the current multicast group membership on a port-by-port basis. If the switch does not

Configure Switching 191 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

receive updated membership information in a timely fashion, it stops forwarding multicasts to
the port where the end device is located.

You can configure and display information about IGMP snooping queriers on the network
and, separately, on VLANS.

Configure an IGMP snooping querier
You can configure the settings for an IGMP snooping querier.

To configure the settings for an IGMP snooping querier:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping Querier > Querier Configuration.
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Querier Cenfiguration
Querier Admin Mode ® Disable () Enable
Snooping Querier Address 0.0.0.0
IGMP Version 2 {1 to 2)
Query Interval(secs) 60 {1 to 1800)
CQuerier Expiry Interval(secs) 125 (60 to 300)

7. Configure the following settings:

e Querier Admin Mode. Enable or disable IGMP snooping for the switch. The default
is Disable.

e Snooping Querier IP Address. Enter the snooping querier IP address to be used as
the source address in periodic IGMP queries. This address is used when no address
is configured on the VLAN on which a query is being sent.

* IGMP Version. Specify the IGMP protocol version used in periodic IGMP queries.
The range is 1 to 2. The default value is 2.

* Query Interval (secs). Specify the time interval in seconds between periodic queries
sent by the snooping querier. The query interval must be in the range from 1 to 1800.
The default value is 60 seconds.

» Querier Expiry Interval (secs). Specify the time interval in seconds after which the
last querier information is removed. The querier expiry interval must be in the range
from 60 to 300. The default value is 125 seconds.

8. Click the Apply button.

Your settings are saved.

Configure an IGMP snooping querier for a VLAN
You can configure IGMP queriers for use with VLANSs on the network.

To configure IGMP snooping for a VLAN:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping Querier > Querier VLAN Configuration.

Querier VLAN Coenfiguration

VLAN 1D New Entry
VLAN 1D (1 to 4093}
Querier Election Participate Mode Disable ~

Snooping Querier VLAN Address

7. From the VLAN ID menu, select New Entry.
8. Configure the following settings:

«  VLAN ID. The VLAN ID for which the IGMP snooping querier must be enabled. You
can select an existing VLAN only.

* Querier Election Participate Mode. Enable or disable the querier mode:

- Disable. Upon seeing another querier of the same version in the VLAN, the
shooping querier moves to the non-querier state.

- Enable. The snooping querier participates in querier election, in which the lowest
IP address operates as the querier in that VLAN. The other querier moves to
non-querier state.

e Snooping Querier VLAN Address. Specify the snooping querier IP address to be
used as the source address in periodic IGMP queries that are sent to the VLAN.

9. Click the Apply button.

Your settings are saved.
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Display the status of the IGMP snooping querier for VLANs

To display the status of the IGMP snooping querier VLANS:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Multicast > IGMP Snooping Querier > Querier VLAN Status.

Querier VLAN Status

: : : Last Last Operational Max
\ (a3 \
KESRAEHISportan Sie [Clestionativr s Querier Address Querier Version Response Time{sec)

7. To refresh the page with the latest information about the switch, click the Refresh button.
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The following table describes the nonconfigurable information on the page.

Table 38. Querier VLAN Status information

Field Description

VLAN ID The VLAN ID on which IGMP snooping querier is administratively enabled and the
VLAN exists in the VLAN database.

Operational State The operational state of the IGMP snooping querier on a VLAN. It can be in any of
the following states:

e Querier. The snooping switch is the querier in the VLAN. The snooping switch
sends out periodic queries with a time interval equal to the configured querier
query interval. If the snooping switch finds a better querier in the VLAN, it
moves to non-querier mode.

¢ Non-Querier. The snooping switch is in non-querier mode in the VLAN. If the
querier expiry interval timer expires, the snooping switch moves into querier
mode.

« Disabled. The snooping querier is not operational on the VLAN. The snooping
querier moves to disabled mode when IGMP snooping is not operational on
the VLAN or when the querier address is not configured or the network
management address is also not configured.

Operational Version The operational IGMP protocol version of the querier.

Last Querier Address The IP address of the last querier from which a query was snooped on the VLAN.

Last Querier Version The IGMP protocol version of the last querier from which a query was snooped on
the VLAN.

Operational Max Response The maximum response time to be used in the queries that are sent by the
Time snooping querier.

View, search, and manage the MAC
address table

You can view or configure the MAC address table. This table contains information about
unicast entries for which the switch holds forwarding or filtering information. This information
lets the transparent bridging function determine how an incoming frame must be propagated.

If you clear the MAC address entries in the MAC address table, only the dynamic entries are
removed.

View, search, or clear the MAC address table

To view, search, or clear the MAC address table:

1. Connect your computer to the same network as the switch.
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You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Address Table > Basic > Address Table.

Address Table MAC Address Table

« Basic ~

+ Address Table

. Search VLAN ID v m
\dvanced v

v 1-20 of 99 ~

Total MAC Addresses 99

VLAN ID MAC Address Interface Status
0 gt Leamed

Learmed

1
1
1
1
1
1

1 g1 Leamed

1 gl Leamed

7. Use the Search menu and field to search for a MAC address, VLAN ID, or interface
number:
»  MAC Address. From the Search menu, select MAC Address, and enter the 6-byte
hexadecimal MAC address in two-digit groups separated by colons, for example,
01:23:45:67:89:AB. Then click the Go button.

If the address exists, that entry is displayed as the first entry followed by the
remaining (higher) MAC addresses. An exact match is required.
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« VLANID. From the Search menu, select VLAN ID, and enter the VLAN ID, for
example, 100. Then click the Go button.

« Interface. From the Search menu, select Interface, and enter the interface ID using
the respective interface naming convention (for example, g1 or I11). Then click the Go
button.

8. To refresh the page with the latest information about the switch, click the Refresh button.
9. To clear all dynamic MAC address entries in the table, click the Clear button.

The following table describes the nonconfigurable information on the page.

Table 39. MAC address table information

Field Description

Total MAC Address The number of MAC addresses learned or configured.

VLAN ID The VLAN ID associated with the MAC address.

MAC Address The unicast MAC address for which the switch holds forwarding and/or filtering
information. The format is a 6-byte MAC address that is separated by colons, for
example 01:23:45:67:89:AB.

Interface The interface upon which this address was learned.

Status The status of this entry. The meanings of the values are as follows:

» Static. The value of the corresponding instance was added by the system or a user
and cannot be relearned.

» Learned. The value of the corresponding instance was learned, and is being used.

« Management. The value of the corresponding instance is also the value of an
existing instance of dotldStaticAddress.

Set the dynamic address aging interval

You can set the address aging interval for the forwarding database. This is the time-out
period in seconds for aging out dynamically learned forwarding information.

To set the address aging interval:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Address Table > Advanced > Dynamic Addresses.

Dynamic Address Table

Address Aging Timeout (seconds) 200 (10 to 1000000)

7. Inthe Address Aging Timeout (seconds) field, specify the time-out period in seconds for
aging out dynamically learned forwarding information.

The value can be any number between 10 and 1000000 seconds. The default is 300
seconds.

8. Click the Apply button.

Your settings are saved.

Add a static MAC address to the MAC address table

To add a static MAC address to the MAC address table:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > Address Table > Advanced > Static MAC Address.

7. From the Interface menu, select the interface.
8. In the Static MAC Address field, enter the MAC address.

9. From the VLAN ID menu, select the VLAN ID that must be associated with the MAC
address.

10. Click the Add button.
The static MAC address is added to the switch.

Contigure Layer 2 loop protection

Loops inside a network are costly because they consume resources and reduce the
performance of the network. Detecting loops manually can be cumbersome.

The switch can automatically identify loops in the network. You can enable loop protection
per port or globally.

If loop protection is enabled, the switch sends predefined PDU packets to a Layer 2
broadcast destination address (FF:FF:FF:FF:FF:FF) on all ports for which the feature is
enabled. You can selectively disable PDU packet transmission for loop protection on specific
ports even while port loop protection is enabled. If the switch receives a packet with the
previously mentioned broadcast destination address, the source MAC address in the packet
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is compared with the MAC address of the switch. If the MAC address does not match, the
packet is forwarded to all ports that are members of the same VLAN, just like any other
broadcast packet. The packet is not forwarded to the port from which it was received.

If the source MAC address matches the MAC address of the switch, the switch can perform
one of the following actions, depending on how you configure the action:

e The port is shut down.

» Alog message is generated. (If a syslog server is configured, the log message can be
sent to the syslog server.)

» The port is shut down and a log message is generated.

Loop protection is not intended for ports that serve as uplinks between spanning tree—aware
switches. It is intended for unmanaged switches that drop spanning tree BPDUSs. Loop
protection detects physical and logical loops between Ethernet ports on a device. You must
enable loop protection globally before you can enable and configure it at the interface level.
Loop protection is supported on physical interfaces and static LAG interfaces, but not on
dynamic LAG interfaces.

Configure global Layer 2 loop protection

To configure L2 loop protection globally:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

Configure Switching 201 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

The System Information page displays.

6. Select Switching > L2 Loop Protection > L2 Loop Protection Configuration.

L2 Loop Protection Global L2 Loop Protection Configuration

=2 Loop Protection
Configuration

Admin Mode @) Disable () Enable

Transmit Interval S v

Max PDU Receive 1 v

h
@
<

Disable Timer 0 (0 to 60

7. To enable or disable loop protection feature, select the Admin Mode Enable or Disable
radio button.

By default, the Disable radio button is selected.

8. From the Transmit Interval menu, select the time in seconds between transmission of loop
packets.

The default transmit interval is 5 seconds.

9. From the Max PDU Receive menu, select the maximum number of packets to be received
before an action is taken.

The default is 1.

10. In the Disable Timer field, enter the time in seconds after which a port is disabled when a
loop is detected.

The range is from 0 to 604800 seconds. The default is 0 seconds.
11. Click the Apply button.

Your settings are saved.

View and configure Layer 2 loop protection on a port

To view and configure L2 loop protection on a port:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Switching > L2 Loop Protection > L2 Loop Protection Configuration.

1 LAG All Go To Interface m

[] Port KeepAlive Loop Detected Loop Count Time Since LastLoop RX Action Port Status

[J g1 Disable No 0 Enable

[J g2 Disable No 0 Enab
Disable No 0 Enable
Disable No 0 Enable
Disable No 0 Enable

O g Disable No 0 Enable

[J g7 Disable No 0 Enable

[0 g8 Disable No 0 Enable

[0 g9 Disable No 0 Enable

[J g10 Disable No 0 Enable

[ g11 Disable No Enable

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

« LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Keep Alive menu, select Enable or Disable to specify whether keep-alives are
enabled on an interface.

The default is Disable.
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10. From the RX Action menu, select the action that occurs when the switch detects a loop on
an interface:

e Log. The switch logs a message.
» Disable. The switch disables the interface. This is the default action.
* Both. The switch both logs a message and disables the interface.

11. Click the Apply button.
Your settings are saved.

12. Click the Clear button to clear all the statistics in the table.
13. Click the Refresh button to update the page to show the latest information.

The following table describes the nonconfigurable information displayed on the page.
Table 40. L2 Loop Protection Interface Information

Field Description

Loop Detected Shows whether a loop is detected on the interface. If the interface is disabled and then
reenabled, the status changes to No again.

Loop Count The number of packets that were received after the loop was detected.

Time Since Last Loop  The time that elapsed since the loop was detected.

Port Status The status of the interface (Enabled, Disabled, or D-Disabled, which stands for
diagnostically disabled).
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This chapter contains the following sections:

* Quality of Service concepts

» Manage Class of Service

* Manage Differentiated Services
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Quality of Service concepts

In a switch, each physical port consists of one or more queues for transmitting packets on the
attached network. Multiple queues per port are often provided to give preference to certain
packets over others based on user-defined criteria. When a packet is queued for
transmission in a port, the rate at which it is serviced depends on how the queue is
configured and possibly the amount of traffic present in the other queues of the port. If a
delay is necessary, packets are held in the queue until the scheduler authorizes the queue for
transmission. As queues become full, packets can no longer be held for transmission and are
dropped by the switch.

Quality of Service (QoS) is a means of providing consistent, predictable data delivery by
distinguishing packets with strict timing requirements from those that are more tolerant of
delay. Packets with strict timing requirements are given special treatment in a QoS-capable
network. With this in mind, all elements of the network must be QoS capable. The presence
of at least one node that is not QoS capable creates a deficiency in the network path, and the
performance of the entire packet flow is compromised.

Manage Class of Service

The Class of Service (CoS) queueing feature lets you directly configure certain aspects of
switch queueing. This provides the desired QoS behavior for different types of network traffic
when the complexities of DiffServ are not required. The priority of a packet arriving at an
interface can be used to steer the packet to the appropriate outbound CoS queue through a
mapping table. CoS queue characteristics that affect queue mapping, such as minimum
guaranteed bandwidth or transmission rate shaping, are user configurable at the queue (or
port) level.

Eight queues per port are supported.

CoS configuration concepts

You can set the Class of Service trust mode for an interface. Each port in the switch can be
configured to trust one of the packet fields (802.1p or IP DSCP), or to not trust any packet’s
priority designation (untrusted mode). If the port is set to a trusted mode, it uses a mapping
table appropriate for the trusted field being used. This mapping table indicates the CoS
gqueue to which the packet must be forwarded on the appropriate egress port. Of course, the
trusted field must exist in the packet for the mapping table to be of any use. If this is not the
case, default actions are performed. These actions involve directing the packet to a specific
CoS level configured for the ingress port as a whole, based on the existing port default
priority as mapped to a traffic class by the current 802.1p mapping table.

Alternatively, when a port is configured as untrusted, it does not trust any incoming packet
priority designation and uses the port default priority value instead. All packets arriving at the
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ingress of an untrusted port are directed to a specific CoS queue on the appropriate egress
ports, in accordance with the configured default priority of the ingress port. This process is
also used for cases where a trusted port mapping cannot be honored, such as when a non-IP
packet arrives at a port configured to trust the IP DSCP value.

Configure the global CoS settings
A global configuration setting is automatically applied to all interfaces on the switch.

To configure the CoS trust mode settings on all interfaces:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > CoS > Basic > CoS Configuration.

DiffServ
CoS CoS Configuration
* Basic “~ @ Global Global Trust Mode 802.1p v
- CoS Configuration Interface Interface Trust Mode
* Advanced v
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7. Either configure the same CoS trust mode settings for all CoS-configurable interfaces or
configure CoS settings per interface:

» To configure the same CoS trust mode settings for all CoS configurable interfaces, do
the following:

a. Select the Global radio button.

b. From the Global Trust Mode menu, select one of the following trust mode
options for ingress traffic on the switch:

- Untrusted. Do not trust any CoS packet marking at ingress.

- 802.1p. The eight priority tags that are specified in IEEE 802.1p are p0 to p7.
The QoS setting lets you map each of the eight priority levels to one of seven
internal hardware priority queues. The default mode is 802.1p.

- DSCP. The six most significant bits of the DiffServ field are called the
Differentiated Services Code Point (DSCP) bits.

» To configure CoS settings per interface, do the following:
a. Select the Interface radio button.

b. From the Interface Trust Mode menu, select one of the following trust mode
options:

- Untrusted. Do not trust any CoS packet marking at ingress.

- 802.1p. The eight priority tags that are specified in IEEE 802.1p are p0 to p7.
The QoS setting lets you map each of the eight priority levels to one of seven
internal hardware priority queues. The default mode is 802.1p.

- DSCP. The six most significant bits of the DiffServ field are called the
Differentiated Services Code Point (DSCP) bits.

8. Click the Apply button.

Your settings are saved.

Configure the CoS settings for an interface

You can configure the trust mode for one or more interfaces and apply an interface shaping
rate to all interfaces or to a specific interface.

To configure CoS settings for an interface:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > CoS > Advanced > CoS Interface Configuration.

CoS Interface Configuration

1 LAG All Go To Interface m
Interface | Interface Trust Mode | Interface Shaping Rate Interface Ingress Rate Limit
g1 802.1p 0 0
g2 802.1p 0 0
g3 802.1p 0 0
g4 802.1p 0 0
g5 802.1p 0 0

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

e LAG. Only LAGs are displayed.
» All. Both physical interfaces and LAGs are displayed.
8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Interface Trust Mode menu, select one of the following trust mode options for
ingress traffic on the selected interfaces:

e Untrusted. Do not trust any CoS packet marking at ingress.
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e 802.1p. The eight priority tags that are specified in IEEE 802.1p are p0 to p7. The
QoS setting lets you map each of the eight priority levels to one of seven internal
hardware priority queues. The default is 802.1p.

» DSCP. The six most significant bits of the DiffServ field are called the Differentiated
Services Code Point (DSCP) bits.

10. In the Interface Shaping Rate field, specify the maximum outbound transmission rate
bandwidth in kbps.

This setting is used to shape the outbound transmission rate in increments of 1 percent in
a range of 0—100. This value is controlled independently of any per-queue maximum
bandwidth configuration. It is effectively a second-level shaping mechanism. The default
value is 0. The value 0 means that the maximum is unlimited.

The expected shaping at egress interface is calculated as follows:

frameSize x shaping/(frameSize + IFG), where IFG (Inter frame gap) is 20 bytes,
frameSize is configured frame size, and shaping is configured traffic shaping.

For example, if 64 bytes frame size and 64 kbps shaping are configured, the expected
shaping is approximately 48 kbps.

11. In the Interface Ingress Rate Limit field, specify the maximum inbound transmission rate
bandwidth in kbps.

This setting is used to shape the inbound transmission rate in increments of 1 percent in
a range of 0-100. The interface discards traffic that arrives at a bandwidth in excess of
the specified limit.

12. Click the Apply button.

Your settings are saved.

Configure the CoS queue settings for an interface

You can define what a particular queue does by configuring switch egress queues. You can
control how much bandwidth is used by the queue, the queue depth during times of
congestion, and the scheduling of packet transmission from all queues on a port. Each port
contains its own CoS queue-related configuration.

For information about configuring CoS queue settings globally, see Configure the global
CoS settings on page 207.

To configure the CoS queue settings for an interface:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
The System Information page displays.

6. Select QoS > CoS > Advanced > Interface Queue Configuration.

Interface Queue Configuration
1 LAG All Go To Interface [ Go |
I Interface %ueue Scheduler Type Queue Management Type
0~ v

gl 0 Weighted TailDrop

g2 0 Weighted TailDrop

g3 0 Weighted TailDrop

g4 0 Weighted TailDrop

gb 0 Weighted TailDrop

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

« LAG. Only LAGs are displayed.

e All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.
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9. From the Queue ID menu, select the queue to be configured.
You can select a queue from 0 to 7.
10. From the Scheduler Type menu, select one of the following options:
e Strict. The interface services traffic with the highest priority on a queue first.

* Weighted. The interface uses weighted round robin to associate a weight to each
queue. This is the default setting.

11. Click the Apply button.
Your settings are saved.

The Queue Management Type field displays the queue depth management technique
that is used for queues on the interface. By default, this method is Taildrop, irrespective of
your selection from the Scheduler Type menu.

Map 802.1p priorities to queues

You can view or change which internal traffic classes are mapped to the 802.1p priority class
values in Ethernet frames that the device receives. The priority-to-traffic class mappings can
be applied globally or per interface. The mapping allows the switch to group various traffic
types (for example, data or voice) based on their latency requirements and give preference to
time-sensitive traffic.

To map 802.1p priorities to queues:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

Configure Quality of Service 212 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > CoS > Advanced > 802.1p to Queue Mapping.

802.1p to Queue Mapping

802.1p Prionty 0 1 2 3 4 5 6 [

Queue 1T~ ~[[|@~]l|1~]|[]2~]|2~]|]I3~]|3~

7. In the 802.1p to Queue Mapping table, map each of the eight 802.1p priorities to a queue
(internal traffic class) from O to 7.

The 802.1p Priority row contains traffic class selectors for each of the eight 802.1p
priorities to be mapped. The priority goes from low (0) to high (7). For example, traffic with
a priority of 0 is for most data traffic and is sent using best effort. Traffic with a higher
priority, such as 7, might be time-sensitive traffic, such as voice or video.

The values in the menu under each priority represent the traffic class. The traffic class is
the hardware queue for a port. Higher traffic class values indicate a higher queue
position. Before traffic in a lower queue is sent, it must wait for traffic in higher queues to
be sent.

8. Click the Apply button.

Your settings are saved.

Map DSCP values to queues
You can map an internal traffic class to a DSCP value.

To map DSCP values to queues:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > CoS > Advanced > DSCP to Queue Mapping.

Class Selector (CS) PHB

* Basic ¥ DScP Queue DSCP Queue DSCP Queue DSCP Queus
*Advanced ~ CS 0 (000000) 1 w CS 2 (010000) 0 ~| CS 4(100000) 2 ~| CS6(110000) 3 v
»CoS Configuration CS 1(001000) |0 ~| CS3(011000) | |1 ~| CS5(101000) |2 ~| CS7(111000) |3 ~

=CoS Interface
Configuration

= Interface Queue Assured Forwarding (AF) PHB

Configuration

«802.1p to Queue DSCP Queve DSCP Queve DSCP Queve DSCP Queue

Mapping AF 11(001010) |0 ~ AF21(010010) |0 ~| AF31(011010) |1 ~| AF 41(100010) |2 ~

lnsantgoQueua AF 12(001100) |0 ~| AF22(010100) |0 ~| AF32(011100) |1 ~| AF42(100100) |2 ~
AF 13(001110) |0 ~| AF23(010110) |0 ~| AF33(011110) |41 ~| AF43(100110) |2 ~

7. For each DSCP value, select from the corresponding Queue menu which internal traffic
class must be mapped to the DSCP value.

The traffic class is the hardware queue for a port. Higher traffic class values indicate a
higher queue position. Before traffic in a lower queue is sent, it must wait for traffic in
higher queues to be sent.

The allowed Per Hop Behavior (PHBSs) values, besides other DSCP experimental values,
are as follows:

* Class Selector (CS) PHB. These values are based on IP precedence.

* Assured Forwarding (AF) PHB. These values define four main levels to sort and
manipulate some flows within the network.

* Expedited Forwarding (EF) PHB. These values are used to prioritize traffic for
real-time applications. In many situations, if the network exceeded traffic and you
need some bandwidth guaranteed for an application, the EF traffic must receive this
rate independently of the intensity of any other traffic attempting to transit the node.

The Other DSCP Values (Local/Experimental Use) section allows you to set non-default
values for advanced settings.
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8. Click the Apply button.

Your settings are saved.

Manage Differentiated Services

The QoS feature contains Differentiated Services (DiffServ) support that allows traffic to be
classified into streams and given certain QoS treatment in accordance with defined per-hop
behaviors.

Standard IP-based networks provide best-effort data delivery service. Best-effort service
implies that the network delivers the data in a timely fashion, although there is no guarantee.
If congestion occurs, packets might be delayed, sent sporadically, or dropped. For typical
Internet applications, such as email and file transfers, a slight degradation in service is
acceptable and in many cases unnoticeable. However, any degradation of service can
negatively affect applications with strict timing requirements, such as voice and multimedia.

Defining DiffServ

To use DiffServ for QoS, you must first define the following categories and their criteria:

1. Class. Create classes and define class criteria.
2. Policy. Create policies, associate classes with policies, and define policy statements.
3. Service. Add a policy to an inbound interface.

Packets are classified and processed based on defined criteria. The classification criteria are
defined by a class. The processing is defined by a policy’s attributes. Policy attributes can be
defined on a per-class instance basis, and it is these attributes that are applied when a match
occurs. A policy can contain multiples classes. When the policy is active, the actions taken
depend on which class matches the packet.

Note the following about the DiffServ process:

« Packets are filtered and processed based on defined criteria. The filtering criteria is
defined by a class. The processing is defined by a policy's attributes. Policy attributes can
be defined on a per-class instance basis, and it is these attributes that are applied when a
match occurs.

» The configuration process begins with defining one or more match criteria for a class.
Then one or more classes are added to a policy. Policies are then added to interfaces.

» Packet processing begins by testing the match criteria for a packet. The All class type
option specifies that each match criteria within a class must evaluate to true for a packet
to match that class. The Any class type option specifies that at least one match criteria
must evaluate to true for a packet to match that class. Classes are tested in the order in
which they were added to the policy. A policy is applied to a packet when a class match
within that policy is found.
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Configure the DiffServ mode and display the entries in the
DiffServ private MIB tables

You can enable or disable DiffServ and display the current and maximum number of rows in
each of the main DiffServ private MIB tables.

To configure the DiffServ mode and display the entries in the DiffServ private MIB

tables:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Basic > DiffServ Configuration.
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m DiffServ Configuration
* Basic “~ DiffServ Admin Mode ® Disable ) Enable
= DiffServ Configuration
= Advanced v
Status
MIB Table Current Size  Max Size
Class table 0 32
Class Rule table 0 32
Policy table 0 24
Policy Instance table 0 24
Policy Attributes table 0 24
Service table 0 34

7. Select the administrative mode for DiffServ:

» Enable. Differentiated services are active. This is the default setting.

» Disable. The DiffServ configuration is retained and can be changed but is not active.
8. Click the Apply button.

Your settings are saved.
The following table describes the information displayed in the Status table on the page.

Table 41. DiffServ Status information

Field Description

Class Table The number of configured DiffServ classes out of the total allowed on the switch.
Class Rule table The number of configured class rules out of the total allowed on the switch.
Policy table The number of configured policies out of the total allowed on the switch.

Policy Instance Table  The number of configured policy class instances out of the total allowed on the switch.

Policy Attributes Table  The number of configured policy attributes (attached to the policy class instances) out
of the total allowed on the switch.

Service Table The number of configured services (attached to the policies on specified interfaces)
out of the total allowed on the switch.

Configure a DiffServ class

You can add a new DiffServ class name or rename or delete an existing class. You can also
define the criteria to associate with a DiffServ class. As packets are received, these DiffServ
classes are used to prioritize packets. You can set up multiple match criteria in a class. The
logic is a Boolean logical AND for this criteria. After creating a class, click the class link to the
Class page.
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Add and configure a DiffServ class

To add and configure a DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Class Configuration.
The Class Name page displays.

7. Inthe Class Name field, enter a class name.

The Class Name field also lists all existing DiffServ class names, from which you can
select one for modification or deletion. The class hame can be 1 to 31 alphanumeric
characters in length.

The switch supports only the class type value All, which means that all the various match
criteria defined for the class are satisfied for a packet match. All signifies the logical AND
statement of all the match criteria. For any class that you add, the class type is All.

8. Click the Add button.
The new class is added.
9. After creating the class, click the class name.

The class name is a hyperlink to the page on which you can define the class
configuration.
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Class Information

Class Name

Class Type

DiffServ Class Configuration

® Match Every Any v
Reference Class

Class Of Service

VLAN {1 to 4093)

Ethemet Type v {600 fo ifff hex)
Source MAC Address Mask

Destination MAC Address Mask

Protocol Type - (0 to 255)
Source IP Address Mask

Source L4 Port v (0 to 65533)
Destination IP Address Mask

Destination L4 Port W (0 to 65535)
IP DSCP w (0 to 63)
Precedence Value v (0loT)

IP ToS Bit Value Bit Mask

10. Define the criteria that must be associated the DiffServ class by selecting one of the
following radio buttons:
e Match Every. Select this radio button to add a match condition that considers all
packets to belong to the class. The only selection from the Match Every menu is Any.

» Reference Class. Select this radio button to reference another class for criteria. The
match criteria defined in the reference class function as match criteria in addition to
the match criteria that you define for the selected class. After you select the radio
button, the classes that can be referenced are displayed. Select the class to
reference. A class can reference only one other class of the same type.

» Class of Service. Select this radio button to require the Class of Service (CoS) value
in an Ethernet frame header to match the specified CoS value. This option lists all the
values for the Class of Service match criterion in the range 0 to 7 from which you can
select one.

* VLAN. Select this radio button to require a packet’'s VLAN ID to match a VLAN ID.
The VLAN value is in the range from 1 to 4093.
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« Ethernet Type. Select this radio button to require the EtherType value in the Ethernet
frame header to match the specified EtherType value. After you select the radio
button, select the EtherType keyword from the menu of common protocols that are
mapped to their Ethertype value. You can also select User Value from the menu and
enter a value in the hexadecimal range from 600 to ffff.

e Source MAC. Select this radio button to require a packet’'s source MAC address to
match the specified MAC address. After you select this radio button, use the following
fields to configure the source MAC address match criteria:

- Address. The source MAC address to match. The source MAC address is
specified as six two-digit hexadecimal numbers separated by colons.

- Mask. The MAC mask, which specifies the bits in the source MAC address to
compare against the Ethernet frame. Use Fs and zeros to configure the MAC
mask. An F means that the bit is checked, and a zero in a bit position means that
the data is not significant. For example, if the MAC address is aa:bb:cc:dd:ee:ff,
and the mask is ff:ff:00:00:00:00, all MAC addresses with aa:bb:xx:xx:xx:xx result
in a match (where x is any hexadecimal number). Note that this is not a wildcard
mask, which ACLs use.

« Destination MAC. Select this radio button to require a packet’s destination MAC
address to match the specified MAC address. After you select the radio button, use
the following fields to configure the destination MAC address match criteria:

- Address. The destination MAC address to match. The destination MAC address
is specified as six two-digit hexadecimal numbers separated by colons.

- Mask. The MAC mask, which specifies the bits in the destination MAC address to
compare against an Ethernet frame. Use Fs and zeros to configure the MAC
mask. An F means that the bit is checked, and a zero in a bit position means that
the data is not significant. For example, if the MAC address is aa:bb:cc:dd:ee:ff,
and the mask is ff:ff:00:00:00:00, all MAC addresses with aa:bb:xx:xx:xx:xx result
in a match (where x is any hexadecimal number). Note that this is not a wildcard
mask, which ACLs use.

* Protocol Type. Select this radio button to require a packet's Layer 4 protocol to match
the specified protocol, which you must select from the menu. You can also select
Other from the menu and enter a protocol number from 0 to 255.

e Source IP. Select this radio button to require a packet’s source IP address to match
the specified IP address. After you select the radio button, use the following fields to
configure the source IP address match criteria:

- Address. The source IP address format to match in dotted-decimal.

- Mask. The bit mask in IP dotted-decimal format indicating which parts of the
source IP address to use for matching against packet content.

e Source L4 Port. Select this radio button to require a packet’'s TCP/UDP source port to
match the specified protocol, which you must select from the menu. You can also
select Other from the menu and enter a port number from 0 to 65535.

« Destination IP. Select this radio button to require a packet’s destination IP address to
match the specified IP address.
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After you select the radio button, use the following fields to configure the destination
IP address match criteria:

- Address. The destination IP address format to match in dotted-decimal.

- Mask. The bit mask in IP dotted-decimal format indicating which parts of the
destination IP address to use for matching against packet content.

» Destination L4 Port. Select this radio button to require a packet's TCP/UDP
destination port to match the specified protocol. You can also select Other from the
menu and enter a port number from 0 to 65535.

« |P DSCP. Select this radio button to require the packet’s IP DiffServ Code Point
(DSCP) value to match the specified IP DSCP keyword code, which you must select
from the menu. You can also select Other from the menu and enter an IP DSCP
value from 0 to 63. The DSCP value is defined as the high-order 6 bits of the Service
Type octet in the IP header.

» Precedence Value. Select this radio button to require the packet’s IP precedence
value to match the specified number from 0 to 7, which you must select from the
menu. The IP Precedence field in a packet is defined as the high-order 3 bits of the
Service Type octet in the IP header.

* IP ToS. Select this radio button to require the packet’s Type of Service (ToS) bits in
the IP header to match the specified value. The IP ToS field in a packet is defined as
all 8 bits of the service type octet in the IP header. After you select the radio button,
use the following fields to configure the ToS match criteria:

- Bits Value. Enter a two-digit hexadecimal number octet value in the range from 00
to ff to match the bits in a packet’s ToS field.

- Bit Mask. Specify the bit positions that are used for comparison against the IP
ToS field in a packet.

11. Click the Apply button.
Your settings are saved.
The following table describes the nonconfigurable information on the page.

Table 42. DiffServ Class Configuration, Class Summary information

Field Description
Match Criteria The configured match criteria for the specified class.
Values The values of the configured match criteria.

Rename an existing DiffServ class
To rename an existing DiffServ class:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Class Configuration.
The Class Name page displays.

7. Select the check box next to the class name.
8. In the Class Name field, specify the new name.
9. Click the Apply button.

Your settings are saved.

Change the criteria for an existing DiffServ class

To change the criteria for an existing DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Class Configuration.
The Class Name page displays.
7. Click the class name, which is a hyperlink.
The page on which you can change the class configuration displays.

8. Change the class configuration as needed.
9. Click the Apply button.

Your settings are saved.

Delete a DiffServ class
To delete a DiffServ class:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

Configure Quality of Service 223 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Class Configuration.
The Class Name page displays.

7. Select the check box next to the class name.
8. Click the Delete button.

The class is removed.

Configure DiffServ IPvé6 class settings

The switch supports QoS ACL and DiffServ functionality for IPv6 by providing support for
IPv6 packet classification. An IPv6 ACL serves the same purpose as an IPv4 ACL.

An Ethernet IPv6 packet is distinguished from an IPv4 packet by its unique Ethertype value,
so all IPv6 classifiers include the Ethertype field, even though you cannot configure its value
on the switch.

The destination and source IPv6 addresses use a prefix length value instead of an individual
mask to qualify them as a subnet addresses or a host addresses. Packets that match an IPv6
classifier can be marked with the IP DSCP field in the traffic class octet.

You can also assign an IPv6 ACL with a DiffServ assignment to LAG interfaces.

Create and configure an IPv6 DiffServ class

To create and configure an IPv6 DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.
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By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > IPv6 Class Configuration.

7. Enter a class name in the Class Name field.

The Class Name field also lists all the existing IPv6 class hames, from which one can be
selected for modification or deletion.

8. From the Class Type menu, select the class type.

The switch supports only the class type value All, which means that all the various match
criteria defined for the class are satisfied for a packet match. All signifies the logical AND
statement of all the match criteria. You can select the class type only when you are
creating a new class. After the class is created, the Class Type field becomes
nonconfigurable.

9. Click the Add button.
The new class is added.
10. Atter creating the class, click the class name.

The class name is a hyperlink to the page on which you can define the class
configuration.
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» Basic W Class Name
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Source PrefixLength

Source L4 Port (0 to 65535)
Destination Prefix/Length

Destination L4 Port (0 to 65535)

IP DSCP . (0 to 63)

Class Summary

Match Criteria Values

11. Define the criteria that must be associated the IPv6 DiffServ class:

« Match Every. Select this radio button to add a match condition that considers alll
packets to belong to the class. The only selection from the Match Every menu is Any.

» Reference Class. Select this radio button to reference another class for criteria. The
match criteria defined in the reference class function as match criteria in addition to
the match criteria that you define for the selected class. After selecting this option, the
classes that can be referenced are displayed. Select the class to reference. A class
can reference one other class of the same type.

* Protocol Type. Select this radio button to require a packet's Layer 4 protocol to match
the specified protocol, which you must select from the menu. The menu includes
Other as a selection, which lets you enter a protocol number from 0 to 255.

e Source Prefix/Length. Select this radio button to require a packet’s source prefix and
prefix length to match the specified source IPv6 prefix and prefix length. Prefix must
always be specified with the prefix length. The prefix can be in the hexadecimal range
from O to FFFF:FFFF:FFFF:FFFF:FFFF:FFFF.FFFF:FFFF and the prefix length can
be in the range from 0 to 128.

e Source L4 Port. Select this radio button to require a packet’'s TCP/UDP source port to
match the specified protocol, which you must select from the menu. The range is 0 to
65535. The menu includes Other as an option for unnamed ports.

« Destination Prefix/Length. Select this radio button to require a packet’s destination
prefix and prefix length to match the specified source IPv6 prefix and prefix length.
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Prefix must always be specified with the prefix length. The prefix can be in the
hexadecimal range from 0 to FFFF:FFFF:FFFF.FFFF.FFFF:FFFF:FFFF:FFFF and
the prefix length can be in the range from 0 to 128.

» Destination L4 Port. Select this radio button to require a packet's TCP/UDP
destination port to match the specified protocol, which you must select from the
menu. The range is 0 to 65535. The menu includes Other as an option for unnamed
ports.

« |P DSCP. Select this radio button to require the packet’s IP DiffServ Code Point
(DSCP) value to match the specified IP DSCP keyword code, which you must select
from the menu. The menu includes Other as a selection, which lets you enter an IP
DSCP value from 0 to 63. The DSCP value is defined as the high-order 6 bits of the
Service Type octet in the IP header.

12. Click the Apply button.
Your settings are saved.

The following table describes the nonconfigurable information that is displayed in the Class
Summary section.

Table 43. IPv6 DiffServ class configuration class summary

Field Description
Match Criteria The configured match criteria for the specified class.
Values The values of the configured match criteria.

Rename an existing IPvé DiffServ class

To rename an existing IPv6 DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > IPv6 Class Configuration.
The Class Name page displays.

7. Select the check box next to the class name.
8. In the Class Name field, specify the new name.
9. Click the Apply button.

Your settings are saved.

Change the criteria for an existing IPv6 DiffServ class

To change the criteria for an existing IPv6 DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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6. Select QoS > DiffServ > Advanced > IPv6 Class Configuration.
The Class Name page displays.

7. Click the class name, which is a hyperlink.
The page on which you can change the class configuration displays.

8. Change the class configuration as needed.
9. Click the Apply button.

Your settings are saved.

Delete an IPv6 DiffServ class

To delete an IPv6 DiffServ class:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > IPv6 Class Configuration.
The Class Name page displays.

7. Select the check box next to the class name.
8. Click the Delete button.

The class is removed.
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Configure a DiffServ policy

You can associate one or more classes with one or more policies.

Create and configure a DiffServ policy
To create and configure a DiffServ policy:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Policy Configuration.
The Policy Configuration page displays.

7. Enter a policy name in the Policy Name field.

You cannot specify the policy type. By default, the policy type is In, indicating that the
policy applies to ingress packets.

8. From the Member Class menu, select an existing class that you want to associate with the
new policy.

9. Click the Add button.
The new policy is added.

10. After creating the policy, click the policy name.
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The policy name is a hyperlink to the page on which you can define the policy attributes.

Class Information

Policy Name
Policy Type

Member Class

Policy Attribute

Policy Attribute Assign Queue
Drop
Mark VLAN CoS
Mark IP Precedence
Mirror
Redirect
Mark IP DSCP
Simple Policy

Color Mode Color Blind
Committed Rate
Conform Action Send
Drop
Mark CoS
Mark IP Precedence
Mark IP DSCP
Violate Action Drop

11. Configure the policy attributes by selecting one of the following radio buttons:

Assign Queue. Select this radio button to specify that traffic must be assigned to a
gueue, which you must select from the menu. The queue is expressed as a value in
the range from O to 7.

Drop. Select this radio button to require each inbound packet to be dropped.

Mark VLAN CoS. Select this radio button to specify the VLAN priority, which you must
select from the menu. The VLAN priority is expressed as a value in the range from 0
to 7.

Mark IP Precedence. Select this radio button to require packets to be marked with an
IP precedence value before being forwarded. You must select an IP precedence
value from 0 to 7 from the menu.

Mirror. Select this radio button to require packets to be mirrored to an interface or
LAG, one of which you must select from the menu.

Redirect. Select this radio button to require packets to be redirected to an interface or
LAG, one of which you must select from the menu.

Mark IP DSCP. Select this radio button to require packet to be marked with an IP
DSCP keyword code, which you must select from the menu. The DSCP value is
defined as the high-order 6 bits of the Service Type octet in the IP header.

Simple Policy. Select this radio button to define the traffic policing style for the class.
By default, this simple policy is color blind, and color classes do not apply. A simple
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policy supports a single data rate and results in one of two outcomes: conform or
violate. Packets that violate the policy are always dropped. That is, you cannot specify
any other action for those packets. You must specify a policy action for packets that
conform to the policy.

- Committed Rate. Enter the committed rate that is applied to conforming packets
by specifying a value in the range from 16 to 1000000 Kbps.

- In the Conform Action section, select one of the following radio buttons:

Send. Packets are forwarded unmodified. This is the default confirming action.
Drop. Packets are dropped. This is the default (and only) violating action.

Mark CoS. Packets are marked by DiffServ with the specified CoS value
before being forwarded. This selection requires that the Mark CoS field is set.
You must select a CoS value from 0 to 7 from the menu.

Mark IP Precedence. These packets are marked by DiffServ with the specified
IP Precedence value before being forwarded. This selection requires that the
Mark IP Precedence field is set. You must select an IP precedence value from
0 to 7 from the menu.

Mark IP DSCP. Packets are marked by DiffServ with the specified DSCP value
before being forwarded. This selection requires that the DSCP field is set. You
must either select a DSCP code from the menu or enter an IP DSCP value
from O to 63 in the field next to the menu. A value that you enter in the field
overrides any selection from the menu.

The DSCP value is defined as the high-order six bits of the Service Type octet
in the IP header.

12. Click the Apply button.

Your settings are saved.

Rename an existing DiffServ policy

To rename an existing DiffServ policy:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Policy Configuration.
The Policy Configuration page displays.

7. Select the check box next to the policy name.

8. In the Policy Name field, specify the new name.
9. Click the Apply button.

Your settings are saved.

Change the policy attributes for an existing DiffServ policy
To change the policy attributes for an existing DiffServ policy:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Policy Configuration.
The Policy Configuration page displays.
7. Click the policy name, which is a hyperlink.
The page on which you can change the policy attributes displays.

8. Change the policy attributes as needed.
9. Click the Apply button.

Your settings are saved.

Change or remove a class from an existing DiffServ policy

To change or remove a class from an existing DiffServ policy:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Policy Configuration.
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The Policy Configuration page displays.

7. Select the check box next to the policy name.

8. Do one of the following:
» To change the class, select another class rom the Member Class menu.
* Toremove the class, select None, from the Member Class menu.

9. Click the Apply button.

Your settings are saved.

Delete a DiffServ policy
To delete a DiffServ policy:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Policy Configuration.
The Policy Configuration page displays.

7. Select the check box next to the policy name.
8. Click the Delete button.

The policy is removed.
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Configure the DiffServ service interface

You can assign (attach) a policy to an interface.

Attach a DiffServ policy to an interface

To attach a DiffServ policy to an interface:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Service Configuration.

Service Interface Configuration

1 LAG All Go To Interface m

Policy In
MName

Interface Direction Operational Status

w

gl
g2

g3
g4
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7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

* LAG. Only LAGs are displayed.
« All. Both physical interfaces and LAGs are displayed.
8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. From the Policy In Name menu, select a policy name.
10. Click the Apply button.

Your settings are saved.
The following table describes the nonconfigurable information displayed on the page.

Table 44. Service Interface Configuration information

Field Description
Direction Shows the traffic direction of this service interface, which is always inbound (In).
Operational Status Shows the operational status of this service interface (either Up or Down).

The operational status is shown as Up if all of the following conditions are true:

e The attached class is valid and includes at least one matching rule.

* The attached policy is valid and includes at least one attribute.

e The port is enabled, that is, the physical link of the port is in the up state.

Change the DiffServ policy for an interface
To change the DiffServ policy for an interface:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select QoS > DiffServ > Advanced > Service Configuration.
The Service Interface Configuration page displays.

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

 LAG. Only LAGs are displayed.

» All. Both physical interfaces and LAGs are displayed.
8. Select the check box for the interface.
9. From the Policy In Name menu, select another policy name.
10. Click the Apply button.

Your settings are saved.

Remove a DiffServ policy from an interface

To remove a DiffServ policy from an interface:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
The Service Interface Configuration page displays.

6. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

e LAG. Only LAGs are displayed.

» All. Both physical interfaces and LAGs are displayed.
7. Select the check box for the interface.
8. From the Policy In Name menu, select None.
9. Click the Apply button.

Your settings are saved.

View DiffServ service statistics

You can display service-level statistical information about all interfaces to which DiffServ
policies are attached.

To view the DiffServ service statistics:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on

page 30.

5. Click the Login button.

The System Information page displays.

6. Select QoS > DiffServ > Advanced > Service Statistics.

The Service Statistics page displays.

7. Click the Refresh button to refresh the page with the latest information about the switch.

The following table describes the information available on the Service Statistics page.

Table 45. DiffServ Service Statistics information

Field Description

Interface All valid port numbers on the switch with a DiffServ policy that is attached in the inbound
direction.

Direction The traffic direction of interface is inbound (In). This field shows only the direction for
which a DiffServ policy is attached.

Policy Name The name of the policy that is currently attached to the specified interface and direction.

Operational Status

The operational status of the policy that is attached to the specified interface and
direction. The value is either Up or Down.

Member Classes

All DiffServ classes that are defined as members of the selected policy name. Select a
member class name to display its statistics. If no class is associated with the selected
policy, then the list is empty.
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Change the local device password for the
local browser Ul

You can change the local device password for the user with the user name admin.

To change the local device password for the local browser Ul:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > User Configuration > Change Password.
The Change Password page displays.

7. In the Current Password field, enter the current password.
The default password is password. The password is displayed in dots.

8. Inthe New Password field, specify the new password.

The password must be between 8 and 20 characters in length and must include at least
one uppercase letter, one lowercase letter, and one number. The password is
case-sensitive.

The password is displayed in dots.
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9. Inthe Confirm Password field, enter the password again to confirm that you entered it
correctly.

The password is displayed in dots.
10. Click the Apply button.

Your settings are saved.

Manage the RADIUS settings

RADIUS servers provide additional security for networks. The RADIUS server maintains a
user database, which contains per-user authentication information. The switch passes
information to the configured RADIUS server, which can authenticate a user name and
password before authorizing use of the network. RADIUS servers provide a centralized
authentication method for the following:

*  Web access
« Access control port (802.1X)

Configure the global RADIUS server settings

You can add information about one or more RADIUS servers on the network.

If you configure multiple RADIUS servers, consider the maximum delay time when you
specify the maximum number of retransmissions (that is, the value that you enter in the Max
Number of Retransmits field) and the time-out period (that is, the value that you enter in the
Timeout Duration field) for RADIUS:

For one RADIUS server, a retransmission does not occur until the configured time-out
period expires without a response from the RADIUS server. In addition. the maximum
number of retransmissions for one RADIUS server must pass before the switch attempts
the next RADIUS server.

Therefore, the maximum delay in receiving a RADIUS response on the switch equals the
maximum number of retransmissions multiplied by the time-out period multiplied by the
number of configured RADIUS servers. If the RADIUS request was generated by a user
login attempt, all user interfaces are blocked until the switch receives a RADIUS
response.

To configure the global RADIUS server settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > RADIUS > Global Configuration.

RADIUS Cenfiguration

* User Configuration v Current Server IP Address

*RADIUS ~  MNumber of Configured Servers ]

Max Number of Retransmits 4 {1ta 15)
= Server Configuration Timeout Duration (secs) 5 {1 to 30)
= Accounting Server Accounting Mode Disable v

Configuration
*TACACS+ v
= Authentication List v

The Current Server IP Address field is blank if no servers are configured (see Configure
a RADIUS authentication server on the switch on page 245). The switch supports up to
three RADIUS servers. If more than one RADIUS server is configured, the current server
is the server configured as the primary server. If no servers are configured as the primary
server, the current server is the most recently added RADIUS server.

CAUTION:

The maximum delay in receiving a RADIUS response on the switch equals
the maximum number of retransmissions multiplied by the time-out period
multiplied by the number of configured RADIUS servers. If the RADIUS
request was generated by a user login attempt, all user interfaces are
blocked until the switch receives a RADIUS response.
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7. Inthe Max Number of Retransmits field, specify the maximum number of times a request
packet is retransmitted to the RADIUS servet.

The range is from 1 to 15. The default value is 4.

8. In the Timeout Duration field, specify the time-out value, in seconds, for request
retransmissions.

The range is from 1 to 30. The default value is 5.

9. From he Accounting Mode menu, select to enable or disable RADIUS accounting on the
server.

The default is Disabled.
10. Click the Apply button.
Your settings are saved.
The following table describes the nonconfigurable fields displayed on the page.

Table 46. RADIUS Configuration information

Field Description

Current Server IP Address  The IP address of the current server. This field is blank if no servers are

configured.
Number of Configured The number of configured authentication RADIUS servers. The value can range
Servers from O to 3.

Configure a RADIUS authentication server on the switch

You view and configure various settings for a RADIUS server configured on the switch.

Add a primary RADIUS authentication server to the switch

To add a primary RADIUS authentication server to the switch and view or reset the
RADIUS authentication server statistics:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > RADIUS > Server Configuration.

Server Configuration
; o Secret S Message
_I|| Server Address Authentication Port Configured Secret Active Aatharticator
| s Primary v Disable v
Statistics
Server. | Round Access | Access Access | Access | Access Malformed Access  Bad Pending TGO Unknown | Packels
Address | Trip Time | Requests. Refransmissions Accepts | Rejects Challenges Responses Authenticators  Requests Types Dropped

7. Inthe Server Address field, specify the IP address of the RADIUS server.

8. Inthe Authentication Port field, specify the UDP port number that the server uses to verify
the RADIUS server authentication.

The range is from 1 to 65535. The default value is 1812.
9. From the Secret Configured menu, select Yes.

You must select Yes before you can configure the RADIUS secret. After you add the
RADIUS server, this field indicates whether the shared secret for this server was
configured.

10. In the Secret field, type the shared secret text string used for authenticating and encrypting
all RADIUS communications between the switch and the RADIUS server.

This secret must match the one that is configured on the RADIUS server.

11. From the Active menu, select Primary.

12. From the Message Authenticator menu, select Enable or Disable to specify whether the
message authenticator attribute for the selected server is enabled.

The message authenticator adds protection to RADIUS messages by using an MD5 hash
to encrypt each message. The shared secret is used as the key, and if the message fails
to be verified by the RADIUS server, it is discarded.

13. Click the Add button.

The server is added to the switch.
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14. To reset the authentication server and RADIUS statistics to their default values, click the

Clear Counters button.

The following table describes the nonconfigurable information in the Statistics table on

the page.

Table 47. RADIUS authentication server statistics information

Field

Server Address

Description

The address of the RADIUS server or the name of the RADIUS server for
which the statistics are displayed.

Round Trip Time

The time interval, in hundredths of a second, between the most recent
access-reply/access-challenge and the access-request that matched it from
this RADIUS authentication server.

Access Requests

The number of RADIUS access-request packets sent to this server. This
number does not include retransmissions.

Access Retransmissions

The number of RADIUS access-request packets retransmitted to this server.

Access Accepts

The number of RADIUS access-accept packets, including both valid and
invalid packets, that were received from this server.

Access Rejects

The number of RADIUS access-reject packets, including both valid and invalid
packets, that were received from this server.

Access Challenges

The number of RADIUS access-challenge packets, including both valid and
invalid packets, that were received from this server.

Malformed Access Responses

The number of malformed RADIUS access-response packets received from
this server. Malformed packets include packets with an invalid length. Bad
authenticators or signature attributes or unknown types are not included in
malformed access-responses.

Bad Authenticators

The number of RADIUS access-response packets containing invalid
authenticators or signature attributes received from this server.

Pending Requests

The number of RADIUS access-request packets destined for this server that
did not yet time out or receive a response.

Timeouts

The number of authentication time-outs to this server.

Unknown Types

The number of RADIUS packets of unknown type that were received from this
server on the authentication port.

Packets Dropped

The number of RADIUS packets received from this server on the
authentication port and dropped for some other reason.

Modify the settings for a RADIUS authentication server on the switch

To modify the settings for a RADIUS authentication server on the switch:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.
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2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security > RADIUS > Server Configuration.
The Server Configuration page displays.

7. Select the check box next to the server IP address.
8. Modify the configuration for the selected server.
9. Click the Apply button.

Your settings are saved.

Remove a RADIUS authentication server from the switch

To remove a RADIUS authentication server from the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security > RADIUS > Server Configuration.
The Server Configuration page displays.

7. Select the check box next to the IP address of the server to remove.
8. Click the Delete button.

The RADIUS server is removed.
9. Click the Apply button.
Your settings are saved.

Contigure a RADIUS accounting server

You can view and configure various settings for a RADIUS accounting server on the network.

Add a RADIUS accounting server to the switch

To add a RADIUS accounting server to the switch and view or clear the RADIUS
accounting server statistics:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > RADIUS > Accounting Server Configuration.

Accounting Server Configuration
- User Configuration ¥ Accounting Server Address
*RADIUS ~  Por 1813
= Global Configuration Secret Configured Mo ~
= Server Configuration Secret
Accounting Mode Disable ~
=TACACS+ v

The previous figure does not show the Accounting Server Statistics section.

7. Inthe Accounting Server Address field, specify the IP address of the RADIUS accounting
server to add.

8. Inthe Port field, specify the UDP port number that the server uses to verify the RADIUS
accounting server authentication.

The default UDP port number is 1813.
9. From the Secret Configured menu, select Yes to add a RADIUS secret in the next field.

You must select Yes before you can configure the RADIUS secret. After you add the
RADIUS accounting server, this field indicates whether the shared secret for this server
was configured.

10. In the Secret field, type the shared secret to use with the specified accounting server.

11. From the Accounting Mode menu, select Enable to enable the RADIUS accounting mode.

12. Click the Apply button.

Your settings are saved.

13. To reset the accounting server and RADIUS statistics to their default values, click the Clear
Counters button.
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14. The following table describes the nonconfigurable information in the Accounting Server
Statistics table on the page.

Table 48. RADIUS accounting server statistics information

Field Description
Accounting Server Address The accounting server associated with the statistics.
Round Trip Time (secs) The time interval, in hundredths of a second, between the most recent

accounting-response and the accounting-request that matched it from this
RADIUS accounting server.

Accounting Requests The number of RADIUS accounting-request packets sent not including
retransmissions.

Accounting Retransmissions The number of RADIUS accounting-request packets retransmitted to this
RADIUS accounting server.

Accounting Responses The number of RADIUS packets received on the accounting port from this
server.

Malformed Accounting Responses The number of malformed RADIUS accounting-response packets received
from this server. Malformed packets include packets with an invalid length.
Bad authenticators and unknown types are not included as malformed
accounting responses.

Bad Authenticators The number of RADIUS accounting-response packets that contained invalid
authenticators received from this accounting server.

Pending Requests The number of RADIUS accounting-request packets sent to this server that
did not yet time out or receive a response.

Timeouts The number of accounting time-outs to this server.

Unknown Types The number of RADIUS packets of unknown type that were received from
this server on the accounting port.

Packets Dropped The number of RADIUS packets that were received from this server on the
accounting port and dropped for some other reason.

Modify the settings for a RADIUS accounting server on the switch

To modify the settings for a RADIUS accounting server on the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security > RADIUS > Accounting Server Configuration.
The Accounting Server Configuration page displays.

7. Select the check box next to the server IP address.
8. Modify the configuration for the selected accounting server.
9. Click the Apply button.

Your settings are saved.

Remove a RADIUS accounting server from the switch

To remove a RADIUS accounting server from the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > RADIUS > Accounting Server Configuration.
The Accounting Server Configuration page displays.

7. Remove the server IP address from the Accounting Server Address field.
Leave the field blank.

8. Click the Apply button.

Your settings are saved. The RADIUS accounting server is removed.

Contigure the TACACS+ settings

TACACS+ provides a centralized user management system, while still retaining consistency
with RADIUS and other authentication processes. TACACS+ provides the following services:

« Authentication. Provides authentication during login and through user names and
user-defined passwords.

» Authorization. Performed at login. When the authentication session is completed, an
authorization session starts using the authenticated user name. The TACACS+ server
checks the user privileges.

The TACACS+ protocol ensures network security through encrypted protocol exchanges
between the device and TACACS+ server.

Configure the global TACACS+ settings
You can configure the global TACACS+ settings for communication between the switch and

a TACACSH+ server.
To configure the global TACACS+ settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

Manage Device Security 253 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > TACACS+ > TACACS+ Configuration.

TACACS+ Cenfiguration

Key String (0 to 128)
3 o '

Connection Timeout L (1 ta 30)

7. Inthe Key String field, specify the authentication and encryption key for TACACS+
communications between the switch and the TACACS+ server.

The range is from 0 to 128. The key must match the key configured on the TACACS+
server.

8. In the Connection Timeout field, specify the maximum number of seconds allowed to
establish a TCP connection between the switch and the TACACS+ server.

The range is from 1 to 30 seconds. The default is 5 seconds.
9. Click the Apply button.

Your settings are saved.

Configure a TACACS+ server on the switch
You can configure up to three TACACS+ servers with which the switch can communicate.

To configure a TACACS+ server on the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.

Manage Device Security 254 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > TACACS+ > TACACS+ Server
Configuration.

TACACS+ Server Configuration

TACACS+ Server Pricrity (0 to 65535) Port (0 to 65535) | Key String Connection Timeout

40
43

7. Inthe TACACS+ Server field, enter the TACACS+ server IP address.
8. In the Priority field, specify the priority for the TACACS+ server.

The priority determines the order in which the TACACS+ servers are contacted when
attempting to authenticate a user. A value of 0 is the highest priority. The range is from
0 to 65535.

9. In the Port field, specify the authentication port value for TACAS+ server sessions.

The value must be in the range from 0 to 65535. If you do not specify a value, the switch
uses the standard TCP port 49 for sessions with the server.

10. In the Key String field, specify the authentication and encryption key for TACACS+
communications between the device and the TACACS+ server.

The range is from 0 to 128. The key must match the key used on the TACACS+ server.

11. In the Connection Timeout field, specify the time that passes before the connection
between the device and the TACACS+ server times out.

The range is from 1 to 30. If you do not specify a value, the switch uses a default value
of 5 seconds.
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12. Click the Add button.

The server is added to the switch.

Modify the settings for a TACACS+ server on the switch

To modify the settings for a TACACS+ server on the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security> TACACS+ > TACACS+ Server Configuration.
The TACACS+ Server Configuration page displays.

7. Select the check box next to the server IP address.
8. Modify the configuration for the selected TACACS+ server.
9. Click the Apply button.

Your settings are saved.
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Remove a TACACS+ server from the switch

To remove a TACACS+ server from the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security> TACACS+ > TACACS+ Server Configuration.
The TACACS+ Server Configuration page displays.

7. Select the check box next to the server IP address.
8. Click the Delete button.

The TACACS+ server is removed.

Configure authentication lists

A login list specifies one or more authentication methods to validate switch or port access for
the admin user. You can configure a default login list.

Note: The admin user is assigned to a preconfigured list that is named
defaultList and that you cannot delete.
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Configure an HTTP authentication list
You can configure the default HTTP login list.

To change the HTTP authentication method for the default list:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

e If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
The System Information page displays.

6. Select Security > Management Security > Authentication List > HTTP Authentication
List.

HTTP Authentication List

List Name 1 2 3 4

httpList

7. Select the check box next to the httpList name.

8. From the menu in the 1 column, select the authentication method that must be used first in
the selected authentication login list.

If you select a method that does not time out as the first method, such as Local, no other
method is tried, even if you specified more than one method. User authentication occurs
in the order the methods are selected.
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Possible methods are as follows:

e Local. The user’s locally stored ID and password are used for authentication. Since
the Local method does not time out, if you select this option as the first method, no
other method is tried, even if you specified more than one method. This is the default
method. This is the default selection for Method 1.

* RADIUS. The user’s ID and password are authenticated using the RADIUS server. If
you select RADIUS or Tacacs+ as the first method and an error occurs during the
authentication, the switch uses Method 2 to authenticate the user.

* Tacacs+. The user’s ID and password are authenticated using the TACACS+ server.
If you select RADIUS or Tacacs+ as the first method and an error occurs during the
authentication, the switch attempts user authentication Method 2.

* None. The authentication method is unspecified, that is, no authentication is required.

9. From the menu in the 2 column, select the authentication method, if any, that must be used
second in the selected authentication login list.

This is the method that is used if the first method times out. If you select a method that
does not time out as the second method, the third method is not tried.

10. From the menu in the 3 column, select the authentication method, if any, that must be used
third in the selected authentication login list.

11. From the menu in the 4 column, select the method, if any, that must be used fourth in the
selected authentication login list.

This is the method that is used if all previous methods time out.
12. Click the Apply button.

Your settings are saved.

Configure an HTTPS authentication list
You can configure the default login list for secure HTTP (HTTPS).

To configure an HTTPS authentication list:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > Authentication List > HTTPS Authentication
List.

HTTPS Authentication List

List Name 1 2 3 4

hitpsList

7. Select the check box next to the httpsList name.

8. From the menu in the 1 column, select the authentication method that must be used first in
the selected authentication login list.

If you select a method that does not time out as the first method, such as Local, no other
method is tried, even if you specified more than one method. This setting does not display
when you first create a new login list. User authentication occurs in the order the methods
are selected. Possible methods are as follows:

* Local. The user’s locally stored ID and password are used for authentication. Since
the Local method does not time out, if you select this option as the first method, no
other method is tried, even if you specified more than one method. This is the default
selection for Method 1.

 RADIUS. The user’s ID and password are authenticated using the RADIUS server. If
you select RADIUS or Tacacs+ as the first method and an error occurs during the
authentication, the switch uses Method 2 to authenticate the user.

e Tacacs+. The user’s ID and password are authenticated using the TACACS+ server.
If you select RADIUS or Tacacs+ as the first method and an error occurs during the
authentication, the switch attempts user authentication Method 2.

« None. The authentication method is unspecified, that is, no authentication is required.

9. From the menu in the 2 column, select the authentication method, if any, that must be used
second in the selected authentication login list.

This is the method that is used if the first method times out. If you select a method that
does not time out as the second method, the third method is not tried.

10. From the menu in the 3 column, select the authentication method, if any, that must be used
third in the selected authentication login list.
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11. From the menu in the 4 column, select the method, if any, that must be used fourth in the
selected authentication login list.

This is the method that is used if all previous methods time out.
12. Click the Apply button.

Your settings are saved.

Configure the dot1x authentication list

The dotlx authentication list defines the IEEE 802.1X authentication method used for the
default list. The default list is dot1xList.

To configure the dotlx authentication list:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Management Security > Authentication List > Dot1lx Authentication
List.

The Dotlx Authentication List page displays.

7. Select the check box next to dotlxList.

From the menu in the 1 column, select the method that must be used first in the selected
authentication login list.
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The options are as follows:

* Radius. The user’s ID and password are authenticated using the RADIUS server
instead of locally.
* None. The user is not authenticated.
9. Click the Apply button.

Your settings are saved.

Manage the Smart Control Center Utility

By default, the Smart Control Center (SCC) utility is disabled. You still can use the SCC utility
to discover the IP address of the switch, but you cannot use the utility to perform any actions
on the switch. If you enable the SCC utility, you can use it to configure the switch.

For more information about the SCC utility, see Discover the switch in a network with a
DHCP server using the Smart Control Center on page 23 and Discover the switch in a
network without a DHCP server using the Smart Control Center on page 24.

Note: The switch administrator password is contained in each NETGEAR
Switch Discovery Protocol (NSDP) packet. Therefore, to increase the
switch security, the SCC utility is disabled by default.

To enable or disable the SCC administrative mode:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. Inthe address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Management Security > SCC Control.

The NETGEAR Smart Control Center (SCC) Utility page displays.
7. Select Security > Management Security > SCC Control.

The NETGEAR Smart Control Center (SCC) Utility page displays.

8. Select the one of the following SCC Admin Mode radio buttons:
* Enable. The SCC utility can discover the switch and perform actions on the switch.

« Disable. The SCC utility can discover the switch but cannot perform any actions on
the switch. This is the default setting.

9. Click the Apply button.

Your settings are saved.

Configure management access

You can configure the global settings for HTTP and secure HTTP (HTTPS) access to the
switch’s local browser Ul. You can also configure access control profiles and access rules.

Configure HTTP access settings
You can configure the HTTP access settings on the switch.

To configure the HTTP access settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > HTTP > HTTP Configuration.

il T *  HTTP Session Soft Timeout (Minutes) 60 (0 to 60)
T Somuion HTTP Session Hard Timeout (Hours) 24 (0o 168)

L ¥ Maximum Number of HTTP Sessions 4 (1to4)

= Access Control v

7. Inthe HTTP Session Soft Timeout field, specify the number of minutes an HTTP session
can be idle before a time-out occurs.

The value must be in the range from 0 to 60 minutes. The default value is 5 minutes.

After the session is inactive for the configured time, you are automatically logged out and
must reenter the password to access the local browser Ul. A value of zero means that the
session does not time out.

8. Inthe HTTP Session Hard Timeout field, specify the hard time-out for HTTP sessions.

This time-out is unaffected by the activity level of the session. The value must be in the
range from O to 168 hours. A value of zero means that the session does not time out. The
default value is 24 hours.

9. In the Maximum Number of HTTP Sessions field, specify the maximum number of HTTP
sessions that can exist at the same time.

The range is from 1 to 4 sessions. The default is 4 sessions.
10. Click the Apply button.

Your settings are saved.
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Configure HTTPS access settings

Secure HTTP (HTTPS) enables the transmission of HTTP over an encrypted Secure Sockets
Layer (SSL) or Transport Layer Security (TLS) connection. When you manage the switch
over the local browser Ul, HTTPS can help ensure that communication between the
management system and the switch is protected from eavesdroppers and man-in-the-middle
attacks. The hash algorithms that SSL uses are MD5 and SHA-1. By default, HTTPS access
is enabled on the switch.

To configure HTTPS access settings:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select Security > Access > HTTPS > HTTPS Configuration.

=HTTP ¥ Admin Mode Disable ® Enable

“HTTPS ~  HTTPS Port 443 (1025 to 65535 | Default: 443)

+HTTPS Configuration HTTPS Session Soft Timeout (Minutes) 60 (1 to 60)

*Certificate Management  i17pg Session Hard Timeout (Hours) 24 (11to 168)

- Certific . - ‘
Carilcale Updas Maximum Number of HTTPS Sessions B (Tto d)

= Access Control v

Select the Admin Mode Enable or Disable radio button.

This selection enables or disables HTTPS. The default value is Enable.
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Note: You can download SSL certificates only when HTTPS is disabled.

8. Inthe HTTPS Port field, type the HTTPS port number.
The range is from 1025 to 65535. The default is port 443.

9. Inthe HTTPS Session Soft Timeout (Minutes) field, enter the inactivity time-out for HTTPS
sessions.

The range is from 1 to 60 minutes. The default value is 5 minutes.

10. In the HTTPS Session Hard Timeout (Hours) field, set the hard time-out for HTTPS
sessions.

This time-out is unaffected by the activity level of the session. The range is from 1 to 168
hours. The default is 24 hours.

11. In the Maximum Number of HTTPS Sessions field, enter the maximum allowable number
of HTTPS sessions.

The range is from 1 to 4 sessions. The default is 4 sessions.
12. Click the Apply button.

Your settings are saved.

Manage certificates for HTTPS access

You can manage certificates for HTTPS access.

Generate an SSL certificate

Note: Before you can generate a certificate, you must disable HTTPS (see
Configure HTTPS access settings on page 265) and log back in to the
local browser Ul over an HTTP session. After you generate the
certificate, you can reenable HTTPS and log back in to the local
browser Ul over an HTTPS session.

To generate an SSL certificate:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > HTTPS > Certificate Management.

Certificate Management

Certificate Present No
@ None

D Generate Certificates

Certificate Generation Status

Certificate Generation Status No certificate generation in progress
g prog

The Certificate Present field displays whether a certificate is present on the switch.

7. In the Certificate Management section, select the Generate Certificates radio button.
8. Click the Apply button.

The switch generates an SSL certificate.

The Certificate Generation Status field shows progress information.
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Delete an SSL certificate

Note: Before you can delete a certificate, you must disable HTTPS (see
Configure HTTPS access settings on page 265) and log back in to the
local browser Ul over an HTTP session. After you delete the
certificate, you can reenable HTTPS and log back in to the local
browser Ul over an HTTPS session.

To delete an SSL certificate:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > HTTPS > Certificate Management.
7. The Certificate Management page displays.
The Certificate Present field displays Yes.

8. In the Certificate Management section, select Delete Certificates radio button.
9. Click the Apply button.

The certificate is removed.
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Transfer an existing certificate from a TFTP server to the switch
You can transfer a certificate file to the switch.

Note: For information about downloading and installing an SSL certificate
over an HTTP session, see Use an HTTP session to download and
install an SSL security certificate file on the switch on page 393.

For the switch to accept HTTPS connections from a device, the switch requires a public key
certificate. You can generate a certificate externally (for example, offline) and transfer it to the
switch.

Before you transfer a file from a TFTP server to the switch, the following conditions must be
true:

« The file that you transfer from a TFTP server is on the server in the appropriate directory.
» Thefile is in the correct format.

e The switch contains a path to the TFTP server.

Note: Before you can transfer a certificate, you must disable HTTPS (see
Configure HTTPS access settings on page 265) and log back in to
the local browser Ul over an HTTP session. After you transfer the
certificate, you can reenable HTTPS and log back in to the local
browser Ul over an HTTPS session.

To configure the certificate transfer settings for HTTPS sessions:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > HTTPS > Certificate Update.

Certificate Update

File Type

Server Address Type
TFTP Server IP
Remaote File Path
Remote File Name

Start File Transfer

7. From the File Type menu, select the type of SSL certificate to download, which can be one
of the following:

» SSL Trusted Root Certificate PEM File. SSL Trusted Root Certificate file (PEM
Encoded)

e SSL Server Certificate PEM File. SSL Server Certificate File (PEM Encoded)

* SSL DH Weak Encryption Parameter PEM File. SSL Diffie-Hellman Weak Encryption
Parameter file (PEM Encoded)

e SSL DH Strong Encryption Parameter PEM File. SSL Diffie-Hellman Strong
Encryption Parameter File (PEM Encoded)

8. From the Server Address Type menu, select IPv4 or DNS to indicate the format for the
TFTP Server IP field.

The default is IPv4.
9. Inthe TFTP Server IP field, specify the address or host name of the TFTP server.

The address can be an IP address in standard x.x.x.x format or a host name. The host
name must start with a letter of the alphabet.

10. In the Remote File Path field, enter the path of the file to download.
You can enter up to 96 characters. The default is blank.

11. In the Remote File Name field, enter the name of the file on the TFTP server to download.
You can enter up to 32 characters. The default is blank.

12. Select the Start File Transfer check box.
13. Click the Apply button.

The file transfer starts. A status message displays during the transfer and upon
successful completion of the transfer.
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Control access with profiles and rules

Access control allows you to configure an access control profile and set rules for access to
the local browser Ul, access by SNMP stations, and client access to a TFTP server. We refer
to an access control profile as an access profile. You can add a single access profile, which
you can configure, activate, or deactivate.

CAUTION:

If you configure a security access profile incorrectly and you activate the
access profile, you might no longer be able to access the switch’s local
browser Ul. If that situation occurs, you must reset the switch to factory
default settings (see Reset the switch to its factory default settings on

page 384).

Add an access profile

You can set up a single security access profile with which you can associate an access rule
configuration.

To add an access profile:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.

The System Information page displays.

6. Select Security > Access > Access Control > Access Profile Configuration.

Access Profile Configuration

Profile Summary

Rule Type Semice Type Source IP Address Mask Pronty

7. Inthe Access Profile Name field, enter the name of the access profile to be added.
The maximum length is 32 characters.
8. Click the Apply button.

Your settings are saved. By default, the access profile is deactivated. After you add rules,
you can activate the access profile.

Add a rule to the access profile

After you add the access profile, you can add one or more security access rules to the access
profile.

If you access the switch from a computer, make sure that you add a permit rule for the type of

service that you use (for example, HTTPS), your computer’s IP address, and your computer’s
subnet mask.

CAUTION:

You must add a permit rule for your device and access method, otherwise
you are locked out from the switch after you activate the access profile. If
that situation occurs, you must reset the switch to factory default settings
(see Reset the switch to its factory default settings on page 384).

To add arule to the access profile:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > Access Control > Access Rule Configuration.

Access Rule Configuration

Rule Type Service Type Source |P Address  Mask Priority

w w

7. From the Rule Type menu, select Permit or Deny to permit or deny access when the
selected rules are matched.

A Permit rule allows access from a device that matches the rule criteria. A Deny rule
blocks a device that matches the rule criteria.

8. From the Service Type menu, select the access method to which the rule is applied.

The policy is restricted by the selected access method. Possible access methods are
TFTP, HTTP, Secure HTTP (SSL), and SNMP.

9. Inthe Source IP Address field, enter the source IP address from which the management
traffic originates.

10. In the Mask field, specify the subnet mask from which the management traffic originates.
11. In the Priority field, assign a priority to the rule.

The rules are validated against the incoming management request in ascending order of
their priorities. If a rule matches, the action is performed and subsequent rules below that
rule are ignored. For example, if a source IP address 10.10.10.10 is configured with
priority 1 to permit, and the same source IP address 10.10.10.10 is also configured with
priority 2 to deny, then access is permitted if the profile is active, and the second rule is
ignored.
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12. Click the Add button.

The access rule is added.

Activate the access profile

After you add rules to the access profile, you can activate the access profile.

CAUTION:

If you configure a security access profile incorrectly and you activate the
access profile, you might no longer be able to access the switch’s local
browser Ul. If that situation occurs, you must reset the switch to factory
default settings (see Reset the switch to its factory default settings on

page 384).

To activate the access profile:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select Security > Access > Access Control > Access Profile Configuration.
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The Access Profile Configuration page displays. The Deactivate Profile check box is
selected.

7. Select the Activate Profile check box.
8. Click the Apply button.

Your settings are saved and the access profile is now active.

Display the access profile summary and the number of
filtered packets
After you added rules to the active profile, you can view the entries in the summary. If the
access profile is active, you can also view the number of filtered packets.
To display the access profile summary and the number of filtered packets:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > Access Control > Access Profile Configuration.
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Access Profile Configuration

Access Profile Name

Activate Profile v
Deactivate Profile

Remove Profile

Packets Filtered 0

Profile Summary

Rule Type | Service Type Source IP Address  Mask Priority
Permit Secure HTTP(SSL) 192.168.100.24 2552552550 1
Permit TFTP 192.168.100.243 | 255.255.2550 3
Permit SNMP 192.168.100.199 25625662550 5

The Packets Filtered field displays the number of packets filtered (none in the previous
figure).

7. To refresh the page with the latest information about the switch, click the Refresh button.
The following table describes the nonconfigurable data that is displayed.

Table 49. Access profile configuration profile summary

Field Description

Rule Type The action performed when the rules match.

Service Type The service type selected. The policy is restricted by the selected service type.
Source |IP Address The source IP address of the client originating the management traffic.

Mask The subnet mask of the IP Address.

Priority The priority of the rule.

Deactivate an access profile

You can deactivate an access profile.

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Access > Access Control > Access Profile Configuration.

The Access Profile Configuration page displays. The Activate Profile check box is
selected.

7. Select the Deactivate Profile check box.
Click the Apply button.

Your settings are saved and the access profile is now deactivated.

Remove an access profile

You can remove an access profile that you no longer need. Before you can remove the
access profile, you must deactivate it (see Deactivate an access profile on page 276).

To remove an access profile:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Access > Access Control > Access Profile Configuration.

The Access Profile Configuration page displays. The Deactivate Profile check box is
selected.

7. Select the Remove Profile check box.
8. Click the Apply button.

The access profile is removed.

Configure port authentication

With port-based authentication, when 802.1X is enabled globally and on the port, successful
authentication of any one supplicant attached to the port results in all users being able to use
the port without restrictions. At any given time, only one supplicant is allowed to attempt
authentication on a port in this mode. Ports in this mode are under bidirectional control. This
is the default authentication mode.

An 802.1X network includes three components:

« Authenticators. The port that is authenticated before system access is permitted.

e Supplicants. The host connected to the authenticated port requesting access to the
system services.

e Authentication Server. The external server, for example, the RADIUS server that
performs the authentication on behalf of the authenticator, and indicates whether the user
is authorized to access system services.
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Configure the global 802.1X settings
You can configure global port access control settings on the switch.

To globally enable all 802.1X features:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Port Authentication > Basic > 802.1X Configuration.

T MR 502.1X Configuration

= Basic ~  Port Based Authentic ation State ® Disable ) Enable
VLAN Assignment Mode ® Disable () Enable
= Advanced ~  Dynamic VLAN Creation Mode ® Disable () Enable

EAPOL Flood Mode ® Disable () Enable

7. Configure the following port authentication settings:
« Port Based Authentication State. This selection specifies the 802.1X administrative
mode on the switch. The default value is Disable.

- Enabled. If 802.1X is enabled, authentication is performed by a RADIUS server.
This means that the primary authentication method must be RADIUS. To set the
method, select Security > Management Security > Authentication List and
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select RADIUS as method 1 for defaultList. For more information, see Configure
authentication lists on page 257.

- Disabled. When port-based authentication is globally disabled, the switch does
not check for 802.1X authentication before allowing traffic on any ports, even if the
ports are configured to allow only authenticated users.

* VLAN Assignment Mode. This selection specifies whether a port can be placed in a
particular VLAN. The default value is Disable.

When enabled, this feature allows a port to be placed into a particular VLAN based on
the result of the authentication or type of 802.1X authentication a client uses when it
accesses the device. The authentication server can provide information to the device
about which VLAN to assign the supplicant.

* Dynamic VLAN Creation Mode. This selection specifies whether a VLAN can be
dynamically created. The default value is Disable.

If RADIUS-assigned VLANSs are enabled, the RADIUS server includes the VLAN ID in
the 802.1X tunnel attributes of its response message to the device. If dynamic VLAN
creation is enabled on the device and the RADIUS-assigned VLAN does not exist, the
assigned VLAN is dynamically created. This means that the client can connect from
any port and is assigned to the appropriate VLAN. This feature gives flexibility for
clients to move around the network without much additional configuration required.

« EAPOL Flood Mode. This selection specifies whether Extensible Authentication
Protocol (EAP) over LAN (EAPoL) flood support is enabled on the switch. The default
value is Disable.

8. Click the Apply button.

Your settings are saved.

Manage port authentication on individual ports

You can enable and configure port access control on one or more physical ports.

Configure 802.1X settings for a port

To configure 802.1X settings for a port:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Port Authentication > Advanced > Port Authentication.

The previous figure does not show all columns.

7. Use the horizontal scroll bar at the bottom of the page to view all the fields.
8. Select one or more interfaces by taking one of the following actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

» To configure multiple interfaces with the same settings, select the check box
associated with each interface.

» To configure all interfaces with the same settings, select the check box in the heading
row.

9. Specify the following settings:

* Port Control. Defines the port authorization state. The control mode is set only if the
link status of the port is link up. Select one of the following options:

- Auto. The switch automatically detects the mode of the interface.

- Authorized. The switch places the interface into an authorized state without
being authenticated. The interface sends and receives normal traffic without client
port-based authentication.

- Unauthorized. The switch denies the selected interface system access by
moving the interface into unauthorized state. The switch cannot provide
authentication services to the client through the interface.
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- MAC based. This mode allows multiple supplicants connected to the same port to
each authenticate individually. Each host connected to the port must authenticate
separately in order to gain access to the network. The hosts are distinguished by
their MAC addresses.

* MAB. Specify whether to enable or disable MAC-based Authentication Bypass (MAB)
for 802.1x-unaware clients at the specified port. MAB only functions if the port control
mode is MAC-based. By default, MAB is disabled.

* Guest VLAN ID. Specify the VLAN ID for the guest VLAN. The range is from O to
4093. The default value is 0. Enter 0 to reset the guest VLAN ID on the interface. The
guest VLAN allows the port to provide a distinguished service to unauthenticated
users, after three authentication failures. This feature provides a mechanism to allow
users access to hosts on the guest VLAN.

e Guest VLAN Period. Specify the time in seconds that the selected port remains in
the quiet state following a failed authentication exchange. The guest VLAN time-out
must be a value in the range from 1 to 300. The default value is 90 seconds.

e Unauthenticated VLAN ID. Specify the VLAN ID of the unauthenticated VLAN for the
selected port. The range is from 0 to 4093. The default value is 0. Hosts that fail the
authentication might be denied access to the network or placed on a VLAN created
for unauthenticated clients. This VLAN might be configured with limited network
access.

» Periodic Reauthentication. Select Enable to allow periodic reauthentication of the
supplicant for the specified port. If you select Disable, connected clients are not
forced to reauthenticate periodically. The default is Disable.

« Reauthentication Period. Specify the time in seconds after which reauthentication of
the supplicant occurs. The reauthentication period must be a value in the range from
1 to 65535. The default value is 3600 seconds.

e Quiet Period. Specify the time in seconds that the port remains in the quiet state
following a failed authentication exchange. While in the quite state, the port does not
attempt to acquire a supplicant. The quite state period must be a value in the range
from 0 to 65535. A value of 0 means that the port remains in the quiet state and never
attempts to acquire a supplicant. The default value is 60 seconds.

* Resending EAP. Specify the EAP retransmit period for the selected port. The
transmit period is the time in seconds, after which an EAPoL EAP Request/Identify
frame is resent to the supplicant. The retransmit period must be a value in the range
from 1 to 65535. The default value is 30 seconds.

«  MAXEAP Requests. Specify the maximum number of EAP requests for the selected
port. The value is the maximum number of times an EAPoL EAP Request/Identity
message is retransmitted before the supplicant times out. The maximum number of
EAP requests must be a value in the range from 1 to 10. The default value is 2.

* Supplicant Timeout. Specify the supplicant time-out for the selected port. The
supplicant time-out is the time in seconds after which the supplicant times out. The
supplicant time-out period must be a value in the range from 1 to 65535. The default
value is 30 seconds.
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» Server Timeout. Specify the time in seconds that elapses before the switch resends
a request to the authentication server. The server time-out period must be a value in
the range from 1 to 65535. The default value is 30 seconds.

10. Click the Apply button.
Your settings are saved.

The following table describes the port authentication status information available on the
page.

Table 50. Port authentication status information

Field Description

Control Direction The control direction for the specified port, which is always Both. The control
direction dictates the degree to which protocol exchanges take place between
supplicant and authenticator. The unauthorized controlled port exerts control over
communication in both directions (disabling both incoming and outgoing frames).

Protocol Version The protocol version associated with the selected port. The only possible value
is 1, corresponding to the first version of the 802.1X specification.

PAE Capabilities The port access entity (PAE) functionality of the selected port. The option is
Authenticator or Supplicant.

Authenticator PAE State The current state of the authenticator PAE state machine. The options are as
follows:
e Initialize

« Disconnected

» Connecting

» Authenticating

e Authenticated

e Aborting

e Held

e ForceAuthorized

» ForceUnauthorized

Backend State The current state of the backend authentication state machine. The options are
as follows:
* Request
* Response
* Success
e Fall
* Timeout
* Initialize
« Idle
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Initialize 802.1X on a port

To initialize 802.1X on a port:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Port Authentication > Advanced > Port Authentication.
The Port Authentication page displays.

7. Select the check box for the port.
8. Click the Initialize button.

802.1X on the selected interface is reset to the initialization state. Traffic sent to and from
the port is blocked during the authentication process. This button is available only if the
control mode is auto. When you click this button, the action is immediate. You do not
need to click the Apply button for the action to occur.

Restart the 802.1X authentication process on a port
To restart the 802.1X authentication process on a port:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.
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Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.
Select Security > Port Authentication > Advanced > Port Authentication.
The Port Authentication page displays.

Select the check box for the port.
Click the Reauthenticate button.

The selected port is forced to restart the authentication process.This button is available only
if the control mode is auto. If the button is not selectable, it is grayed out. When you click
this button, the action is immediate. You do not need to click the Apply button for the
action to occur.

View the port summary

You can view summary information about the port-based authentication settings for each
port.

To view the port summary:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Port Authentication > Advanced > Port Summary.

NVNITPATTET N Port Summary

=Basic v

*ATERCH - Port Control Operating Control Reauthentication Port
-802.1X Configuration Mode  Mode Enabled Status

- Port Authentication g1 Auto N/A False N/A

g2 Aulo N/A False N/A

g3 Auto N/A False N/A

= Client Summary g4 Auto N/A False N/A

g5 Auto N/A False N/A

g6 Auto N/A False N/A

g7  Auto N/A False N/A

g8 Auto N/A False N/A

g9 Auto N/A False N/A

g10 Auto N/A False N/A

g11  Auto N/A False N/A

g12 Auto N/A False N/A

7. To refresh the page with the latest information about the switch, click the Refresh button.
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The following table describes the fields on the Port Summary page.

Table 51. Port summary

Field

Port

Description

The port whose settings are displayed in the current table row.

Control Mode

This field indicates the configured control mode for the port. The options are as
follows:

* Force Unauthorized. The authenticator port access entity (PAE)
unconditionally sets the controlled port to unauthorized.

* Force Authorized. The authenticator PAE unconditionally sets the controlled
port to authorized.

« Auto. The authenticator PAE sets the controlled port mode to reflect the
outcome of the authentication exchanges between the supplicant,
authenticator, and the authentication server.

« MAC Based. The authenticator PAE sets the controlled port mode to reflect the
outcome of authentication exchanges between a supplicant, an authenticator,
and an authentication server on a per supplicant basis.

Operating Control Mode

The control mode under which the port is actually operating. The options are as
follows:

e ForceUnauthorized

* ForceAuthorized

* Auto

« MAC Based

« N/A: If the port is in detached state, it cannot participate in port access control.

Reauthentication Enabled

This field shows whether reauthentication of the supplicant for the specified port is
allowed. The option is True or False. If the value is True, reauthentication occurs.
Otherwise, reauthentication is not allowed.

Port Status

The authorization status of the specified port. The options are Authorized,
Unauthorized, and N/A. If the port is in detached state, the value is N/A because the
port cannot participate in port access control.

View the client summary

You can view information about supplicant devices that are connected to the local
authenticator ports. If no active 802.1X sessions exist, the table is empty.

To view the client summary:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.

3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Port Authentication > Advanced > Client Summary.

Client Summary

Port| User Supplicant MAC | Session | Filter VLAN | VLAN Session Termination
Name Address Time D D Assigned Timeout Action

The following table describes the fields on the Client Summary page.

Table 52. Client Summary information

Field Description
Port The port to be displayed.
User Name The user name representing the identity of the supplicant device.

Supplicant Mac Address  The supplicant’s device MAC address.

Session Time The time since the supplicant logged in seconds.

Filter ID The policy filter ID assigned by the authenticator to the supplicant device.

VLAN ID The VLAN ID assigned by the authenticator to the supplicant device.

VLAN Assigned The reason for the VLAN ID assigned by the authenticator to the supplicant device.
Session Timeout The session time-out imposed by the RADIUS server on the supplicant device.
Termination Action The termination action imposed by the RADIUS server on the supplicant device.
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Set up traffic control
You can configure MAC filters, storm control, port security, and protected port settings.

Manage MAC filtering

You can create MAC filters that limit the traffic allowed into and out of specified ports on the
switch.

Create a MAC filter

If a packet with a MAC address and VLAN ID that you specify for a filter is received on a port
that is not part of the inbound filter, the packet is dropped.

A packet with a MAC address and VLAN ID that you specify for a filter can be transmitted
only from a port that is part of the outbound filter.

To create a MAC filter:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > MAC Filter > MAC Filter Configuration.
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MAC Filter Configuration
*MAC Filter ~ MAC Filter Create Filter v
MAC Address
*MAR: Filter Summay Source Port Members
= Storm Control - -
shart Seciny K Pots 1 3 8§ 7 & #H 13 15 17 19 21 28 2§
“ProtestedPo O
LL L L L L)
2 4 6 8 10 12 14 16 18 20 2 24 2
| R
LAG 13 5 7
O
LU
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7. From the MAC Filter menu, select Create Filter.
If you did not configure any filters, this is the only option available.

8. From the VLAN ID menu, select the VLAN that must be used with the MAC address.

9. Inthe MAC Address field, specify the MAC address of the filter in the format
XXXXKXXKXXXXXX.

You cannot define filters for the following MAC addresses:
¢ 00:00:00:00:00:00

¢ 01:80:C2:00:00:00 to 01:80:C2:00:00:0F

e 01:80:C2:00:00:20 to 01:80:C2:00:00:21

e FF.FF.FF.FF.FF:FF

10. In the Port and LAG tables in the Source Port Members section, select the ports and LAGs
that must be included in the inbound filter.

If a packet with the MAC address and VLAN ID that you specify is received on a port that
is not part of the inbound filter, the packet is dropped.

11. In the Port and LAG tables in the Destination Port Members section, select the ports and
LAGs that must be included in the outbound filter.

A packet with the MAC address and VLAN ID that you specify can be transmitted only
from a port that is part of the outbound filter.

Note: Destination ports can be included only in a multicast filter. A multicast
filter is determined by the MAC address that you enter in the MAC
Address field.

Manage Device Security 290 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

12. Click the Apply button.

Your settings are saved.

Delete a MAC filter
To delete a MAC filter:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Traffic Control > MAC Filter > MAC Filter Configuration.
The MAC Filter Configuration page displays.

7. From the MAC Filter menu, select the filter.
8. Click the Delete button.

The filter is removed.
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View the MAC filter summary
You can view the MAC filters that are configured on the switch.

To view the MAC filter summary:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

e If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > MAC Filter > MAC Filter Summary.

MAC Filter Summary

MAC Address VLAN ID Source Port Members Destination Port Members
A1:A3:C1:DE:12:D8 1 Q9 -g10 ql

The following table describes the information displayed on the page.

Table 53. MAC Filter Summary information

Field Description
MAC Address The MAC address of the filter in the format XX:XX:XX:XX: XX:XX.
VLAN ID The VLAN ID used with the MAC address to fully identify packets you want filtered.
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Table 53. MAC Filter Summary information (continued)

Field Description

Source Port Members The ports to be used for filtering inbound packets.

Destination Port Members  The ports to be used for filtering outbound packets.

Configure storm control settings

A broadcast storm is the result of an excessive number of broadcast messages
simultaneously transmitted across a network by a single port. Forwarded message
responses can overload network resources, cause the network to time out, or do both.

The switch measures the incoming packet rate per port for broadcast, multicast, unknown,
and unicast packets and discards packets if the rate exceeds the defined value. You enable
storm control per interface, by defining the packet type and the rate at which the packets are
transmitted.

Configure global storm control settings
The global storm control settings apply to all ports. After you configure the global settings,

you can specify storm control settings for one or more ports.
To configure storm control settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > Storm Control.

Storm Control

Port | Status Threshold

g1 Disable 0
g2 | Disable 0
g3  Disable 0
g4 Disable 0
g5  Disable 0

Ingress Control Mode Disabled v
Status
Threshold {0 to 100)
Control Action
Port Settings
Go To Interface m

Control Action
None
None
None
None

None

7. In the Storm Control section, from the Ingress Control Mode menu, select one of the
following modes for storm control:

« Disabled. Storm control is disabled. This is the default setting.

e Unknown Unicast. If the rate of incoming unknown Layer 2 unicast traffic (that is,

10.

traffic for which a destination lookup failure occurs) increases beyond the configured
threshold on an interface, the traffic is dropped.

Multicast. If the rate of incoming Layer 2 multicast traffic increases beyond the
configured threshold on an interface, the traffic is dropped.

Broadcast. If the rate of incoming Layer 2 broadcast traffic increases beyond the
configured threshold on an interface, the traffic is dropped.

If the selection from the Ingress Control Mode menu is not Disabled, specify whether the
ingress control mode is enabled by selecting Enable or Disable from the Status menu.

In the Threshold field, specify the maximum rate at which unknown packets are forwarded.

The range is a percent of the total threshold between 0 and 100%. The default is 5%.

From the Control Action mode menu, select one of the following options:

None. No action is taken. This is the default setting.
Trap. If the threshold of the configured broadcast storm is exceeded, a trap is sent.

Shutdown. If the threshold of the configured broadcast storm is exceeded, the port is
shut down.

11. Click the Apply button.
Your settings are saved.
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Configure storm control settings for one or more ports
After you configure the global settings, you can specify storm control settings for one or more

ports.
To configure storm control settings for one or more ports:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > Storm Control.
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Storm Control

Ingress Control Mode Disabled v
Status
Threshold (0 to 100)

Control Action

Port Settings
Go To Interface m
Port | Status Threshold Control Action
g1 Disable 0 None
g2 | Disable 0 None
g3  Disable 0 None
g4 Disable 0 None
g5 Disable 0 None

The default settings in the Port Settings section depends on the global storm control
settings (see Configure global storm control settings on page 293), which apply to all
ports.

7. In the Port Settings section, select one or more interfaces by taking one of the following
actions:

» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

« To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.

8. From the Status menu, specify whether the ingress control mode is enabled for the port by
selecting Enable or Disable.

9. Inthe Threshold field, specify the maximum rate at which unknown packets are forwarded
for the port.

The range is a percent of the total threshold between 0 and 100%.
10. From the Control Action mode menu, select one of the following options for the port:
* None. No action is taken.
« Trap. If the threshold of the configured broadcast storm is exceeded, a trap is sent.

e Shutdown. If the threshold of the configured broadcast storm is exceeded, the port is
shut down.

11. Click the Apply button.

Your settings are saved.
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Configure port security

Port security lets you lock one or more ports on the switch. When a port is locked, the port
can only forward packets with a source MAC addresses that you specifically allowed. The
port discards all other packets.

Configure the global port security mode

To configure the global port security mode:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > Port Security > Port Security Configuration.
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Traffic Control Port Security Configuration

*MAC Filter v

Port Security Mode @ Disable () Enable
= Storm Control

= Port Security A

- Port Security Port Security Violations
Configuration

- ; Port Last Violation MAC VLAN ID
= Interface Configuration

= Security MAC Address

= Protected Ports

7. To enable port security on the switch, select the Port Security Mode Enable radio button.
The default is Disable.
8. Click the Apply button.
Your settings are saved.
By default, port security is disabled for individual ports.
Note: After you enable port security for individual ports (see Configure a port
security interface on page 298), you can return to this page and click

the Refresh button to refresh the page with the latest information about
the ports.

The Port Security Violations table shows information about violations that occurred on ports
that are enabled for port security.

The following table describes the fields in the Port Security Violations table.

Table 54. Port Security Violations information

Field Description

Port The physical interface.

Last Violation MAC The source MAC address of the last packet that was discarded at a locked port.

VLAN ID The VLAN ID corresponding to the last MAC address violation.

Configure a port security interface

A MAC address can be defined as allowed on a port by one of two methods: dynamically or
statically. Both methods can occur concurrently when a port is locked.

Dynamic locking implements a first arrival mechanism for port security. You specify how
many addresses can be learned on the locked port. If the limit is not reached, a packet with
an unknown source MAC address is learned and forwarded normally. If the limit is reached,
no more addresses are learned on the port. Any packets with source MAC addresses that
were not already learned are dropped.
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Static locking allows you to specify a list of MAC addresses that are allowed on a port. The
behavior of packets is the same as for dynamic locking: only packets with an allowable
source MAC address can be forwarded.

To configure port security settings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > Port Security > Interface Configuration.

Interface Configuration
1 LAG Al Go To Port | o |
; ; fiolati iolati
Port Port Security Max Leamed MAC Address Max Static MAC Address Cnable Violation  Enable Violation
Shutdown Traps
gl Disable 4096 48 Mo No
g2  Disable 4096 48 No No
g3  Disable 4096 48 No No
g4 | Disable 4096 48 No No
g>  Disable 4096 43 No No

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.
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e LAG. Only LAGs are displayed.
e All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:
» To configure a single interface, select the check box associated with the port, or type
the port number in the Go To Interface field and click the Go button.

« To configure multiple interfaces with the same settings, select the check box
associated with each interface.

« To configure all interfaces with the same settings, select the check box in the heading
row.

9. Specify the following settings:
« Port Security. Enable or disable the port security feature for the selected interfaces
The default is Disable.

 Max Learned MAC Address. Specify the maximum number of dynamically learned
MAC addresses on the selected interfaces. The default is 4096. If you specify 0, the
selected interfaces do not learn any MAC addresses.

e Max Static MAC Address. Specify the maximum number of statically locked MAC
addresses on the selected interfaces. The default is 48.

* Enable Violation Shutdown. Enable or disable shutdown of the selected interfaces if
a packet with a disallowed MAC address is received. The default value is No, which
means that the option is disabled.

« Enable Violation Traps. Enable or disable the sending of new violation traps if a
packet with a disallowed MAC address is received. The default value is No, which
means that the option is disabled.

10. Click the Apply button.

Your settings are saved.

View learned MAC addresses and convert them to static MAC addresses

After you enabled port security globally (see Configure the global port security mode on
page 297) and enabled port security for specific interfaces (see Configure a port security
interface on page 298), you can convert a dynamically learned MAC address to a statically
locked address.

To view learned MAC addresses for an individual interface or LAG and convert these
MAC addresses to static MAC addresses:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select Security > Traffic Control > Port Security > Security MAC Address.

Traffic Control Port Security Settings

= MAC Filter

Convert Dynamic Address to Static
= Storm Control

Number Of Dynamic MAC Addresses Learned: 0
= Port Security A
* Port Security
Configuration Dynamic MAC Address Table

= Interface Configuration

Port List gl ~
= Security MAC Address
VLAN ID

MAC Address
= Protected Ports

From the Port List menu, select the individual interface.
Port security must be enabled on the selected interface.

The Dynamic MAC Address Table displays the MAC addresses and their associated
VLANS that were learned on the selected port.

Field Description
VLAN ID The VLAN ID corresponding to the MAC address.
MAC Address The MAC addresses learned on a specific port.

To convert the dynamically learned MAC address to a statically locked addresses, select the
Convert Dynamic Address to Static check box.

Click the Apply button.

The dynamic MAC address entries are converted to static MAC address entries in a
numerically ascending order until the static limit is reached.
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The Number of Dynamic MAC Addresses Learned field displays the number of
dynamically learned MAC addresses on a specific port.

10. To refresh the page with the latest information about the switch, click the Refresh button.

Configure protected ports

If you configure a port as protected, it does not forward traffic to any other protected port on
the switch, but it does forward traffic to unprotected ports. You can configure the ports as
protected or unprotected. By default, all ports are unprotected.

To configure protected ports:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > Traffic Control > Protected Port.
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Traffic Control Protected Ports Membership

= MAC Filter v
Il unit 1
= Storm Control

= Port Security v Ports 1 3 9 M 19 21

5 i 13 15 1% 23 25
I e
LI LI LU L)

In the Ports table, click each port that you want to configure as a protected port.

Protected ports are marked with a check mark. No traffic forwarding is possible between

two protected ports.
Click the Apply button.

Your settings are saved.

Configure access control lists

Access control lists (ACLs) ensure that only authorized users can access specific resources
while blocking any unwarranted attempts to reach network resources. ACLs are used to
provide traffic flow control, restrict contents, decide which types of traffic are forwarded or
blocked, and provide security for the network. The switch supports a total of 100 ACLs, which
can be a combination of MAC ACLS, basic or extended IPv4 ACLs, and IPv6 ACLSs.

To configure an ACL.:

1.
2.
3.

4.

Create an IPv4-based, IPv6-based, or MAC-based ACL ID.
Create a rule and assign it to a unique ACL ID.

Define the rules, which can identify protocols, source, and destination IP and MAC

addresses, and other packet-matching criteria.
Use the ID number to assign the ACL to a port or to a LAG.

To view ACL configuration examples, see Access control lists (ACLs) on page 411.
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Use the ACL Wizard to create a simple ACL

The ACL Wizard helps you create a simple ACL and apply it to the selected ports easily and
quickly. First, select an ACL type to use when you create an ACL. Then add an ACL rule to
this ACL and apply this ACL on the selected ports.

Note: The steps in the following procedure describe how you can create an
ACL based on the destination MAC address. If you select a different
type of ACL (or example, an ACL based on a source IPv4), the page
displays different information.

Use the ACL Wizard to create an ACL
To use the ACL Wizard to create an ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > ACL > ACL Wizard.
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ACL Type Selection

ACL Type ACL Based on Destination MAC ~

ACL Based on Destination MAC

_||| Sequence Number || Action Match Every | Destination MAC Destination MAC Mask VLAN

v -

Binding Configuration

Direction Inbound v

- Unit 1
11 13 15 17

T
LLLL LU LU Ll

il G

"
L L]

From the ACL Type menu, select the type of ACL.

You can select from the following ACL types:
« ACL Based on Destination MAC. Creates an ACL based on the destination MAC
address, destination MAC mask, and VLAN.

« ACL Based on Source MAC. Creates an ACL based on the source MAC address,
source MAC mask, and VLAN.

« ACL Based on Destination IPv4. Creates an ACL based on the destination IPv4
address and IPv4 address mask.

« ACL Based on Source IPv4. Creates an ACL based on the source |IPv4 address and
IPv4 address mask.

« ACL Based on Destination IPv6. Creates an ACL based on the destination IPv6
prefix and IPv6 prefix length.

e ACL Based on Source IPv6. Creates an ACL based on the source IPv6 prefix and
IPv6 prefix length.

« ACL Based on Destination IPv4 L4 Port. Creates an ACL based on the destination
IPv4 Layer 4 port number.

« ACL Based on Source IPv4 L4 Port. Creates an ACL based on the source IPv4
Layer 4 port number.

« ACL Based on Destination IPv6 L4 Port. Creates an ACL based on the destination
IPv6 Layer 4 port number.

« ACL Based on Source IPv6 L4 Port. Creates an ACL based on the source IPv6
Layer 4 port number.

Note: For L4 port options, two rules are created (one for TCP and one for
UDP).
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8. Inthe Sequence Number field, enter a whole number in the range of 1 to 2147483647 that

is used to identify the rule.

9. From the Action menu, select Permit or Deny to specify the action that must be taken if a
packet matches the rule’s criteria.

10. From the Match Every menu, select one of the following options:

+ False. Packets do not need to match the selected ACL and rule. With this selection,
you can add a destination MAC address, destination MAC mask, and VLAN.

* True. All packets must match the selected ACL and rule and are either permitted or
denied. In this case, since all packets match the rule, the option of configuring other
match criteria is not offered.

11. Specify the additional match criteria for the selected ACL type.

The rest of the rule match criteria fields available for configuration depend on the selected
ACL type. For information about the possible match criteria fields, see the following table.

ACL Based On Fields

Destination MAC .

Destination MAC. Specify the destination MAC address to compare against
an Ethernet frame. The format is xx:xx:xx:xx:xx:xx. The BPDU keyword
might be specified using a destination MAC address of 01:80:C2:XX:XX:XX.
Destination MAC Mask. Specify the destination MAC address mask, which
represents the bits in the destination MAC address to compare against an
Ethernet frame. The format is xx:xx:xx:xx:xx:xx. The BPDU keyword might
be specified using a destination MAC mask of 00:00:00:ff:ff:ff.

VLAN. Specify the VLAN ID to match within the Ethernet frame.

Source MAC .

Source MAC. Specify the source MAC address to compare against an
Ethernet frame. The format is XX:XX:XX:XX:XX:XX.

Source MAC Mask. Specify the source MAC address mask, which
represents the bits in the source MAC address to compare against an
Ethernet frame. The format is (XX:XX:XX:XX:XX:XX).

VLAN. Specify the VLAN ID to match within the Ethernet frame.

Destination IPv4 .

Destination IP Address. Specify the destination IP address.
Destination IP Mask. Specify the destination IP address mask.

Source IPv4 .

Source IP Address. Specify the source IP address.
Source IP Mask. Specify the source IP address mask.

Destination IPv6 .

Destination Prefix. Specify the destination prefix.
Destination Prefix Length. Specify the destination prefix length.

Source IPv6 .

Source Prefix. Specify the source destination prefix.
Source Prefix Length. Specify the source prefix length.

Destination IPv4 L4 Port

Destination L4 port (protocol). Specify the destination IPv4 L4 port
protocol.

Destination L4 port (value). Specify the destination IPv4 L4 port value.

Source IPv4 L4 Port .

Source L4 port (protocol). Specify the source IPv4 L4 port protocol.
Source L4 port (value). Specify the source IPv4 L4 port value.
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ACL Based On Fields

Destination IPv6 L4 Port « Destination L4 port (protocol). Specify the destination IPv6 L4 port
protocol.

« Destination L4 port (value). Specify the destination IPv6 L4 port value.

Source IPv6 L4 Port + Source L4 port (protocol). Specify the source IPv6 L4 port protocol.
e Source L4 port (value). Specify the source IPv6 L4 port value.

12. As a sample, the following steps describe how you can create an ACL based on the
destination MAC address:

a. Inthe Destination MAC field, specify the destination MAC address that must be
compared against the information in an Ethernet frame.

The format is xx:xx:xx:xx:xx:xx. The BPDU keyword can be specified using a
destination MAC address of 01:80:C2:XX:XX:XX.

b. Inthe Destination MAC Mask field, specify the destination MAC address mask that
must be compared against the information in an Ethernet frame.

The format is xx:xx:xx:xx:xx:xx. The BPDU keyword can be specified using a
destination MAC mask of 00:00:00:ff:ff:ff.

c. Inthe VLAN ID field, specify which VLAN must be compared against the information
in an Ethernet frame.

The range is from 1 to 4093. Either a VLAN range or VLAN can be configured.

13. In the Binding Configuration section, from the Direction menu, select the packet filtering
direction for the ACL.

Only the inbound direction is valid.

14. In the Ports and LAG tables in the Binding Configuration section, select the ports and LAGs
to which the ACL must be applied.

15. Click the Add button.
The rule is added to the ACL.
16. Click the Apply button.

Your settings are saved.

Modify an ACL rule that you created with the ACL Wizard
To modify an ACL rule that you created with the ACL Wizard:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > ACL Wizard.
The ACL Wizard page displays.

7. Select check box that is associated with the rule.
8. Update the match criteria as needed.
9. Click the Apply button.

Your settings are saved.

Delete an ACL rule that you created with the ACL Wizard
To delete an ACL rule that you created with the ACL Wizard:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:

« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password

at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter

the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on

page 30.
5. Click the Login button.

The System Information page displays.

6. Select Security > ACL > ACL Wizard.

The ACL Wizard page displays.

7. Select check box that is associated with the rule.

8. Click the Delete button.

The rule is removed.

ACL Wizard Example

In the following figure, the ACL rule is configured to check for packet matches on ports 8, 10,
11, and 13 and on LAG 1. Only the Inbound option is valid. Packets that include a source
address in the 192.168.3.0/16 network are forwarded by the interfaces. All other packets are

dropped because every ACL includes an implicit deny all rule as the last rule.

ACL Type Selection

ACL Type ACL Based on Source IPvd

ACL Based on Source IPv4

[]| Sequence Number | Action Match Every Source IP Address

1 Permit ~ | False ~ 192.168.3.0

Binding Configuration

Source IP Mask
2565.255.0.0

Direction Inbound v

B unit 1

Ports 1 3 5 7 9 11 13 15 17 19 72‘\#72.?:7 25
.IIIIII.}QE-
1] (L)

2 4 6 g8 10 12 14 16 18 20 22 24 26

For information about the ACL Wizard, see Use the ACL Wizard to create a simple ACL on

page 304.
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Configure a MAC ACL

A MAC ACL consists of a set of rules that are matched sequentially against a packet. When a
packet meets the match criteria of a rule, the specified rule action (Permit or Deny) is taken,
and the additional rules are not checked for a match.

The following steps are involved in defining a MAC ACL and applying it to the switch:

1. Create a MAC ACL ID (see Configure a MAC ACL on page 310).
2. Create a MAC rule (see Configure MAC ACL rules on page 313).
3. Associate the MAC ACL with one or more interfaces (see Configure MAC bindings on

page 317).

You can view or delete MAC ACL configurations in the MAC Binding table (see View or
delete MAC ACL bindings in the MAC binding table on page 319.

Add a MAC ACL
To add a MAC ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC ACL.

Manage Device Security 310 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

MAC ACL

Current Number of ACL

Maximum ACL

MAC ACL Table

|_I| Name Rules Direction

The MAC ACL Table displays the number of ACLs currently configured in the switch and
the maximum number of ACLs that can be configured. The current size is equal to the
number of configured IPv4 and IPv6 ACLs plus the number of configured MAC ACLSs.

7. In the Name field, specify a name for the MAC ACL.

The name string can include alphabetic, numeric, hyphen, underscore, or space
characters only. The name must start with an alphabetic character.

8. Click the Add button.
The MAC ACL is added.
Each configured ACL displays the following information:

* Rules. The number of rules currently configured for the MAC ACL.

« Direction. The direction of packet traffic affected by the MAC ACL, which can be
Inbound or blank.

Change the name of a MAC ACL
To change the name of a MAC ACL.:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC ACL.
The MAC ACL page displays.

7. Select check box that is associated with the rule.
8. In the Name field, specify the new name.
9. Click the Apply button.

Your settings are saved.

Delete a MAC ACL
To delete a MAC ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
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6. Select Security > ACL > Basic > MAC ACL.
The MAC ACL page displays.

7. Select check box that is associated with the rule.
8. Click the Delete button.

The rule is removed.

Configure MAC ACL rules

You can define rules for MAC-based ACLs. The access list definition includes rules that
specify whether traffic matching the criteria is forwarded normally or discarded. A default
deny all rule is the last rule of every list.

Add a rule to a MAC ACL
To add arule to a MAC ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC Rules.

Manage Device Security 313 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

Rules

ACL Name ”

Rule Table

Sequence Number Action Assign Mirror Redirect Match

(1 to 2147483647) A Interface  Interface | Every CoS Destination MAC Destination MAC Mask

w w w w

The previous figure does not show all columns.

7. From the ACL Name menu, select the MAC ACL.

8. Inthe Sequence Number field, enter a whole number in the range from 1 to 2147483647 to
identify the rule.

9. From the Action menu, select the action that must be taken if a packet matches the rule’s
criteria:

* Permit. Forwards packets that meet the ACL criteria.
e Deny. Drops packets that meet the ACL criteria.

10. In the Assign Queue field, specify the hardware egress queue identifier that must be used
to handle all packets matching this ACL rule.

The range for the queue ID is from O to 7.

11. From the Mirror Interface menu, select the specific egress interface to which the matching
traffic stream must be copied, in addition to being forwarded normally by the switch.

This field cannot be set if a redirect interface is already configured for the ACL rule. This
field is visible for a Permit action.

12. From the Redirect Interface menu, select the egress interface to which the matching traffic
stream must be redirected, bypassing any forwarding decision normally performed by the
switch.

This field cannot be set if a mirror interface is already configured for the ACL rule.

13. From the Match Every menu, select whether each Layer 2 MAC packet must be matched
against the rule:

e True. Each packet must match the selected ACL rule.
* False. Not all packets need to match the selected ACL rule.

14. In the CoS field, specify the 802.1p priority that must be compared against the information in
an Ethernet frame.

The range for the priority is from O to 7.

15. In the Destination MAC field, specify the destination MAC address that must be compared
against the information in an Ethernet frame.

The format is xx:xx:xx:xx:xx:xx. The BPDU keyword can be specified using a destination
MAC address of 01:80:C2:XX:XX:XX.
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16. In the Destination MAC Mask field, specify the destination MAC address mask that must
be compared against the information in an Ethernet frame.

The format is xx:xx:xx:xx:xx:xx. The BPDU keyword can be specified using a destination
MAC mask of 00:00:00:ff:ff:ff.

17. From the EtherType Key menu, select the EtherType value that must be compared against
the information in an Ethernet frame.

The values are as follows:

e Apple Talk
« IBM SNA
« IPv4

e IPv6

+ IPX

e MPLS Multicast
e MPLS Unicast

 NetBios
*  Novell
« PPPOE
* RARP

 User Value

18. If you select User Value from the EtherType Key menu, in the EtherType User Value field,
specify the customized EtherType value that must be used.

This value must be compared against the information in an Ethernet frame. The range is
from 0x0600 to OxFFFF.

19. In the Source MAC field, specify the source MAC address that must be compared against
the information in an Ethernet frame.

The format is XX:XX:XX: XX XX:XX.

20. In the Source MAC Mask field, specify the source MAC address mask that must be
compared against the information in an Ethernet frame.

The format is XX:XX:XX:XX:XX:XX.

21. In the VLAN field, specify the VLAN ID that must be compared against the information in an
Ethernet frame.

The range is from 1 to 4093. You can configure either a single VLAN or a VLAN range.
22. From the Logging menu, select whether to enable or disable logging.

If you select Enable, logging is enabled for this ACL rule (subject to resource availability
on the switch).

23. Click the Add button.
The rule is added.
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Change the match criteria for a MAC rule

To change the match criteria for a MAC rule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC Rules.
The MAC Rules page displays.

7. Select the check box that is associated with the rule.
8. Modify the fields as needed.
9. Click the Apply button.

Your settings are saved.

Delete a rule fora MAC ACL

To delete a rule for a MAC.:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC Rules.
The MAC Rules page displays.

7. Select the check box that is associated with the rule.
Click the Delete button.

The rule is removed.

Configure MAC bindings

When an ACL is bound to an interface, all the rules that are defined are applied to the
selected interface. You can assign MAC ACLs to interfaces and LAGs.

To configure MAC bindings:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

Manage Device Security 317 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:

« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

6. Select Security > ACL > Basic > MAC Binding Configuration.

ACL MAC Binding Configuration
= ACL Wizard ACLID o
#BasIE " Direction Inbound ~
MasAck Sequence Number 0 (1 to 4294967205)

- MAC Rules

-MAC Binding -Unm
Configuration Pots 1 3 5 7 9 11 13 15 17 19 21 23 25
+ Binding Table -------------
= Advanced v
2 4 6 8 10 12 14 16 18 20 2 24 26
[ e

Interface Binding Status

Interface Direction ACL Type ACL ID Sequence Number

7. From the ACL ID menu, select an ACL.

The fixed selection from the Direction menu is Inbound, which means that MAC ACL
rules are applied to traffic entering the interface.

In the Sequence Number field, optionally specify a number to indicate the order of the
access list relative to other access lists already assigned to the interface and direction.

A low number indicates high precedence order. If a sequence number is already in use
for the interface and direction, the specified access list replaces the currently attached
access list using that sequence number. If you do not specify the sequence number, a
sequence number that is one number greater than the highest sequence number
currently in use for the interface and direction is used. The range is from 1 to
4294967295.
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9. To add the selected ACL to a port or LAG, in the Ports table or LAG table, click the port or
LAG so that a check mark displays.

You can add the ACL to several ports and LAGs.

The Ports and LAG tables display the available and valid interfaces for ACL binding. All
nonrouting physical interfaces, VLAN interfaces, and interfaces participating in LAGs are
listed.

10. Click the Apply button.
Your settings are saved.
The following table describes the columns in the Interface Binding Status table on the page.

Table 55. Interface Binding Status table

Field Description

Interface The interface of the ACL assigned.

Direction The selected packet filtering direction for the ACL.

ACL Type The type of ACL assigned to the selected interface and direction.

ACL ID The ACL name identifying the ACL assigned to the selected interface and direction.

Sequence Number The sequence number signifying the order of the specified ACL relative to other ACLs
assigned to the selected interface and direction.

View or delete MAC ACL bindings in the MAC binding
table

You can view or delete the MAC ACL bindings in the MAC binding table.

To view or delete MAC ACL bindings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

» Afterinitial login, enter your local device password.
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By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Basic > MAC Binding Table.

The previous figure shows examples.

7. To delete a MAC ACL-to-interface binding, do the following:
a. Select the check box next to the interface.
b. Click the Delete button.

The binding is removed.
The following table describes the nonconfigurable information on the page.

Table 56. MAC Binding Table

Field Description

Interface The interface of the ACL assigned.

Direction The selected packet filtering direction for the ACL.

ACL Type The type of ACL assigned to the selected interface and direction.

ACL ID The ACL name identifying the ACL assigned to the selected interface and direction.

Sequence Number  The sequence number signifying the order of the specified ACL relative to other ACLs
assigned to the selected interface and direction.

Configure a basic or extended IPv4 ACL

An IPv4 ACL consists of a set of rules that are matched sequentially against a packet. When
a packet meets the match criteria of a rule, the specified rule action (Permit or Deny) is taken,
and the additional rules are not checked for a match. You must specify the interfaces to
which an IPv4 ACL applies, as well as whether it applies to inbound or outbound traffic.
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Multiple steps are involved in defining an IPv4 ACL and applying it to the switch:
1. Add an IPv4 ACL ID (see Configure a basic or extended IPv4 ACL on page 320).

The differences between a basic IPv4 ACL and an extended IPv4 ACL are as follows:

* Numbered ACL from 1 to 99. Creates a basic IPv4 ACL, which allows you to permit
or deny traffic from a source IP address.

* Numbered ACL from 100 to 199. Creates an extended IPv4 ACL, which allows you
to permit or deny specific types of Layer 3 or Layer 4 traffic from a source IP address
to a destination IP address. This type of ACL provides more granularity and filtering
capabilities than the basic IP ACL.

« Named IP ACL. Create an extended IPv4 ACL with a name string that is up to 31
alphanumeric characters in length. The name must start with an alphabetic character.

2. Create an IPv4 rule (see Configure rules for a basic IPv4 ACL on page 324 or
Configure rules for an extended IPv4 ACL on page 329).

3. Associate the IPv4 ACL with one or more interfaces (see Configure IP ACL interface
bindings on page 347).

You can view or delete IPv4 ACL configurations in the IP ACL Binding table (see View or
delete IP ACL bindings in the IP ACL binding table on page 349.

Add an IPv4 ACL
To add an IPv4 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.
The System Information page displays.

6. Select Security > ACL > Advanced > IP ACL.

IP ACL Cenfiguration

Current Mumber of ACL

Maximum ACL

IP ACL Table

IP ACLID Rules Type

|—

0 Basic IP ACL

The previous figure shows an example.

The IP ACL page shows the current size of the ACL table compared to the maximum size
of the ACL table. The current size is equal to the number of configured IPv4 and IPv6
ACLs plus the number of configured MAC ACLs. The maximum size is 100.

The Current Number of ACL field displays the current number of all ACLs configured on
the switch.

The Maximum ACL field displays the maximum number of IP ACLs that can be
configured on the switch.

7. Inthe IP ACL ID field, specify the ACL ID or IP ACL name, which depends on the IP ACL
type. The IP ACL ID is an integer in the following range:

e 1-99. Creates a basic IP ACL, which allows you to permit or deny traffic from a source
IP address.

e 100-199. Creates an extended IP ACL, which allows you to permit or deny specific
types of Layer 3 or Layer 4 traffic from a source IP address to a destination IP
address. This type of ACL provides more granularity and filtering capabilities than the
standard IP ACL.

 IP ACL Name. Create an extended IP ACL with a name string that is up to
31 alphanumeric characters in length. The name must start with an alphabetic
character.

Each configured ACL displays the following information:

* Rules. The number of rules currently configured for the IPv4 ACL.

* Type. Identifies the ACL as a basic IP ACL (with ID from 1 to 99), extended IP ACL
(with 1D from 100 to 199 or a name).

8. Click the Add button.
The IP ACL is added.
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Change the number or name of an IPv4 ACL

To change the number or name of an IPv4 ACL:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP ACL.
The IP ACL Configuration page displays.

7. Select the check box that is associated with the IP ACL.
8. Inthe IP ACL field, specify the new number or name.
9. Click the Apply button.

Your settings are saved.

Delete an IPv4 ACL
To delete an IPv4 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
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3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP ACL.

The IP ACL Configuration page displays.
7. Select the check box that is associated with the IP ACL.
8. Click the Delete button.

The IP ACL is removed.

Configure rules for a basic IPv4 ACL

You can define rules for IP-based standard ACLs (basic ACLs). The access list definition
includes rules that specify whether traffic matching the criteria is forwarded normally or
discarded.

Note: An implicit deny all rule is included at the end of an ACL list. This
means that if an ACL is applied to a packet, and if none of the explicit
rules match, then the final implicit deny all rule applies and the packet
is dropped.
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Add a rule for a basic IPv4 ACL
To add arule for a basic IPv4 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Rules.

IP Rules

ACLID 1

Basic ACL Rule Table

Assign Match ~ Mimor Redirect Source Source

% ; ;
S SO R Lo Queue ld Every Interface Interface IP Address IP Mask

1 Permit False g1 10.131.6.8 | 255.255.255.255

If no rules exist, the Basic ACL Rule Table might show the message No rules were
configured for this ACL. If one or more rules exist for the ACL, the rules display in the
Basic ACL Rule Table.

7. From the ACL ID menu, select the IP ACL for which you want to add a rule.
For basic IP ACLs, this must be an ID in the range from 1 to 99.
8. Click the Add button.
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Standard ACL Rule Configuration(1-99)
ACLID 1
Sequence Number 0
Action Permit Egress Queue {0to7)
® Deny
Logging ® Disable O Enable
Match Every ® Disable © Enable
Interface ® Mirror
Redirect
Source
IP Address
Source
IP Mask

9. Specify the following match criteria for the rule:

* Sequence Number. Enter an ACL sequence number in the range from 1 to
2147483647 that is used to identify the rule. An IP ACL can contain up to 50 rules.

* Action. Select the ACL forwarding action, which is one of the following:
- Permit. Forward packets that meet the ACL criteria.

Egress Queue. If the selection form the Action menu is Permit, you can specify
the hardware egress queue identifier that is used to handle all packets matching
this IP ACL rule. The range of queue IDs is from 0 to 7.

- Deny. Drop packets that meet the ACL criteria.

Logging. If the selection from the Action menu is Deny, you can enable logging
for the ACL by selecting the Enable radio button. (Logging is subject to resource
availability on the switch.)

e Match Every. Select one of the radio buttons to specify whether all packets must
match the selected IP ACL rule:

- Enable. All packets must match the selected IP ACL rule and are either permitted
or denied.

- Disable. Not all packets need to match the selected IP ACL rule.

» Interface. Select one of the radio buttons to specify whether all packets must be
mirrored or redirected:

- Mirror. From the menu, select the specific egress interface to which the matching
traffic stream must be copied, in addition to being forwarded normally by the
switch.

- Redirect. From the menu, select the egress interface to which the matching traffic
stream must be redirected, bypassing any forwarding decision normally
performed by the switch.

e Source IP Address. Enter an IP address using dotted-decimal notation to be
compared to a packet’s source IP address as a match criterion for the selected IP
ACL rule.
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» Source IP Mask. Specify the IP mask in dotted-decimal notation to be used with the
source IP address value.

10. Click the Apply button.

Your settings are saved.

Modify the match criteria for a basic IPv4 ACL rule

To modify the match criteria for a basic IPv4 ACL rule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Rules.
The IP Rules page displays.

7. From the ACL ID menu, select the ACL that includes the rule that you want to modify.
In the Basic ACL Rule Table, click the rule.

The rule is a hyperlink. The Standard ACL Rule Configuration page displays.

9. Modify the basic IP ACL rule criteria.
10. Click the Apply button.

Your settings are saved.
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Delete a basic IPv4 ACL rule
To delete a basic IPv4 ACL rule:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Rules.
The IP Rules page displays.

7. From the ACL ID menu, select the ACL that includes the rule that you want to modify.
8. In the Basic ACL Rule Table, select the check box that is associated with the rule.
9. Click the Delete button.

The rule is removed.
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Configure rules for an extended IPv4 ACL

You can define rules for extended IPv4 ACLs. The access list definition includes rules that
specify whether traffic matching the criteria is forwarded normally or discarded.

Note: An implicit deny all rule is included at the end of an ACL list. This means
that if an ACL is applied to a packet and if none of the explicit rules match,
then the final implicit deny all rule applies and the packet is dropped.

Add a rule for an extended IPv4 ACL
To add arule for an extended IPv4 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Extended Rules.
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IP Rules

ACL ID 101 ~

Extended ACL Rule Table

- - Assign Mirror Redirect  Match Protocol  Source Source Source L4 | Source L4 | Source L4 Source L4
L} iEequeace Rtmtar Bz |Cogqen Queue ID | Interface  Interface Every Type IP Address  IP Mask Port Action | Port Start Port  End Port

2 Deny False 4 (IP) 203.0.113.0 255.255.255.0

The previous figure does not show all columns on the page.

If no rules exists, the Extended ACL Rule Table might show the message No rules were
configured for this ACL. If one or more rules exist for the ACL, the rules display in the
Extended ACL Rule Table.

7. From the ACL ID/Name menu, select the IP ACL for which you want to add a rule.
For extended IP ACLs, this must be an ID in the range from 100 to 199 or a name.
8. Click the Add button.

Extended ACL Rule Configuration(100-199)
ACL ID/Name 101
Sequence Number 0
Action D Permit Egress Queue ¢ (0ta7)
® Deny
Logging ® Disable Enable
Interface ® Mirror
Redirect
Match Every False ~
Protocaol Type 1 ~ (0 to 255)
Sre ® IP Address
@ Host
Sre L4 ® Port - v (0 to 65535)
Range Start Port v (0 to 65535) End Port " (0 to 65535)
Dt ® IP Address
Host
Dst L4 ® Port “ (0 to 65535)
Range Start Port v (0 fo 65535) End Port - (0 to 65535)
IGMP Type (0 to 255)
ICMP Type (0t0 255) Code (0 fo 255)
= Message
Fragmenis ® Disable Enable
Service Type ® IP DSCP other v (0 to 63)
IP Precedence v (0te7)
) IPTOS (01 )

9. Configure the following match criteria for the rule:

e Seqguence Number. Enter a number in the range from 1 to 2147483647 that is used to
identify the rule. An extended IP ACL can contain up to 50 rules.

e Action. Select the ACL forwarding action, which is one of the following:
- Permit. Forward packets that meet the ACL criteria.

Egress Queue. If the selection from the Action menu is Permit, select the
hardware egress queue identifier that is used to handle all packets matching this
IP ACL rule. The range of queue IDsis 0 to 7.

- Deny. Drop packets that meet the ACL criteria.
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Logging. If the selection form the Action menu is Deny, you can enable logging
for the ACL by selecting the Enable radio button. (Logging is subject to resource
availability in the device.)

* |Interface. For a Permit action, use either a mirror interface or a redirect interface:

- Select the Mirror radio button and use the menu to specify the egress interface to
which the matching traffic stream is copied, in addition to being forwarded
normally by the device.

- Select the Redirect radio button and use the menu to specify the egress interface
to which the matching traffic stream is forced, bypassing any forwarding decision
normally performed by the device.

» Match Every. Select one of the radio buttons to specify whether all packets must
match the selected IP ACL rule:

- False. Not all packets need to match the selected IP ACL rule. You can configure
other match criteria on the page.

- True. All packets must match the selected IP ACL rule and are either permitted or
denied. In this case, you cannot configure other match criteria on the page.

* Protocol Type. From the menu, select a protocol that a packet’s IP protocol must be
matched against: IP, ICMP, IGMP, TCP, UDP, EIGRP, GRE, IPINIP, OSPF, PIM, or
Other. If you select Other, enter a protocol number from 0 to 255.

» Src. In the Src field, enter a source IP address, using dotted-decimal notation, to be
compared to a packet’s source IP address as a match criterion for the selected IP
ACL rule:

- If you select the IP Address radio button, enter an IP address or an IP address
range. You can enter a relevant wildcard mask to apply this criteria. If this field is
left empty, it means any.

- If you select the Host radio button, the wildcard mask is configured as 0.0.0.0. If
this field is left empty, it means any.

The wildcard mask determines which bits are used and which bits are ignored. A
wildcard mask of 0.0.0.0 indicates that none of the bits are important. A wildcard of
255.255.255.255 indicates that all of the bits are important.

e Src L4. The options are available only when the protocol is set to TCP or UDP. Use the
source L4 port option to specify relevant matching conditions for L4 port numbers in
the extended ACL rule.

You can select either the Port radio button or the Range radio button:
- Port. If you select the Port radio button, you can either enter the port number
yourself or select one of the following protocols from the menu:

« The source IP TCP port protocols are domain, echo, ftp, ftpdata, www-http,
smtp, telnet, pop2, pop3, and bgp.

* The source IP UDP port protocols are domain, echo, snmp, ntp, rip, time,
who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.
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Select Other from the menu to enter a port number. If you select Other from the
menu but leave the field blank, it means any.

The only relevant matching condition for L4 port numbers is Equal. This means
that an IP ACL rule matches only if the Layer 4 source port number is equal to the
specified port number or port protocol.

- Range. If you select the Range radio button, the IP ACL rule matches only if the
Layer 4 source port number is within the specified port range. The starting port,
ending port, and all ports in between are a part of the Layer 4 port range.

The Start Port and End Port fields identify the first and last ports that are part of
the port range. The values can range from 0 to 65535.

You can either enter the port range yourself or select one of the following
protocols from the menu:

e The destination IP TCP port protocols are domain, echo, ftp, ftpdata,
www-http, smtp, telnet, pop2, pop3, and bgp.

e The destination IP UDP port protocols are domain, echo, snmp, ntp, rip,
time, who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range. Select Other from the menu to enter a
port number. If you select Other from the menu but leave the field blank, it means
any.

The wildcard mask determines which bits are used and which bits are ignored. A
wildcard mask of 0.0.0.0 indicates that none of the bits are important. A wildcard
of 255.255.255.255 indicates that all of the bits are important.

« Dst. In the Dst field, enter a destination IP address, using dotted-decimal notation, to
be compared to a packet’s destination IP address as a match criterion for the selected
IP ACL rule:

- If you select the IP Address radio button, enter an IP address with a relevant
wildcard mask to apply this criteria. If this field is left empty, it means any.

- If you select the Host radio button, the wildcard mask is configured as 0.0.0.0. If
this field is left empty, it means any.

The wildcard mask determines which bits are used and which bits are ignored. A
wildcard mask of 0.0.0.0 indicates that none of the bits are important. A wildcard of
255.255.255.255 indicates that all of the bits are important.

e Dst L4. The options are available only when the protocol is set to TCP or UDP. Use the
destination L4 port option to specify relevant matching conditions for L4 port numbers
in the extended ACL rule.
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You can select either the Port radio button or the Range radio button:

- Port. If you select the Port radio button, you can either enter the port number
yourself or select one of the following protocols from the menu.

e The destination IP TCP port protocols are domain, echo, ftp, ftpdata,
www-http, smtp, telnet, pop2, pop3, and bgp.

e The destination IP UDP port protocols are domain, echo, snmp, ntp, rip,
time, who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter a port number. If you select Other from the
menu but leave the field blank, it means any.

The only relevant matching condition for L4 port numbers is Equal. This means
that an IP ACL rule matches only if the Layer 4 source port number is equal to the
specified port number or port protocol.

- Range. If you select the Range radio button, the IP ACL rule matches only if the
Layer 4 destination port number is within the specified port range. The starting
port, ending port, and all ports in between are a part of the Layer 4 port range.

The Start Port and End Port fields identify the first and last ports that are part of
the port range. They values can range from 0 to 65535.

You can either select the enter the port range yourself or select one of the
following protocols from the menu:

e The destination IP TCP port range names are domain, echo, ftp, ftpdata,
www-http, smtp, telnet, pop2, pop3, and bgp.

e The destination IP UDP port range names are domain, echo, snmp, ntp, rip,
time, who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter a port number. If you select Other from the
menu but leave the field blank, it means any.

The wildcard mask determines which bits are used and which bits are ignored. A
wildcard mask of 0.0.0.0 indicates that none of the bits are important. A wildcard
of 255.255.255.255 indicates that all of the bits are important.

e IGMP Type. If your selection from the Protocol Type menu is IGMP and you specify
the IGMP type, the IP ACL rule matches the specified IGMP message type. The
range is from 0 to 255. If this field is left empty, it means any.

« ICMP. If your selection from the Protocol Type menu is ICMP, you can select either
the Type or Message radio button:

- If you select the Type radio button, note the following:

e The Type and Code fields are enabled only if the protocol is ICMP. Use these
fields to specify a match condition for ICMP packets:
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« If you specify information in the Type field, the IP ACL rule matches the
specified ICMP message type. The type number can be from 0 to 255.

« If you specify information in the Code field, the IP ACL rule matches the
specified ICMP message code. The code can be from 0 to 255.

« If these fields are left empty, it means any.

- If you select the Message radio button, from the menu, select the type of the
ICMP message to match with the selected IP ACL rule. Specifying a type of
message implies that both the ICMP type and ICMP code are specified. The
ICMP message is decoded into the corresponding ICMP type and ICMP code
within the ICMP type.

The IPv4 ICMP message types are echo, echo-reply, host-redirect,
mobile-redirect, net-redirect, net-unreachable, redirect, packet-too-big,
port-unreachable, source-quench, router-solicitation, router-advertisement,
ttl-exceeded, time-exceeded, and unreachable.

* Fragments. Either select the Enable radio button to allow initial fragments (that is,
the fragment bit is asserted) or leave the default Disable radio button selected to
prevent initial fragments from being used.

This option is not valid for rules that match L4 information such as a TCP port number,
because that information is carried in the initial packet.

e Service Type. Select a service type match condition for the extended IP ACL rule.

The possible options are IP DSCP, IP precedence, and IP TOS, which are alternative
methods to specify a match criterion for the same service type field in the IP header.
Each method uses a different user notation. After you make a selection, you can
specify the appropriate values:

- IP DSCP. This is an optional configuration. Specify the IP DiffServ Code Point
(DSCP) field. The DSCP is defined as the high-order 6 bits of the service type
octet in the IP header. Enter an integer from 0 to 63. To select the IP DSCP, select
one of the DSCP keywords from the menu. To specify a numeric value, select
Other and a field displays in which you can enter numeric value of the DSCP.

- IP Precedence. This is an optional configuration. The IP precedence field in a
packet is defined as the high-order 3 bits of the service type octet in the IP header.
Enter a number from O to 7.

- IP TOS. This is an optional configuration. The IP ToS field in a packet is defined
as all 8 bits of the service type octet in the IP header. The ToS bits value is a
hexadecimal number that is composed of numbers 00 to 09 and AA to FF. The
ToS mask value is a hexadecimal number that is composed of numbers 00 to FF.
The ToS mask denotes the bit positions in the ToS bits value that are used for
comparison against the IP ToS field in a packet.

For example, to check for an IP ToS value for which bit 7 is set and is the most
significant value, for which bit 5 is set, and for which bit 1 is cleared, use a ToS
bits value of OXAO and a ToS mask of OxFF.
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10. Click the Apply button.

Your settings are saved.

Modify the match criteria for an extended IPv4 ACL rule

To modify the match criteria for an existing extended IPv4 ACL rule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Extended Rules.
The IP Rules page displays.

7. From the ACL ID menu, select the ACL that includes the rule that you want to modify.
8. In the Extended ACL Rule Table, click the rule.

The rule is a hyperlink. The Extended ACL Rule Configuration page displays.

9. Modify the extended IP ACL rule criteria.
10. Click the Apply button.

Your settings are saved.
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Delete an extended IPv4 ACL rule

To delete an extended IPv4 ACL rule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IP Extended Rules.
The IP Rules page displays.

7. From the ACL ID menu, select the ACL that includes the rule that you want to delete.
8. In the Extended ACL Rule Table, select the check box that is associated with the rule.
9. Click the Delete button.

The rule is removed.
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Configure an IPv6 ACL

An IPv6 ACL consists of a set of rules that are matched sequentially against a packet. When
a packet meets the match criteria of a rule, the specified rule action (Permit or Deny) is taken,
and the additional rules are not checked for a match. You must specify the interfaces to
which an IPv6 ACL applies, as well as whether it applies to inbound or outbound traffic.

Multiple steps are involved in defining an IPv6 ACL and applying it to the switch:
1. Add an IPv6 ACL ID (see Add an IPv6 ACL on page 337).

An IPv6 ACL must start with a name string that is up to 31 alphanumeric characters in
length. The name must start with an alphabetic character.

2. Create an IPv6 rule (see Configure rules for an IPvé ACL on page 340).

3. Associate the IPv6 ACL with one or more interfaces (see Configure IP ACL interface
bindings on page 347).

You can view or delete IPv6 ACL configurations in the IP ACL Binding table (see View or
delete IP ACL bindings in the IP ACL binding table on page 349.

Add an IPvé6 ACL
To add an IPv6 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.
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The System Information page displays.

6. Select Security > ACL > Advanced > IPv6 ACL.

ACL IPvE Configuration
*ACL Wizerd Current Number of ACL
~Basic Maximum ACL
= Advanced A
«IP ACL
1P Rules IPvG ACL Table
«|P Fxte = a
IP Extended Rules 1PV6 ACL Rules || Type
- IPvG ACL
*IPv6 Rules IPVACL1 0 IPv6 ACL
«|P Binding
Configuration
+ Binding Table

7. Inthe IPv6 ACL field, specify a name to identify the IPv6 ACL.

This is the IPv6 ACL name string, which includes up to 31 alphanumeric characters only.
The name must start with an alphabetic character.

8. Click the Add button.
The IPv6 ACL is added.

The following table describes the nonconfigurable information displayed on the page.

Table 57. IPv6 Configuration and IPv6 ACL Table information

Field Description

Current Number of ACL The current number of the IP ACLs configured on the switch.

Maximum ACL The maximum number of IP ACLs that can be configured on the switch.
Rules The number of the rules associated with the IP ACL.

Type The type is IPv6 ACL.

Change the name of an IPv6 ACL

To change the name of an IPv6 ACL.:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IPv6 ACL.
The IPv6 ACL Configuration page displays.

7. Select the check box that is associated with the IPv6 ACL.
8. Inthe IPv6 ACL field, specify the new name.
9. Click the Apply button.

Your settings are saved.

Delete an IPv6 ACL
To delete an IPv6 ACL:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IPv6 ACL.
The IPv6 Configuration page displays.

7. Select the check box that is associated with the IPv6 ACL.
8. Click the Delete button.

The IPv6 ACL is removed.

Configure rules for an IPv6 ACL

You can define rules for IPv6 ACLs. The access list definition includes rules that specify
whether traffic matching the criteria is forwarded normally or discarded.

Add a rule for an IPv6 ACL
Add arule for an ACL IPv6:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IPv6 Rules.

|Pv Extended Rules

ACL ID/Name IPVACLY

Extended ACL Rule Table

Assign  Match  Protocol | Source Source Source L4 Destination Destination Destination L4
Queue ID  Every Type IP Address  IP Mask Port IP Address  IP Mask Port

No rules have been configured for this ACL

Sequence Number Action Logging

The previous figure does not show all columns on the page.

If no rules exists, the IPv6 ACL Rule Table might show the message No rules were
configured for this ACL. If one or more rules exist for the ACL, the rules display in the
IPv6 Rules table.

7. From the ACL Name menu, select the IPv6 ACL for which you want to add a rule.
An IPv6 ACL can contain up to 50 rules.
8. Click the Add button.

1PV ACL Rule Configuration
ACL ID/Name IPvE_ACL_1
Sequence Number o
Action Permit Egress Queue | {0l 7)
® Deny
Logging ® Disable Enable
Interface ® Mirror
Redirect
Match Every False ~
Protocol Type IPVE v (0 to 255)
Sre ® |P Address
Host
Src L4 % Port . - (0 to 65535)
Range Start Port . (0 to 65535) End Port - (0 to 65535)
Dst ® IP Address
Host
DstL4 s Port (0 to 65535)
Range Start Port {0 to 65535) End Port (0 to 65535)
ICMPvE Type (0 to 255) Code (0 to 255)
* Message
Fragments ® Disable Enable
Routing ® Disable Enable
IPvE DSCP Service other ~ (0 to 63)
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9. Configure the following match criteria for the rule:

« Action. Select the ACL forwarding action by selecting one of the following radio
buttons:

- Permit. Forward packets that meet the ACL criteria.
- Deny. Drop packets that meet the ACL criteria.

» Egress Queue. If you select the Permit radio button, select the hardware egress
queue identifier that is used to handle all packets matching this IPv6 ACL rule. The
range of queue IDsis 0 to 7.

« Logging. If you select the Deny radio button, you can enable logging for the ACL by
selecting the Enable radio button. (Logging is subject to resource availability in the
device.)

If the access list trap flag is also enabled, periodic traps are generated, indicating the
number of times this rule was evoked during the report interval. A fixed five-minute
report interval is used for the switch. A trap is not issued if the ACL rule hit count is
zero for the current interval.

* Interface. For a Permit action, use either a mirror interface or a redirect interface:

- Select the Mirror radio button and use the menu to specify the egress interface to
which the matching traffic stream is copied, in addition to being forwarded
normally by the device.

- Select the Redirect radio button and use the menu to specify the egress interface
to which the matching traffic stream is forced, bypassing any forwarding decision
normally performed by the device.

e Match Every. Select whether all packet must match the selected IPv6 ACL rule:

- False. Not all packets need to match the selected IPv6 ACL rule. You can
configure other match criteria on the page.

- True. All packets must match the selected IPv6 ACL rule and are either permitted
or denied. In this case, you cannot configure other match criteria on the page.

« Protocol Type. Specify the IPv6 protocol type in one of the following ways:
- From the Protocol Type menu, select IPv6, ICMPv6, TCP, or UDP.

- From the Protocol Type menu, select Other, and in the associated field, specify
an integer ranging from 0 to 255. This number represents the IPv6 protocol.

e Src. In the Src field, enter a source IPv6 address or source IPv6 address range to be
compared to a packet’s source IPv6 address as a match criterion for the selected
IPv6 ACL rule:

- If you select the IPv6 Address radio button, enter an IPv6 address or IPv6 range
to apply this criteria. If this field is left empty, it means any.

- Ifyou select the Host radio button, enter a host source IPv6 address to match the
specified IPv6 address. If this field is left empty, it means any.

The source IPv6 address argument must be in the form documented in RFC 2373
where the address is specified in hexadecimal numbers using 16-bit values between
colons.
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» Src L4. The options are available only when the protocol is set to TCP or UDP. Use the
source L4 port option to specify relevant matching conditions for L4 port numbers in
the extended ACL rule.

You can select either the Port radio button or the Range radio button:

- Port. If you select the Port radio button, you can either enter the port number
yourself or select one of the following protocols from the menu:

» The source IP TCP port protocols are domain, echo, ftp, ftpdata, www-http,
smtp, telnet, pop2, pop3, and bgp.

* The source IP UDP port protocols are domain, echo, snmp, ntp, rip, time,
who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter a port number. If you select Other from the
menu but leave the field blank, it means any.

The only relevant matching condition for L4 port numbers is Equal. This means
that an IPv6 ACL rule matches only if the Layer 4 source port number is equal to
the specified port number or port protocol.

- Range. If you select the Range radio button, the IPv6 ACL rule matches only if
the Layer 4 source port number is within the specified port range. The starting
port, ending port, and all ports in between are a part of the Layer 4 port range.

The Start Port and End Port fields identify the first and last ports that are part of
the port range. They values can range from 0 to 65535.

You can either enter the port range yourself or select one of the following
protocols from the menu:

» The source IP TCP port protocols are domain, echo, ftp, ftpdata, www-http,
smtp, telnet, pop2, pop3, and bgp.

* The source IP UDP port protocols are domain, echo, snmp, ntp, rip, time,
who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter port numbers. If you select Other from the
menu but leave the fields blank, it means any.

» Dst. In the Dst field, enter a destination IPv6 address to be compared to a packet’s
destination IPv6 address as a match criterion for the selected IPv6 ACL rule:

- If you select the IPv6 Address radio button, enter an IPv6 address to apply this
criteria. If this field is left empty, it means any.

- Ifyou select the Host radio button, enter a host source IPv6 address to match the
specified IPv6 address. If this field is left empty, it means any.
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The source IPv6 address argument must be in the form documented in RFC 2373
where the address is specified in hexadecimal numbers using 16-bit values between
colons.

« Dst L4. The options are available only when the protocol is set to TCP or UDP. Use the
destination L4 port option to specify relevant matching conditions for L4 port numbers
in the extended ACL rule.

You can select either the Port radio button or the Range radio button:
- Port. If you select the Port radio button, you can either enter the port number
yourself or select one of the following protocols from the menu:

e The destination IP TCP port protocols are domain, echo, ftp, ftpdata,
www-http, smtp, telnet, pop2, pop3, and bgp.

e The destination IP UDP port protocols are domain, echo, snmp, ntp, rip,
time, who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter a port number. If you select Other from the
menu but leave the field blank, it means any.

The only relevant matching condition for L4 port numbers is Equal. This means
that an IPv6 ACL rule matches only if the Layer 4 destination port number is equal
to the specified port number or port protocol.

- Range. If you select the Range radio button, the IPv6 ACL rule matches only if
the Layer 4 destination port number is within the specified port range. The starting
port, ending port, and all ports in between are a part of the Layer 4 port range.

The Start Port and End Port fields identify the first and last ports that are part of
the port range. They values can range from 0 to 65535.

You can either enter the port range yourself or select one of the following
protocols from the menu:

* The destination IP TCP port protocols are domain, echo, ftp, ftpdata,
www-http, smtp, telnet, pop2, pop3, and bgp.

» The destination IP UDP port protocols are domain, echo, snmp, ntp, rip,
time, who, and tftp.

Each of these values translates into its equivalent port number, which is used as
both the start and end of the port range.

Select Other from the menu to enter port numbers. If you select Other from the
menu but leave the fields blank, it means any.

« |ICMPv6. Select either the Type or Message radio button:
- If you select the Type radio button, note the following:

e The Type and Message fields are enabled only if the protocol is ICMPv6. Use
these fields to specify a match condition for ICMPV6 packets.

Manage Device Security 344 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

» The IPv6 ACL rule matches the specified ICMPv6 message type. Possible
type numbers are in the range from 0 to 255.

* If you specify information in the Message field, the IPv6 ACL rule matches the
specified ICMPv6 message code. Possible values for code can be in the
range from O to 255.

» If these fields are left empty, it means any.

- Ifyou select the Message radio button, select the type of the ICMPv6 message to
match with the selected IPv6 ACL rule. Specifying a type of message implies that
both the ICMPV6 type and ICMPV6 code are specified. The ICMPv6 message is
decoded into the corresponding ICMPV6 type and ICMPv6 code within the ICMP

type.

The ICMPv6 message types are destination-unreachable, echo-reply,
echo-request, header, hop-limit, mld-query, mld-reduction, mld-report,
next-header, no-admin, no-route, packet-too-big, port-unreachable,
router-solicitation, router-advertisement, router-renumbering, unreachable,
time-exceeded, nd-na, and nd-ns.

» Fragments. Either select the Enable radio button to allow initial fragments (that is,
the fragment bit is asserted) or leave the default Disable radio button selected to
prevent initial fragments from being used.

This option is not valid for rules that match L4 information such as TCP port number,
because that information is carried in the initial packet.

* Routing. Either select the Enable radio button to match packets that include a
routing extension header or leave the default Disable radio button selected to ignore
the routing extension headers in packets.

» IPv6 DSCP Service. Specify the IP DiffServ Code Point (DSCP) field. This is an
optional configuration.

The DSCP is defined as the high-order 6 bits of the service type octet in the IPv6
header. Enter an integer from 0 to 63. To select the IPv6 DSCP, select one of the
DSCP keywords. To specify a numeric value, select Other and enter the numeric
value of the DSCP.

10. Click the Apply button.

Your settings are saved.

Modify the match criteria for an IPvé6 ACL rule

To modify the match criteria for an IPv6 ACL rule:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IPv6 Rules.
The IPv6 Rules page displays.

7. From the ACL Name menu, select the ACL that includes the rule that you want to modify.
8. Inthe IPv6 ACL Rule Table, click the rule.
The rule is a hyperlink. The IPv6 ACL Rule Configuration page displays.

9. Modify the IPv6 ACL rule criteria.
10. Click the Apply button.

Your settings are saved.

Delete an IPv6 ACL rule
To delete an IPv6 ACL rule:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. Inthe address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL > Advanced > IPv6 Rules.
The IPv6 Rules page displays.

7. From the ACL Name menu, select the ACL that includes the rule that you want to delete.
8. In the IPv6 ACL Rule Table, select the check box that is associated with the rule.
9. Click the Delete button.

The rule is removed.

Configure IP ACL interface bindings

When you bind a basic IPv4, extended IPv4, or IPv6 ACL to an interface, all the rules that
you defined for the IP ACL are applied to the selected interface.

If resources on the switch are insufficient, an attempt to bind an ACL to an interface fails.

To bind an IP ACL to one or more interfaces:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > ACL > Advanced > IP Binding Configuration.

IP Binding Configuration

ACLID 1 v
Direction Inbound v

Sequence Number 0 (1 to 4294967295)

B unit 1

Pots 1 3 5 7 9 11 13 15 17 19 21 23 25
2 4 6 8 10 12 14 16 18 20 22 24 26

M e

" S
LLL L

Interface Binding Status

Interface Direction ACL Type ACL ID/Name Sequence Number

7. From the ACL ID menu, select an existing IP ACL for you which you want to add an IP ACL
interface binding.

The fixed selection from the Direction menu is Inbound, which means that MAC ACL
rules are applied to traffic entering the interface.

8. In the Sequence Number field, optionally specify a number to indicate the order of the
access list relative to other access lists already assigned to this interface and direction.

A low number indicates high precedence order. If a sequence number is already in use
for the interface and direction, the specified access list replaces the currently attached
access list using that sequence number. If you do not specify the sequence number
(meaning that the value is 0), a sequence number that is one number greater than the
highest sequence number currently in use for the interface and direction is used. The
range is from 1 to 4294967295.
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9. To add the selected ACL to a port or LAG, in the Ports table or LAG table, click the port or
LAG so that a check mark displays.

You can add the ACL to several ports and LAGs.

The Ports and LAG tables display the available and valid interfaces for ACL binding. All
nonrouting physical interfaces, VLAN interfaces, and interfaces participating in LAGs are
listed.

10. Click the Apply button.
Your settings are saved.
The following table describes the nonconfigurable information on the page.

Table 58. IP Binding Status table

Field Description

Interface The selected interface.

Direction The selected packet filtering direction for the ACL, which is always Inbound.

ACL Type The type of ACL assigned to the selected interface and direction.

ACL ID The ACL number or name identifying the ACL assigned to the selected interface and
direction.

Sequence Number  The sequence number signifying the order of specified ACL relative to other ACLs
assigned to the selected interface and direction.

View or delete IP ACL bindings in the IP ACL binding table

You can view or delete bindings for basic IPv4, extended IPv4, and IPv6 ACLs.

To view or delete IP ACL bindings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

» After initial login, enter your local device password.
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By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Security > ACL > Advanced > Binding Table.

IP ACL Binding Table

Interface  Direction ACL Type ACLID Sequence Number

g4 In Bound IPACL 101 1

7. To delete an IP ACL-to-interface binding, do the following:
a. Select the check box next to the interface.
b. Click the Delete button.

The binding is removed.
The following table describes the fields in the IP ACL Binding Table on the page.
Table 59. IP ACL Binding Table

Field Description

Interface The interface.

Direction The selected packet filtering direction for the ACL, which is always Inbound.

ACL Type The type of ACL assigned to the selected interface and direction.

ACL ID The ACL number or name identifying the ACL assigned to the selected interface and
direction.

Sequence Number  The sequence number signifying the order of the specified ACL relative to other ACLs
assigned to the selected interface and direction.

Configure VLAN ACL bindings

You can associate a MAC ACL, any type of IPv4 ACL, or an IPv6 ACL with a VLAN. When
you do so, the ACL is applied to all interfaces that are members of the VLAN.

Manage Device Security 350 User Manual



24-Port Gigabit (Hi-Power) PoE+ Ethernet Smart Managed Pro Switch with 2 SFP Ports

Add a VLAN ACL binding
To add a VLAN ACL binding:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL> Advanced > VLAN Binding Configuration.

WLAN Binding Configuration

VLAN D Direction Sequence Number ACL Type ACLID

- w

7. Inthe VLAN ID field, enter the VLAN ID to which the binding must apply.
The direction for packet filtering is always inbound.
8. In the Sequence Number field, enter an optional sequence number.

You can specify an optional sequence number to indicate the order of this access list
relative to other access lists that are already assigned to the VLAN ID and selected
direction. A lower number indicates a higher precedence order. If a sequence number is
already in use for the VLAN ID and selected direction, the specified access list replaces
the currently attached ACL using that sequence number. If you do not specify a sequence
number (the value is 0), a sequence number that is one greater than the highest
sequence number currently in use for the VLAN ID and selected direction is used.The
range is from 1 to 4294967295.
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9. From the ACL Type menu, select the type of ACL.
You can select a MAC ACL, IP ACL, or IPv6 ACL.

10. From the ACL ID list, select the ID or name of the ACL that must be bound to the specified
VLAN.

11. Click the Add button.
The VLAN ACL binding is added.

Remove a VLAN ACL binding
To remove a VLAN ACL binding:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > ACL> Advanced > VLAN Binding Configuration.
The VLAN Binding Configuration page displays.

7. Select the check box for the VLAN binding that you want to remove.
8. Click the Delete button.

The VLAN ACL binding is removed.
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This chapter contains the following sections:

*  Monitor the switch and the ports

» Configure and view the logs

e Configure port mirroring
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Monitor the switch and the ports

You can view and clear port and switch statistics and perform a cable test.

View or clear switch statistics

You can view detailed statistical information about the traffic that the switch processes.

To view or clear the switch statistics:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

To view the switch statistics, select Monitoring > Ports > Switch Statistics.
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Statistics
iflndex 1
QOctets Received 58151066
Packets Received Without Errors 0
Unicast Packets Received 0
Multicast Packets Received 0
Broadcast Packets Received 0
Receive Packets Discarded 1]
Octets Transmitted 7062712
Packets Transmitted Without Errors 55545
Unicast Packets Transmitted 42726
Multicast Packets Transmitted 3127
Broadcast Packets Transmitted 9692

Transmit Packets Discarded

(=]

Most Address Entries Ever Used 13

Address Enfries in Use 10

Maximum VLAN Entries 64

Maost VLAN Entries Ever Used 3

Static VLAN Entries 3

VLAN Deletes 0

Time Since Counters Last Cleared 0 days 20 hours 44 mins 12 secs

7. Click the Refresh button to refresh the page with the latest information about the switch.
8. To clear all the statistics counters, click the Clear button.

Clearing resets all switch summary and detailed statistics to default values. However, the
discarded packets count cannot be cleared.

The following table describes the switch statistics displayed on the page.

Table 60. Switch statistics

Field Description

iflndex The interface index of the interface table entry associated with the processor of
this switch.

Octets Received The total number of octets of data received by the processor (excluding framing

bits, but including FCS octets).

Packets Received Without The total number of packets (including broadcast packets and multicast
Errors packets) received by the processor.

Unicast Packets Received The number of subnetwork-unicast packets delivered to a higher-layer protocol.

Multicast Packets Received  The total number of packets received that were directed to a multicast address.
This number does not include packets directed to the broadcast address.

Broadcast Packets Received The total number of packets received that were directed to the broadcast
address. This does not include multicast packets.
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Table 60. Switch statistics (continued)

Field

Receive Packets Discarded

Description

The number of inbound packets that were chosen to be discarded, even though
no errors were detected, in order to prevent their being delivered to a
higher-layer protocol. A possible reason for discarding a packet could be to free
up buffer space.

Octets Transmitted

The total number of octets transmitted out of the interface, including framing
characters.

Packets Transmitted Without
Errors

The total number of packets transmitted out of the interface.

Unicast Packets Transmitted

The total number of packets that higher-level protocols requested be
transmitted to a subnetwork-unicast address, including those that were
discarded or not sent.

Multicast Packets
Transmitted

The total number of packets that higher-level protocols requested be
transmitted to a multicast address, including those that were discarded or not
sent.

Broadcast Packets
Transmitted

The total number of packets that higher-level protocols requested be
transmitted to the broadcast address, including those that were discarded or not
sent.

Transmit Packets Discarded

The number of outbound packets that were chosen to be discarded, even
though no errors were detected, in order to prevent their being delivered to a
higher-layer protocol. A possible reason for discarding a packet could be to free
up buffer space.

Most Address Entries Ever
Used

The highest number of Forwarding Database Address Table entries that were
learned by this switch since the most recent reboot.

Address Entries in Use

The number of learned and static entries in the Forwarding Database Address
Table for this switch.

Maximum VLAN Entries

The maximum number of VLANSs allowed on this switch.

Most VLAN Entries Ever
Used

The largest number of VLANS that were active on this switch since the last
reboot.

Static VLAN Entries

The number of active VLAN entries on this switch that were created statically.

VLAN Deletes

The number of VLANSs on this switch that were created and then deleted since
the last reboot.

Time Since Counters Last
Cleared

The elapsed time, in days, hours, minutes, and seconds, since the statistics for
this switch were last cleared.
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View port statistics

You can view a summary of per-port traffic statistics on the switch.

To view port statistics:

1.

Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

Launch a web browser.
In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

Click the Login button.

The System Information page displays.

Select Monitoring > Ports > Port Statistics.

Status

1 LAG All Go To Interface m

Total Packets received Packets received  Broadcast Packets Packets transmitted.  Transmit Packet. Collision Link down  Time since counters
without Errors with Errors received without Errors Errors Frames  everts last clearsd

Interface

1 13801 0 2395 26726 0

0 0

D 0 day 7 hr 8 min 50 sec

hr 8 min 50 sec

0 day 7 hr 8 min 50 sec

y 7 hr 8 min 50 sec

(i}

0 0
1] 0
0 0
0 0

(=T = =T ==
T &= o

0
0
0
1]

oo o

0
0
0 0

o 0 day 7 hr 8 min 50 sec

Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

« 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

 LAG. Only LAGs are displayed.
» All. Both physical interfaces and LAGs are displayed.
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8. Select one or more interfaces by taking one of the following actions:

» To view a single interface, select the check box associated with the port, or type the
port number in the Go To Interface field and click the Go button.

« To view multiple interfaces, select the check box associated with each interface.
The following table describes the per-port statistics displayed on the page.

Table 61. Port statistics

Field Description
Interface The interface or LAG.
Total Packets Received The total number of packets received that were without errors.

Without Errors

Packets Received With Error The number of inbound packets that contained errors preventing them from
being deliverable to a higher-layer protocol.

Broadcast Packets Received The total number of good packets received that were directed to the broadcast
address. This does not include multicast packets.

Packets Transmitted Without The number of frames without errors that were transmitted by the port.

Errors

Transmit Packet Errors The number of outbound packets that could not be transmitted because of
errors.

Collision Frames The best estimate of the total number of collisions on this Ethernet segment.

Link Down Events The total number of link down events on a physical port.

Time Since Counters Last The elapsed time in days, hours, minutes, and seconds since the statistics for

Cleared the port were last cleared.

Reset the counters for all interfaces on the switch

To reset the counters for all interfaces on the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Ports > Port Statistics.
The Port Statistics page displays.

7. Select the check box in the heading of the table.
8. Click the Clear button.

All counters are reset to O.

Reset the counters for one or more interfaces

To reset the counters for one or more interfaces:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.
The System Information page displays.

6. Select Monitoring > Ports > Port Statistics.
The Port Statistics page displays.

7. Select whether to display physical interfaces, LAGs, or both by clicking one of the following
links above the table heading:

e 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

 LAG. Only LAGs are displayed.
» All. Both physical interfaces and LAGs are displayed.

8. Select one or more interfaces by taking one of the following actions:

* Toreset a single interface, select the check box associated with the port, or type the
port number in the Go To Interface field and click the Go button.

« To reset multiple interfaces, select the check box associated with each interface.
9. Click the Clear button.

The counters for the interface are reset to O.

View and manage detailed port statistic
You can view a variety of per-port traffic statistics.

To view or clear detailed port statistics:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Monitoring > Ports > Port Detailed Statistics.

Port Detailed Statistics
Interface gl ~
MST ID CST ~
ifindex 1
Port Type
Port Channel ID Disable
Port Role
STP Mode Enable
STP State
Admin Mode Enable
Flow Control Mode Disable
LACP Mode Enable
Physical Mode Auto
Physical Status 1000 Mbps
Link Status Link Up
Link Trap Enable
Packets RX and TX 64 Octets 15891
Packets RX and TX 65-127 Octets 9368
Packets RX and TX 128-255 Octets 1006
Packets RX and TX 256-511 Octets 2790
Packets RX and TX 512-1023 Octets 1074

The previous figure does not show all fields on the Port Detailed Statistics page.
7. From the Interface menu, select the interface with the statistics to view.
8. From the MST ID menu, select the MST ID associated with the interface (if available).
9. To refresh the page with the latest information about the switch, click the Refresh button.
10. To clear all the counters, click the Clear button.

All statistics for the port are reset to the default values.
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The following table describes the detailed port information that displays for a particular port.

Table 62. Detailed port statistics

Field Description
ifindex The interface or LAG.
Port Type For normal ports, this field is displayed as blank. Otherwise, the options are as

follows:

e Mirrored. The port is a participating in port mirroring as a mirrored port.
* Probe. The port is a participating in port mirroring as the probe port.

e Port Channel. The port is a member of a LAG.

Port Channel ID

If the port is a member of a port channel (LAG), the port channel’s interface ID
and name are shown. Otherwise, Disable is shown.

Port Role

Each MST bridge port that is enabled is assigned a port role for each spanning
tree. The port role is one of the following values: Root, Designated, Alternate,
Backup, Master, or Disabled.

STP Mode

The Spanning Tree Protocol administrative mode that is associated with the port
or port channel. The options are as follows:

* Enable. Spanning tree is enabled for the port.
« Disable. Spanning tree is disabled for the port.

STP State

The port's current Spanning Tree state. This state controls what action a port
takes on receipt of a frame. If the bridge detects a malfunctioning port, it places
that port into the broken state. The states are defined in IEEE 802.1D:

» Disabled

« Blocking

« Listening

e Learning

* Forwarding
* Broken

Admin Mode

The port control administration state. The port must be enabled for it to be
allowed into the network. The default is Enabled.

Flow Control Mode

Indicates whether flow control is enabled or disabled for the port. This field does
not apply to LAGs.

LACP Mode

Indicates the Link Aggregation Control Protocol administrative state. The mode
must be enabled for the port to participate in link aggregation.

Physical Mode

Indicates the port speed and duplex mode. In autonegotiation mode the duplex
mode and speed are set from the autonegotiation process.

Physical Status

Indicates the port speed and duplex mode for physical interfaces.

Link Status

Indicates whether the link is up or down.

Link Trap

Indicates whether or not the port sends a trap when link status changes.

Packets RX and TX 64

Octets

The total number of packets (including bad packets) received or transmitted that
were 64 octets in length (excluding framing bits but including FCS octets).
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Table 62. Detailed port statistics (continued)

Field Description

Packets RX and TX 65-127  The total number of packets (including bad packets) received or transmitted that
Octets were between 65 and 127 octets in length inclusive (excluding framing bits but
including FCS octets).

Packets RX and TX 128-255 The total number of packets (including bad packets) received or transmitted that
Octets were between 128 and 255 octets in length inclusive (excluding framing bits but
including FCS octets).

Packets RX and TX 256-511 The total number of packets (including bad packets) received or transmitted that
Octets were between 256 and 511 octets in length inclusive (excluding framing bits but
including FCS octets).

Packets RXand TX 512-1023 The total number of packets (including bad packets) received or transmitted that
Octets were between 512 and 1023 octets in length inclusive (excluding framing bits
but including FCS octets).

Packets RX and TX The total number of packets (including bad packets) received or transmitted that
1024-1518 Octets were between 1024 and 1518 octets in length inclusive (excluding framing bits
but including FCS octets).

Octets Received The total number of octets of data (including those in bad packets) received on
the network (excluding framing bits but including FCS octets). This object can be
used as a reasonable estimate of Ethernet utilization. If you need greater
precision, the etherStatsPkts and etherStatsOctets objects must be sampled
before and after a common interval.

Packets Received 64 Octets The total number of packets (including bad packets) received that were 64
octets in length (excluding framing bits but including FCS octets).

Packets Received 65-127 The total number of packets (including bad packets) received that were between
Octets 65 and 127 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Received 128-255  The total number of packets (including bad packets) received that were between
Octets 128 and 255 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Received 256-511 The total number of packets (including bad packets) received that were between
Octets 256 and 511 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Received 512-1023 The total number of packets (including bad packets) received that were between
Octets 512 and 1023 octets in length inclusive (excluding framing bits but including
FCS octets).

Packets Received 1024-1518 The total number of packets (including bad packets) received that were between
Octets 1024 and 1518 octets in length inclusive (excluding framing bits but including
FCS octets).

Packets Received > 1518 The total number of packets received that were longer than 1518 octets

Octets (excluding framing bits, but including FCS octets) and were otherwise well
formed.

Total Packets Received The total number of packets received that were without errors.

Without Errors
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Table 62. Detailed port statistics (continued)

Field

Unicast Packets Received

Description

The number of subnetwork-unicast packets delivered to a higher-layer protocol.

Multicast Packets Received

The total number of good packets received that were directed to a multicast
address. This number does not include packets directed to the broadcast
address.

Broadcast Packets Received

The total number of good packets received that were directed to the broadcast
address. This does not include multicast packets.

Receive Packets Discarded

The number of inbound packets that were discarded even though no errors were
detected to prevent their being delivered to a higher-layer protocol. A possible
reason for discarding a packet could be to free up buffer space.

Total Packets Received with
MAC Errors

The total number of inbound packets that contained errors preventing them from
being deliverable to a higher-layer protocol.

Jabbers Received

The total number of packets received that were longer than 1518 octets
(excluding framing bits, but including FCS octets), and included either a bad
frame check sequence (FCS) with an integral number of octets (FCS Error) or a
bad FCS with a nonintegral number of octets (alignment error). This definition of
jabber is different from the definition in IEEE-802.3 section 8.2.1.5 (10BASES)
and section 10.3.1.4 (10BASE?2). These documents define jabber as the
condition where any packet exceeds 20 ms. The allowed range to detect jabber
is between 20 ms and 150 ms.

Fragments Received

The total number of packets received that were less than 64 octets in length with
ERROR CRC (excluding framing bits but including FCS octets).

Undersize Received

The total number of packets received that were less than 64 octets in length with
GOOD CRC (excluding framing bits but including FCS octets).

Alignment Errors

The total number of packets received with a length (excluding framing bits, but
including FCS octets) of between 64 and 1518 octets, inclusive, but included a
bad frame check sequence (FCS) with a nonintegral number of octets.

Rx FCS Errors

The total number of packets received with a length (excluding framing bits, but
including FCS octets) of between 64 and 1518 octets, inclusive, but included a
bad frame check sequence (FCS) with an integral number of octets.

Total Received Packets Not
Forwarded

The number of valid frames received that were discarded (that is, filtered) by the
forwarding process.

802.3x Pause Frames
Received

The number of MAC control frames received on the interface with an opcode
indicating the PAUSE operation. This counter does not increment when the
interface is operating in half-duplex mode.

Total Packets Transmitted
(Octets)

The total number of octets of data (including those in bad packets) transmitted
on the network (excluding framing bits but including FCS octets). This object can
be used as a reasonable estimate of Ethernet utilization. If yo need greater
precision, the etherStatsPkts and etherStatsOctets objects must be sampled
before and after a common interval.

Packets Transmitted 64
Octets

The total number of packets (including bad packets) received that were 64
octets in length (excluding framing bits but including FCS octets).
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Table 62. Detailed port statistics (continued)

Field

Packets Transmitted 65-127
Octets

Description

The total number of packets (including bad packets) received that were between
65 and 127 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Transmitted 128-255
Octets

The total number of packets (including bad packets) received that were between
128 and 255 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Transmitted 256-511
Octets

The total number of packets (including bad packets) received that were between
256 and 511 octets in length inclusive (excluding framing bits but including FCS
octets).

Packets Transmitted
512-1023 Octets

The total number of packets (including bad packets) received that were between
512 and 1023 octets in length inclusive (excluding framing bits but including
FCS octets).

Packets Transmitted
1024-1518 Octets

The total number of packets (including bad packets) received that were between
1024 and 1518 octets in length inclusive (excluding framing bits but including
FCS octets).

Packets Transmitted > 1518
Octets

The total number of packets transmitted that were longer than 1518 octets
(excluding framing bits, but including FCS octets) and were otherwise well
formed. This counter supports a maximum increment rate of 815 counts per sec
at 10 Mb/s.

Maximum Frame Size

The maximum Ethernet frame size the interface supports or is configured to use,
including Ethernet header, CRC, and payload. The possible range is 1522 to
10000. The default maximum frame size is 1522.

Total Packets Transmitted
Successfully

The number of frames that were transmitted successfully by the port.

Unicast Packets Transmitted

The total number of packets that higher-level protocols requested be transmitted
to a subnetwork-unicast address, including those that were discarded or not
sent.

Multicast Packets
Transmitted

The total number of packets that higher-level protocols requested be transmitted
to a multicast address, including those that were discarded or not sent.

Broadcast Packets
Transmitted

The total number of packets that higher-level protocols requested be transmitted
to the broadcast address, including those that were discarded or not sent.

Transmit Packets Discarded

The number of outbound packets which were chosen to be discarded even
though no errors were detected to prevent them from being delivered to a
higher-layer protocol. A possible reason for discarding a packet could be to free
up buffer space.

Total Transmit Errors

The sum of single, multiple, and excessive collisions.

Total Transmit Packets
Discarded

The sum of single collision frames discarded, multiple collision frames
discarded, and excessive frames discarded.

Single Collision Frames

The number of successfully transmitted frames on a particular interface for
which transmission is inhibited by exactly one collision.
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Table 62. Detailed port statistics (continued)

Field Description

Multiple Collision Frames The number of successfully transmitted frames on a particular interface for
which transmission is inhibited by more than one collision.

Excessive Collision Frames  The number of frames for which transmission on a particular interface fails due
to excessive collisions.

Dropped Transmit Frames The number of transmit frames discarded at the selected port.

STP BPDUs Received The number of STP BPDUSs received at the selected port.
STP BPDUs Transmitted The number of STP BPDUs transmitted from the selected port.
RSTP BPDUs Received The number of RSTP BPDUSs received at the selected port.

RSTP BPDUs Transmitted The number of RSTP BPDUs transmitted from the selected port.

MSTP BPDUs Received The number of MSTP BPDUs received at the selected port.

MSTP BPDUs Transmitted The number of MSTP BPDUs transmitted from the selected port.

802.3x Pause Frames The number of MAC control frames transmitted on the interface with an opcode
Transmitted indicating the PAUSE operation. This counter does not increment when the
interface is operating in half-duplex mode.

EAPOL Frames Received The number of valid EAPoL frames of any type that were received by this
authenticator.

EAPOL Frames Transmitted The number of EAPoL frames of any type that were transmitted by this

authenticator.
Time Since Counters Last The elapsed time in days, hours, minutes, and seconds since the statistics for
Cleared the port were last cleared.

View or clear EAP and EAPoL statistics

You can view information about Extensible Authentication Protocol (EAP) and EAP over LAN
(EAPoL) packets that are received on physical ports.

To view or clear EAP and EAPoL statistics:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Monitoring > Ports > EAP Statistics.

EAP Statistics
EAPOL
Parts  Frames  Frames Start Frames Logoff Frames  Last Frame  Last Frame Invalid Frames  Length Emor
Received Transmitted Received Received Version Source Received Frames Received
g1 0 0 0 0 0 00:00:00:00:00:00 0 0
g2 0 0 0 0 0 00:00:00:0 0 0 0
g3 0 0 0 0 00:00:00:00:00:00 0

The previous figure does not show all fields on the EAP Statistics page.

7. To refresh the page with the latest information about the switch, click the Refresh button.

8. To clear the counters, which resets the EAP and EAPoL statistics to default values, take
one of the following actions:

» To clear the counters for a specific port, select the check box associated with the port,
and click the Clear button.

» To clear the counters for multiple ports, select the check boxes associated with the
ports, and click the Clear button.

» To clear all counters for all ports, select the check box in the row heading, and click
the Clear button.

Clicking the button resets all statistics for all ports to default values.
The following table describes the EAP statistics displayed on the page.

Table 63. EAP statistics

Field Description

Port The port number.

EAPOL Frames Received The number of valid EAPoL frames of any type that were received by this
authenticator.
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Table 63. EAP statistics

Field

EAPOL Frames Transmitted

Description

The number of EAPoL frames of any type that were transmitted by this
authenticator.

EAPOL Start Frames
Received

The number of EAPoL start frames that were received by this authenticator.

EAPOL Logoff Frames
Received

The number of EAPoL logoff frames that were received by this authenticator.

EAPOL Last Frame Version

The protocol version number carried in the most recently received EAPoL frame.

EAPOL Last Frame Source

The source MAC address carried in the most recently received EAPoL frame.

EAPOL Invalid Frames
Received

The number of EAPoL frames that were received by this authenticator in which
the frame type is not recognized.

EAPOL Length Error Frames
Received

The number of EAPoL frames that were received by this authenticator in which
the frame type is not recognized.

EAP Response/ID Frames
Received

The number of EAP response/identity frames that were received by this
authenticator.

EAP Response Frames
Received

The number of valid EAP response frames (other than resp/ID frames) that were
received by this authenticator.

EAP Request/ID Frames
Transmitted

The number of EAP request/identity frames that were transmitted by this
authenticator.

EAP Request Frames
Transmitted

The number of EAP request frames (other than request/identity frames) that
were transmitted by this authenticator.

Perform a cable test

You can test and view information about the cables that are connected to switch ports.

To perform a cable test:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.
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4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Monitoring > Ports > Cable Test.

Cable Test
Go To Port m
Port Cable Status Cable Length Failure Location
gl Untested
g2  Untested
g3  Untested
g4  Untested

7. Select one or more interfaces by taking one of the following actions:

» To test a single interface, select the check box associated with the port, or type the
port number in the Go To Interface field and click the Go button.

» To test multiple interfaces, select the check box associated with each interface.
» To test all interfaces, select the check box in the heading row.

8. Select the check boxes that are associated with the physical ports for which you want to test
the cables.

9. Click the Apply button.

A cable test is performed on all selected ports. The cable test might take up to two
seconds to complete. If the port forms an active link with a device, the cable status is
always Normal. The test returns a cable length estimate if this feature is supported by the
PHY for the current link speed. Note that if the link is down and a cable is attached to a
10/100 Ethernet adapter then the cable status might be Open or Short because some
Ethernet adapters leave unused wire pairs unterminated or grounded.
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The following table describes the nonconfigurable information on the page.

Table 64. Cable Test information

Field Description

Cable Status Indicates the cable status:
* Normal. The cable is working correctly.
e Open. The cable is disconnected or a faulty connector exists.
« Short. An electrical short exists in the cable.

* Cable Test Failed. The cable status could not be determined. The cable might in
fact be working.

* No cable. The cable is not present or too short to test.
* Untested. The cable is not yet tested.
» Port Disabled. The port is disabled.

Cable Length The estimated length of the cable in meters. The length is displayed as a range
between the shortest estimated length and the longest estimated length. Unknown is
displayed if the cable length could not be determined. The cable length is displayed
only if the cable status is Normal.

Failure Location The estimated distance in meters from the end of the cable to the failure location. The
failure location is displayed only if the cable status is Open or Short.

Configure and view the logs

The switch generates messages in response to events, faults, or errors occurring on the
platform as well as changes in configuration or other occurrences. These messages are
stored locally and can be forwarded to one or more centralized points of collection for

monitoring purposes or long-term archival storage. Local and remote configuration of the

logging capability includes filtering of messages logged or forwarded based on severity and
generating component.

Manage and view the memory log

The memory log stores messages in memory based upon the settings for message
component and severity. You can set the administrative status and behavior of logs in the
system buffer. These log messages are cleared when the switch reboots.

To manage and view the memory log:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Logs > Memory Log.
The Memory Log page displays.

7. Select one of the following Admin Status radio buttons:
« Enable. Enable system logging. This is the default setting.
» Disable. Prevent the system from logging messages.
8. From the Behavior menu, specify the behavior of the log when it is full:

» Wrap. When the buffer is full, the oldest log messages are deleted as the system logs
new messages.

» Stop on Full. When the buffer is full, the system stops logging new messages and
preserves all existing log messages.

9. From the Severity Filter menu, select the logging level for messages that must be logged.

Log messages with the selected severity level and all log messages of greater severity
are logged. For example, if you select Warning, the logged messages include Warning,
Error, Critical, Alert, and Emergency. The default severity level is Informational (6).

The severity can be one of the following levels:

 Emergency (0). System is unusable.

e Alert (1). Action must be taken immediately.
e Critical (2). Critical conditions.

e Error (3). Error conditions.

« Warning (4). Warning conditions.

* Notice (5). Normal but significant conditions.
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« Informational (6). Informational messages. This is the default setting.
e Debug (7). Debug-level messages.

Note: A log records messages equal to or above a configured severity threshold.

10. Click the Apply button.
Your settings are saved.
The Memory Log table displays on the Memory Log page.

The Total number of Messages field displays the number of messages the system logged
in memory. Up to 450 of the most recent entries can be displayed.

The rest of the page displays the Memory Log messages. The format of the log message
is the same for messages that are displayed for the message log, persistent log, or
console log. Messages logged to a collector or relay through syslog support the same
format as well.

The following example shows the standard format for a log message:

*Jan 01 2018 00:00:18: AAA-5-CONNECT: New http connection for user
admin, source 192.168.1.111 ACCEPTED

The message was generated by component AAA on January 1, 2018 at 00:00:18 a.m.
with severity 5 (Notice). The message indicates that the administrator logged on to the
HTTP management interface from a host with IP address 192.168.1.111.

11. To refresh the page with the latest information about the switch, click the Refresh button.
12. To clear the messages from the buffered log in the memory, click the Clear button.

Manage and view the flash log

The flash log is a persistent log, that is, is a log that is stored in persistent storage. Persistent
storage survives across platform reboots. The first log type is the system startup log. The
system startup log stores the first 32 messages received after system reboot. The second log
type is the system operation log. The system operation log stores messages received during
system operation.

To manage and view the flash log:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.
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The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Logs > FLASH Log.
The FLASH Log Configuration page displays.

7. Select one of the following Admin Status radio buttons:
* Enable. A log that is enabled logs messages.
» Disable. A log that is disabled does not log messages.
8. From the Severity Filter menu, select the logging level for messages that must be logged.

Log messages with the selected severity level and all log messages of greater severity
are logged. For example, if you select Warning, the logged messages include Warning,
Error, Critical, Alert, and Emergency. The default severity level is Error (3).

The severity can be one of the following levels:
- Emergency (0). The highest warning level. If the device is down, or not
functioning properly, an emergency log message is saved to the device.

- Alert (1). The second-highest warning level. An alert log message is saved if a
serious device malfunction occurs, such as all device features being down. Action
must be taken immediately.

- Critical (2). The third-highest warning level. A critical log message is saved if a
critical device malfunction occurs, for example, two device ports are not
functioning, while the rest of the device ports remain functional.

- Error (3). A device error occurred, such as a port being offline. This is the default
setting.

- Warning (4). The lowest level of a device warning.

- Notice (5). Normal but significant conditions. Provides the network administrators
with device information.

- Informational (6). Provides device information.
- Debug (7). Provides detailed information about the device.
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9. From the Logs to be Displayed menu, select one of the following options:

e Current Logs. The log messages for the current switch session are displayed. This is
the default setting.

» Previous Logs. The previous log messages are displayed, that is, the log messages
that are still in the flash memory from before the switch was rebooted.

10. Click the Apply button.
Your settings are saved.

The Total Number of Messages field shows is the total number of persistent log
messages that are stored on the switch. The maximum number of persistent log
messages displayed on the switch is 64.

*Jan 01 2018 00:00:18: AAA-5-CONNECT: New http connection for user
admin, source 192.168.1.111 ACCEPTED

The message was generated by component AAA on January 1, 2018 at 00:00:18 a.m.
with severity 5 (Notice). The message indicates that the administrator logged on to the
HTTP management interface from a host with IP address 192.168.1.111.

Manage the server log

You can let the switch send log messages to remote logging hosts. A remote log server is the
same as a remote syslog host.

You must enable the server log on the switch and specify one or more remote syslog hosts.

Enable the server log and add a remote syslog host

To enable the server log and add a remote syslog host:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Logs > Server Log.
The Server Log page displays.

7. In the Server Log Configuration section, select one of the following Admin Status radio
buttons:

* Enable. Send log messages to all configured hosts (syslog collectors or relays) using
the values configured for each host.

» Disable. Stop logging to all syslog hosts. Disable means no messages are sent to
any collector or relay.

8. Click the Apply button.
Your settings are saved.

9. In the Server Configuration section, specify the following settings:

» IP Address Type. Specify the IP address type of the host, which can be IPv4, IPv6,
or DNS.

* Host Address. Specify the IP address or host name of the syslog host.

» Port. Specify the port on the host to which syslog messages must be sent. The
default port number is 514.

» Severity Filter. Use the menu to select the severity of the logs that must be sent to
the logging host. Logs with the selected severity level and all logs of greater severity
are sent to the host. For example, if you select Error, the logged messages include
Error, Critical, Alert, and Emergency. The severity can be one of the following levels:

- Emergency (0). The highest warning level. If the device is down or not
functioning properly, an emergency log is saved to the device.

- Alert (1). The second-highest warning level. An alert log is saved if a serious
device malfunction occurs, such as all device features being down.

- Critical (2). The third-highest warning level. A critical log is saved if a critical
device malfunction occurs, for example, two device ports are not functioning,
while the rest of the device ports remain functional.

- Error (3). A device error occurred, such as a port being offline.

- Warning (4). The lowest level of a device warning.

- Notice (5). Provides the network administrators with device information.
- Informational (6). Provides device information.

- Debug (7). Provides detailed information about the log.
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10. Click the Add button.
The remote syslog host is added.

The Status field in the Server Configuration table shows whether the remote logging host
is currently active.

Modify the settings for a remote syslog host

To modify the settings for a remote syslog host:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Logs > Server Log.
The Server Log Configuration page displays.

7. Select the check box that is associated with the host.
8. Change the information as needed.
9. Click the Apply button.

Your settings are saved.
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Delete the settings for a remote syslog host

To delete the settings for a remote syslog host:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Monitoring > Logs > Server Log.
The Server Log Configuration page displays.

7. Select the check box that is associated with the host.
8. Click the Delete button.

The host is removed.

View or clear the trap logs and the counter

You can view information about the SNMP traps generated on the switch.

You can also display information about the traps that were sent.

To view or clear the trap logs and the counters:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.
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2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Monitoring > Logs > Trap Logs.

Trap Logs
Number of Traps Since Last Reset 2
Trap Log Capacity 256

Number of Traps Since Log Last Viewed 2

Trap Logs

Log System Up Time Trap
2019-01-01T00:00:24.210Z 192.168.0.239-5-PORT_LINK_UP ksi_snmp.c(232): Interface GigabitEthernet1 link up
2 | 2019-01-01T00:00:23.550Z 192.168.0239-5-SYSTEM_WARMSTART sal_snmp.c(765): Warm startup

7. To clear all counters, click the Clear button.
All statistics for the trap logs are reset to their default values.

8. To refresh the page with the latest information about the switch, click the Refresh button.

9. To clear the messages from the trap logs in the memory and clear the counters, click the
Clear button.
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The following table describes the nonconfigurable information that is displayed on the page.

Table 65. Trap Logs information

Field Description

Number of Traps Since Last The number of traps that occurred since the switch last rebooted.
Reset

Trap Log Capacity The maximum number of traps stored in the log. If the number of traps exceeds
the capacity, the entries overwrite the oldest entries.

Number of Traps since log The number of traps that occurred since the traps were last displayed. Displaying
last viewed the traps by any method (terminal interface display, web display, upload file from
switch, and so on) causes this counter to be cleared to 0.

Log The sequence number of the trap.

System Up Time The time when this trap occurred, expressed in days, hours, minutes, and
seconds, since the last reboot of the switch.

Trap Information describing the trap.

Configure port mirroring

Port mirroring lets you select the network traffic of specific switch ports for analysis by a
network analyzer. You can select many switch ports as source ports but a single switch port
only as the destination port. You can configure how traffic is mirrored on a source port by
selecting packets that are received, transmitted, or both.

A packet that is copied to the destination port is in the same format as the original packet on
the wire. This means that if the mirror is copying a received packet, the copied packet is
VLAN-tagged or untagged as it was received on the source port. If the mirror is copying a
transmitted packet, the copied packet is VLAN-tagged or untagged as it is being transmitted
on the source port.

To globally enable port mirroring, specify the destination port, and specify one or
more source ports:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Monitoring > Mirroring > Port Mirroring.

Global Configuration

Admin Mode ® Disable © Enable

Destination Port None ~

Source Interface Configuration

1 LAG CPU All Go To Interface m
Source Port Direction Status
gl None
g2 None
g3 None
gd None
g5 None

7. Select an Admin Mode radio button:
« Disable. Port mirroring is disabled. This is the default setting.
« Enabled. Port mirroring is enabled.

8. From the Destination Port menu, select the physical destination port to which port traffic
must be copied.

You can configure one destination port only. The port functions as a probe port and
receives traffic from all configured source ports. If no port is configured, None is
displayed. The default is None.

9. Click the Apply button.

Your settings are saved.

In the Source Interface Configuration section, perform the following steps.
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10. Select whether to display physical interfaces, LAGs, the CPU, or al by clicking one of the
following links above the table heading:

* 1 (the unit ID of the switch). Only physical interfaces are displayed. This is the default
setting.

* LAG. Only LAGs are displayed.
e« CPU. Only the CPU is displayed.
« All. The physical interfaces, LAGs, and CPU are displayed.

11. Select one or more interfaces by taking one of the following actions:

» To select a single interface, select the check box associated with the port, or type the
port number in the Go To Interface field and click the Go button.

» To select multiple interfaces, select the check box associated with each interface.
Traffic from the selected ports will be sent to the destination port.

12. From the Direction menu, specify the direction of the traffic that must be mirrored from the
selected source ports:

* None. No traffic direction is selected. This is the default setting.
* Tx and Rx. Monitors both transmitted and received packets.
* Rx. Monitors received (ingress) packets only.
» Tx. Monitors transmitted (egress) packets only.
13. Click the Apply button.
Your settings are saved.

The Status field indicates the interface status. The destination port is listed as Probe. The
source ports are listed as Mirrored.
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Switch

This chapter contains the following sections:

e Reboot the switch

* Reset the switch to its factory default settings

e Export afile from the switch

«  Download a file to the switch or update the software

* Manage software images

* Perform diagnostics and troubleshooting
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Reboot the switch

You can reboot the switch from the local browser Ul.

To reboot the switch:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Maintenance > Reset > Device Reboot.
The Device Reboot page displays.

7. Select the check box.
8. Click the Apply button.

An Alert pop-up window opens.

9. Click the OK button to confirm.

The switch reboots.
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Reset the switch to its factory default
settings

You can reset the system configuration to the factory default values. All changes that you
made are lost. If the IP address changes, your web session might disconnect.

Note: If you reset the switch to the default configuration, the IP address is
reset to 192.168.0.239, and the DHCP client is enabled. If you lose
network connectivity after you reset the switch to the factory defaults,
see Access the switch on-network and connected to the Internet on
page 18 or Access the switch off-network on page 27.

To reset the switch to the factory default settings:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > Reset > Factory Default.

The Default Settings page displays.
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7. Select one of the following radio buttons:

* Reset configuration to factory default (EXCEPT registered device status), and
clear device logs.

This option resets the switch to its factory default settings but does not change its
registration status with NETGEAR.

* Reset and erase everything including registered device status.

This option resets the switch to its factory default settings and resets its registration
status with NETGEAR. That is, the switch becomes an unregistered device.

After the switch reboots, to access the full menu of the browser Ul, you first must
reregister the switch using your NETGEAR account credentials. If you previously
obtained a registration key, you can reenter the registration key. For more information,
see Reqister the switch on page 31.

8. Click the Apply button.
An Alert pop-up window opens.
9. Click the OK button.

All configuration settings are reset to their factory default values. All changes that you
made are erased, even if you saved the configuration. This process takes about 135
seconds.

Export a file from the switch

You can export configuration (ASCII) or log (ASCII log) files from the switch to a file server by
using TFTP or to a computer by using HTTP.

Use TFTP to export a file from the switch to a TFTP server

You can upload (export) configuration (ASCII or log ASCII) files from the switch to a TFTP
server on the network.

To export a file from the switch to a TFTP server:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.
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If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > Export > TFTP File Export.

TFTP File Export

Export
= TFTP File Export File Type Text Configuration
“HTTP File Export Server Address Type 1Pvd ~
Server Address 0.0.0.0

Transfer File Path
Transfer File Name

Start File Transfer

7. From the File Type menu, select the type of file:

» Text Configuration. A text-based configuration file enables you to edit a configured
text file (startup-config) offline as needed. The most common usage of
text-based configuration is to upload a working configuration from a device, edit it
offline to personalize it for another similar device (for example, change the device
name or IP address), and download it to that device. This is the default setting.

e Trap Log. The trap log with the switch trap records.
« Buffered Log. The switch buffered (in-memory) log.

« Tech Support. The tech support file is a text-base file that contains a variety of
hardware, software, and configuration information that can assist in device and
network troubleshooting.

e Crash Logs. The switch crash logs, if any are available.

8. From the Server Address Type menu, select the format for the Server Address field:

+ |Pv4. Indicates that the TFTP server address is an I[P address in dotted-decimal
format. This is the default setting.

« DNS. Indicates that the TFTP server address is a host name.

9. In the Server Address field, enter the IP address of the server in accordance with the
format indicated by the server address type.
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The default is the IPv4 address 0.0.0.0.

10. In the Transfer File Path field, specify the path on the TFTP server where you want to save
the file.

You can enter up to 160 characters. Include the backslash at the end of the path. A path
name with a space is not accepted. Leave this field blank to save the file to the root TFTP
directory.

11. In the Transfer File Name field, specify a destination file name for the file to be uploaded.
You can enter up to 32 characters. The transfer fails if you do not specify a file name.

12. Select the Start File Transfer check box.
13. Click the Apply button.

The file transfer begins.

The page displays information about the file transfer progress. The page refreshes
automatically when the file transfer completes.

Use HTTP to export a file from the switch to a computer

You can upload (export) files of various types from the switch to a computer through an
HTTP session by using your web browser.

To export a file from the switch to a computer by using HTTP:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.
The System Information page displays.

6. Select Maintenance > Export > HTTP File Export.
The HTTP File Export page displays.

7. From the File Type menu, select the type of file:

« Text Configuration. A text-based configuration file enables you to edit a configured
text file (startup-config) offline as needed. The most common usage of
text-based configuration is to upload a working configuration from a device, edit it
offline to personalize it for another similar device (for example, change the device
name or IP address), and download it to that device.

» Tech Support. The tech support file is a text-base file that contains a variety of
hardware, software, and configuration information that can assist in device and
network troubleshooting.

* Crash Logs. The switch crash logs, if any are available.
8. Click the Apply button.
The file transfer begins.

The page displays information about the file transfer progress. The page refreshes
automatically when the file transfer completes.

Download a file to the switch or update the
software

You can manually check for the latest software version (also referred to as firmware version)
through the local browser Ul of the switch, download the firmware, and upload the firmware to
the switch. If firmware release notes are available with new firmware, read the release notes
to find out if you must reconfigure the switch after updating.

You can download system files from a remote system to the switch by using either TFTP or
HTTP. In this context, downloading is also referred to as updating.

Use TFTP to download a file to the switch or update the
software image

You can download a software (firmware) image, configuration files, and SSL files from a
TFTP server to the switch.

Before you download a file to the switch, the following conditions must be true:

e The file to download from the TFTP server is on the server in the appropriate directory.
e Thefile is in the correct format.
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» The switch contains a path to the TFTP server.

You can also download files by using HTTP. See Use HTTP to download a file to the switch
or update the software image on page 391 for additional information.

To download a file to the switch from a TFTP server:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > Update > TFTP Firmware/File Update.

Update TFTP Firmware/File Update
-BI;Id';girmwarefFﬂe File Type Software v

*HTTP Firmware/File Image Name mapa:
Update Server Address Type IPv4 ~
TFTP Server IP 0.0.00

Transfer File Path
Remote File Name
Start File Transfer

NOTE: This process will send a file from the specified TFTP server to the switch
When the file transfer starts, wait until the page refreshes before continuing.
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7. From the File Type menu, select the type of file:

« Software. The system software image, which is saved in one of two flash sectors
called images (imagel and image?2). The active image stores the active copy, while
the other image stores a second copy. The device boots and runs from the active
image. If the active image is corrupted, the system automatically boots from the
nonactive image. This is a safety feature for faults occurring during the boot upgrade
process. This is the default setting.

« Text Configuration. A text-based configuration file enables you to edit a configured
text file (startup-config) offline as needed. The most common usage of
text-based configuration is to upload a working configuration from a device, edit it
offline to personalize it for another similar device (for example, change the device
name or IP address), and download it to that device.

e SSL Trusted Root Certificate PEM File. SSL Trusted Root Certificate File (PEM
Encoded).

e SSL Server Certificate PEM File. SSL Server Certificate File (PEM Encoded).

e SSL DH Weak Encryption Parameter PEM File. SSL Diffie-Hellman Weak
Encryption Parameter File (PEM Encoded).

e SSL DH Strong Encryption Parameter PEM File. SSL Diffie-Hellman Strong
Encryption Parameter File (PEM Encoded).

8. If the selection from the File Type menu is Software, the Image Name menu is displayed
and you must select the software image that must be downloaded to the switch:

« Imagel. Select imagel to upload imagel.
* Image2. Select image2 to upload image2.

Note: We recommended that you do not overwrite the active image.

9. From the Server Address Type menu, select the format for the TFTP Server IP field:

+ |Pv4. Indicates that the TFTP server address is an I[P address in dotted-decimal
format. This is the default setting.

+ DNS. Indicates that the TFTP server address is a host name.

10. In the TFTP Server IP field, enter the IP address of the TFTP server indicated by the server
address type.

The default is the IPv4 address 0.0.0.0.
11. In the Transfer File Path field, specify the path on the TFTP server where the file is located.

Enter up to 160 characters. Include the backslash at the end of the path. A path name
with a space is not accepted. Leave this field blank to save the file to the root TFTP
directory.

12. In the Remote File Name field, specify the name of the file to download from the TFTP
server.

You can enter up to 32 characters. A file name with a space is not accepted.

13. Select the Start File Transfer check box to initiate the file upload.
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14. Click the Apply button.
The file transfer begins.

The page displays information about the progress of the file transfer. The page refreshes
automatically when the file transfer completes.

Note: After you download a text configuration file, the switch applies the
configuration automatically.

15. After you download a software image file, if you want the switch to run the software image,
do the following:

a. Select the new software image file (see Change the software image that loads when
the switch starts or reboots on page 396).

b. Reboot the switch (see Reboot the switch on page 383).

Use HTTP to download a file to the switch or update the
software image
You can download a software (firmware) image, configuration files, and SSL files from a
computer to the switch by using an HTTP session over a web browser.
To download afile to the switch using HTTP:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

* If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.
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5. Click the Login button.
The System Information page displays.
6. Select Maintenance > Update > HTTP Firmware/File Update.

HTTP Firmware/File Update

= TFTP Fimware/File
Update

«HTTP Firmware/File Image Name Image1 v
Update 2
Select File No file selected

NOTE: This process will send a file from your computer to the switch. When the file
transfer starts, wait until the page refreshes before continuing

File Type Software ¥

7. From the File Type menu, select the type of file:

e Software. The system software image, which is saved in one of two flash sectors
called images (imagel and image?2). The active image stores the active copy, the
other image stores a second copy. The device boots and runs from the active image.
If the active image is corrupted, the system automatically boots from the nonactive
image. This is a safety feature for faults occurring during the boot upgrade process.
This the default setting.

e Text Configuration. A text-based configuration file enables you to edit a configured
text file (startup-config) offline as needed. The most common usage of
text-based configuration is to upload a working configuration from a device, edit it
offline to personalize it for another similar device (for example, change the device
name, serial number, IP address), and download it to that device.

* SSL Trusted Root Certificate PEM File. SSL Trusted Root Certificate File (PEM
Encoded).

» SSL Server Certificate PEM File. SSL Server Certificate File (PEM Encoded).

* SSL DH Weak Encryption Parameter PEM File. SSL Diffie-Hellman Weak
Encryption Parameter File (PEM Encoded).

e SSL DH Strong Encryption Parameter PEM File. SSL Diffie-Hellman Strong
Encryption Parameter File (PEM Encoded).

8. If the selection from the File Type menu is Software, the Image Name menu is displayed
and you must select the software image that must be downloaded to the switch:

* Imagel. Select imagel to upload imagel.
* Image2. Select image2 to upload image?2.

Note: We recommended that you do not overwrite the active image.

9. Click the Browse button and locate and select the file that you want to download.
The file name can contain up to 80 characters.

10. Click the Apply button.
The file transfer begins.
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The page displays information about the progress of the file transfer. After a file transfer is
started, wait until the page refreshes. When the page refreshes, the option to select a file
is no longer available, indicating that the file transfer is complete.

Note: After you download a text configuration file, the switch applies the
configuration automatically.

11. After you download a software image file, if you want the switch to run the software image,
do the following:

a. Select the new software image file (see Change the software image that loads when
the switch starts or reboots on page 396).

b. Reboot the switch (see Reboot the switch on page 383).

Use an HTTP session to download and install an SSL
security certificate file on the switch

Note: You are not required to obtain an SSL certificate. The security warning
that might display in your browser prompts you to confirm that the
self-signed certificate of the switch is valid. Once you do so, the
browser warning might no longer display when you log in.

If you obtain an SSL security certificate from a certificate authority, you can download and
install the SSL security certificate through an HTTP session using your web browser.

For an SSL security certificate, you must download two Privacy Enhanced Mail (PEM) files to
the switch:

« SSL Trusted Root Certificate PEM file. This the certificate file, which must be in the
format XxXxXXCERTXXXXX . pem.

e SSL Server Certificate PEM file. This is the key file, which must be in the format
XXXXKEYXXXXX . pem.

Before you can download and install an SSL security certificate, you must disable HTTPS on
the switch.

To disable HTTPS and use an HTTP session to download and install an SSL security
certificate file on the switch:

1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.
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If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Security > Access > HTTPS.
HTTPS Configuration page displays.
7. Select the Admin Mode Disable radio button.
8. Click the Apply button.

Your settings are saved. Because you changed the access mode from HTTPS to HTTP,
you are logged out of the switch.

9. Wait one minute, refresh your browser, and log back in to the switch (see steps 3 through 5).
10. Select Maintenance > Update > HTTP Firmware/File Update.

The HTTP Firmware/File Update page displays.

11. From the File Type menu, select SSL Trusted Root Certificate PEM File.
12. Select the Select File Browse button and locate the file that you want to download.

This the certificate file, which must be in the format XxxXCERTXXXXX . pem.
13. Click the Apply button.
The file transfer begins.

The page displays information about the progress of the file transfer. The page refreshes
automatically when the file transfer completes (or if it fails).

14. From the File Type menu, select SSL Server Certificate PEM File.
This is the key file, which must be in the format XXxXXKEYXXXXX . pem.
15. Select the Select File Browse button and locate the file that you want to download.

The file name can contain up to 80 characters.
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16. Click the Apply button.

The file transfer begins.

The page displays information about the progress of the file transfer. The page refreshes
automatically when the file transfer completes (or if it fails).

Manage software images

The switch maintains two versions of the switch software in permanent storage. One image is
the active image, and the second image is the backup image. The active image is loaded
when the switch starts or reboots. This feature reduces switch down time when you are
updating the switch software.

Note: A switch that runs an older (legacy) software version might not load a
configuration file that is created by a newer software version. In such
a situation, the switch displays a warning.

Copy a software image
You can copy a software image from one location (primary or backup) to another.

To copy a software image:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.
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For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > File Management > Copy.

File Management  [Jekuid

* Copy Source Image ® imagel image2

* Dual Image ¥ Destination Image imagel @® image2

7. Select the Source Image imagel or image2 radio button to specify the image to be copied.

8. Select the Destination Image imagel or image2 radio button to specify the destination
image.

9. Click the Apply button.

Your settings are saved.

Configure dual image settings

The Dual Image feature allows the switch to retain two images in permanent storage. You
can select which image must be loaded when the reboots, specify an image description, or
delete an image. This feature reduces switch down time when you are upgrading or
downgrading the software image.

Change the software image that loads when the switch starts or reboots

To change the image that loads during the boot process:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > File Management > Dual Image Configuration.

Dual Image Configuration

*Copy Image Mame image1
= Dual Image #  Current-active image2
= Dual Image Image Description (0 ta 255)
Confi

Activate Image
= Dual Image Status

Delete Image

7. As an option, specify a name for the selected image by entering one in the Image
Description field.

8. Select the Activate Image check box.
9. Click the Apply button.

Your settings are saved.

10. After activating the image, reboot the switch (see Reboot the switch on page 383).

If you do not reboot the switch, it continues running the image shown in the
Current-active field until the next time that the switch reboots.

Delete a software image

To delete a software image:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:

« After initial login, enter your local device password.
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By default, the local device password is password. You must change this password
at initial login.

» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.
6. Select Maintenance > File Management > Dual Image Configuration.
The Dual Image Configuration page displays.

7. From the Image Name menu, select the image that is not the image displayed in the
Current-active field.

The Current-active field displays the name of the active image. You cannot delete the
active image.

8. Select the Delete Image check box.
9. Click the Apply button.

The image is removed.

View the dual image status
You can view information about the active and backup images on the switch.

To view dual image status information:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
« Afterinitial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.
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» If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on

page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > File Management > Dual Image > Dual Image Status.

The following table describes the nonconfigurable information on the page.

Table 66. Dual Image Status information

Field Description
Imagel Ver The version of the imagel file.
Image2 Ver The version of the image2 file.

Current-active

The currently active image on this switch.

Next-active

The image to be used after the switch reboots.

Imagel Description

The description, if any, associated with the image1 file.

Image?2 Description

The description, if any, associated with the image?2 file.

Perform diagnostics and troubleshooting

You can send a ping or a traceroute, and you can perform a memory dump.

Ping an IPv4 Address

You can configure the switch to send a ping request to a specified IPv4 address. You can use
this option to check whether the switch can communicate with a particular IPv4 device. When
you send a ping, the switch sends a specified number of ping requests and the results are

displayed.

If a reply to the ping is received, the following message displays:

PING x.y.z.w (X.y.z.w): size data bytes

size bytes from x.y.z.w: seq=0 ttl=xyz

--- X.y.z.w ping statistics ---

count packets transmitted, count packets received, x% packet loss

If a reply to the ping is not received, the following message displays:

PING x.y.z.w (X.y.z.w): size data bytes
--- X.y.z.w ping statistics ---
count packets transmitted, O packets received, 100% packet loss
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To ping an IPv4 address:
1. Connect your computer to the same network as the switch.

You can use a WiFi or wired connection to connect your computer to the network, or
connect directly to a switch that is off-network using an Ethernet cable.

2. Launch a web browser.
3. In the address field of your web browser, enter the IP address of the switch.

If you do not know the IP address of the switch, see Access the switch on-network and
connected to the Internet on page 18 or Access the switch off-network on page 27.

The Local Device Login page displays.

If you did not yet register the switch with your NETGEAR account, the Register to unlock
all features page displays. For more information, see Register the switch on page 31.

4. Enter one of the following passwords:
» After initial login, enter your local device password.

By default, the local device password is password. You must change this password
at initial login.

« If you previously managed the switch through the Insight app or Cloud portal, enter
the Insight network password for the last Insight network location.

For information about the credentials, see Credentials for the local browser Ul on
page 30.

5. Click the Login button.

The System Information page displays.

6. Select Maintenance > Troubleshooting > Ping IPv4.

Ping Details
IP Address/Host Name (Max 255 characters/x.x.x.x)
Count 3 (1o 15)
Interval (secs) 3 (1 to 60)
Size 0 (0 to 13000)
Results
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7. Inthe IP Address/Host Name field, enter the IP address or host name of the device that
must be pinged.

8. In the Count field, enter the number of echo requests that must be sent.
The default value is 3. The range is 1 to 15.

9. Inthe Interval (secs) field, enter the time between ping packets in seconds.
The default value is 3 seconds. The range is 1 to 60.

10. In the Size field, enter the size of the ping packet. The default value is 0 bytes. The range is
0 to 13000.

11. Click the Apply button

The specified address is pinged. The results are displayed below the configurable data in
the Results field.

Ping an IPv6 address

You can configure the switch to send a ping request to a specified IPv6 address. You can use
this option to check whether the switch can communicate with a particular IPv6 device. When
you send a ping, the switch sends a specified number of ping requests and the results are
displayed.

If a reply to 